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Panoramica

Posizione e funzione delle parti

Per informazioni dettagliate sullutilizzo e la funzione di ogni parte, fare riferimento alla pagina indicata.

Unita principale

10

1
1. Gancio per tracolla (9) 9. Slitta multi interfaccia (anteriore)
2. Pulsante ASSIGN7/DIRECT MENU (38) 10. Levetta zoom elettrico (25)

3. N (icona N) 11. Antenna Wi-Fi

* Avvicinare a questo simbolo uno
smartphone compatibile con la funzione
NFC per realizzare una connessione
wireless tra la videocamera e lo
smartphone.
Per i dettagli, consultare le istruzioni per
I’uso dello smartphone.

¢ La funzione (Near Field Communication) &
uno standard internazionale per la
comunicazione radio a breve distanza.

4. Pulsante ASSIGNS/FOCUS MAG
5. Slitta multi interfaccia (posteriore)

® Multi
Y interface Shoe

Per informazioni dettagliate sulla gamma di
accessori utilizzabili con la slitta multi-
interfaccia, rivolgersi al proprio rappresentante
commerciale.

6. Morsetto microfono

7. Supporto microfono (33)

8. Antenna GPS
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. Microfono interno (32)

2. Spia di registrazione/tally (anteriore)
(101)
Lampeggia quando la capacita rimanente del
supporto di registrazione o della batteria ¢ bassa.

. Pulsante ASSIGN6

. Pulsante FULL AUTO (24)

. Selettore ND FILTER

. Selettore modalita ND FILTER

. Selettore FOCUS (26)

8. Pulsante ASSIGN3/VIDEO SIGNAL
MONITOR

9. Pulsante ASSIGN1/ZEBRA
10. Pulsante ASSIGN2/PEAKING
11. Selettore INPUT1 (32)
12. Selettore CH1 (INT/EXT/MI SHOE) (32)
13. Manopola AUDIO LEVEL (CH1) (32)
14. Manopola AUDIO LEVEL (CH2) (32)
15. Selettore CH2 (INT/EXT/MI SHOE)
16. Selettore INPUT2 (32)
17. Pulsante ASSIGN5
18. Selettore SHUTTER
19. Pulsante ASSIGN4

20. Pulsante FOCUS PUSH AUTO/HOLD
27)

21. Manopola di regolazione ND
22. Pulsante WB SET

23. Paraluce con copriobiettivo (19)

~N o ol AW
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. Pulsante BATT RELEASE (17)

. Attacco pacco batteria (17)

. Connettore multi/micro USB (65)

. Connettore USB 3.0 HOST (tipo A)

. Connettore SDI OUT (64)

. Comando di regolazione diottrie (20)
. Selettore ON/STANDBY (18)

I: ON
&: STANDBY

. Spia di alimentazione

. Connettore USB 2.0 (HOST) (tipo A)

(Supportato in un aggiornamento futuro.)

. Selettore IN/OUT (ingresso/uscita)

. Apertura uscita aria

* Le zone intorno all’uscita dell’aria possono
risultare molto calde.
* Non coprire I'uscita dell’aria.

Levetta dello zoom sulla maniglia (25)

Pulsante di registrazione della maniglia
Quando la levetta si trova nella posizione
HOLD, il pulsante di registrazione della
maniglia non ¢ utilizzabile.

. Connettore AUDIO INPUT1 (32)
. Connettore AUDIO INPUT?2 (32)
16.

Fermacavi

Consente di assicurare il cavetto di un
microfono o simili.

Cinghia dell’impugnatura

Selettore multiplo (pulsante 4/%/«/»/
SET)

910 11

1213 14 15

2221201918 17 16

19.
20.

21

22.

23.

24,
25.
26.

Pulsante di registrazione (24)

Apertura ingresso aria

* Non coprire I’ingresso dell’aria.

. Connettore REMOTE

11 connettore REMOTE consente di avviare o
arrestare la registrazione e altre funzioni sul
dispositivo video e sulle periferiche ad esso
collegate.

Fermacavo

« Utilizzare esclusivamente per assicurare i cavi in
posizione e non per altri scopi.

Connettore LAN cablata (supportato in

un aggiornamento futuro)

Connettore TC IN/OUT
Connettore HDMI OUT (64)

Slot/indicatore di accesso UTILITY SD/
MS

Utilizzato per la registrazione proxy e per la
memorizzazione e il caricamento di
impostazioni (funzione File). Sara supportato in
un aggiornamento futuro (aggiornamento
software).
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18.
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. Ghiera dello zoom (26)
. Ghiera di messa a fuoco (26)
. Selettore Full MF (26)

Attivare o disattivare la modalita di messa a
fuoco manuale spostando in avanti o indietro la
ghiera di messa a fuoco.

. Levetta del copriobiettivo (19)

Apre e chiude il coperchietto dell’obiettivo.

. Gancio per tracolla
. Ghiera del diaframma (28)

. Connettore () (cuffie)

Per cuffie con mini jack stereo.

. Spia di registrazione/tally (posteriore)

(101)

Lampeggia quando la capacita rimanente del

supporto di registrazione o della batteria & bassa.
. Pulsante SLOT SELECT
10.

Slot per schede di memoria A

. Indicatore di accesso alla scheda di

memoria A (21)
Slot per schede di memoria B

Indicatore di accesso alla scheda di
memoria B (21)

Connettore DC IN

Pulsante CANCEL/BACK (70)
Manopola SEL/SET (70)
Pulsante MENU (70)

Sul pulsante ¢ presente una barretta in rilievo
che ne facilita I’individuazione al tatto.

Selettore WHT BAL (31)

19. Selettore GAIN (29)
20. Pulsante IRIS PUSH AUTO
21. Selettore IRIS (28)

Fissaggio della tracolla
Agganciare la tracolla agli appositi ganci.
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THUMBNAIL  F RV PLAY;/AUSE F ['WD [ LCD |IRIGHT

1T 0D 0|0

2 STATIIS _PREV__QTOPCAM  NEXT DISPLAY

—0 @ 0 & G-

VOLUME

DURATION
CANCEL  TCU-BIT

19 18 17 16

1. Pulsante THUMBNAIL (57) Lato inferiore

2. Pulsante STOP/CAM (58)
3. Pulsante STATUS CHECK (13)
4. Pulsante PREV (58)
5. Pulsante 4/%/«/»/SET (70)
6. Pulsante MENU (70)
7. Pulsante F REV (58)
8. Pulsante PLAY/PAUSE (58)
9. Pulsante F FWD (58)
10. Pulsante NEXT (58)
11. Pulsante LCD BRIGHT (20)
12. Pulsante DISPLAY (11) 1
13. Schermo LCD (20) 1. Fori filettati per il montaggio del treppiede

14. Mirino (20) (1/4 poll., 3/8 poll.)
Compatibile con viti 1/4-20UNC e 3/8-16UNC.

15. Oculare grande Consentono il montaggio di un treppiede (in
16. Apertura ingresso aria vendita separatamente, vite di lunghezza max.
m 5,5 mm).

* Non coprire I'ingresso dell’aria.
17. Pulsanti VOLUME (27)
18. Pulsante DURATION/TC/U-BIT (35)
19. Pulsante CANCEL (70)
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Informazioni visualizzate sullo schermo

Schermo LCD/mirino

Durante la registrazione, 1’attesa della registrazione o la riproduzione, gli stati e le impostazioni della
videocamera vengono visualizzati in sovrimpressione su schermo LCD o mirino.

E possibile visualizzare o nascondere queste informazioni premendo il pulsante DISPLAY.

E inoltre possibile scegliere quali voci devono essere visualizzate indipendentemente dalle altre
(pagina 90).

Informazioni visualizzate a schermo durante le riprese

15 16 171819 20 21 22 23

1. Indicatore di stato della rete (pagina 13) 6. Indicatore della modalita di messa a fuoco

Icona indicante lo stato della connessione di (pagina 36)

rete. Modalita Full MF Eull ME
2. Indicatore della modalita di registrazione Modalita MF ME

o stato operativo degli slot A/B Modalita AR A

ORec Registrazione Face detection AF (AE/ B/ ouly/</ [T])
Stby Standby registrazione - -
Icona rilevamento viso o

3. Indicatore di profondita di campo Icona AF solo viso Ol
4. Indicatore della frequenza fotogrammi in Icona viso registrato £

modalita di ripresa Slow & Quick Motion
Icona pausa messa a fuoco  [1]

5. Indicatore carica residua della batteria o automatica modalita Face
tensione DC IN Only AF ®

a) Visualizzata solo quando un viso registrato non
¢ presente e nessun viso viene rilevato e quando
un volto registrato & presente ma non & rilevato.

7. Indicatore di posizione di zoom

Visualizza la posizione dello zoom con un

valore compreso fra 0 (grandangolo) e 99

(teleobiettivo).
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15.
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17

22.
23.
24,

25.
26.

21

28.
29.

. Indicatore stato GPS

. Indicatore modalita di stabilizzazione

dell’immagine (SteadyShot)

Indicatore Rec Control uscita SDI/HDMI
Visualizzato quando Display On/Off >SDI/
HDMI Rec Control nel menu LCD/VF e SDI/
HDMI Rec Control >Setting nel menu Video
sono entrambi impostati su On.

Indicatore moltiplicatore di focale digitale
(pagina 100)

Indicatore Focus Assist di assistenza alla
messa a fuoco

Indicatore capacita rimanente sul
supporto di memorizzazione

Indicatore modalita bilanciamento del
bianco

Visualizza il formato registrato su una scheda di
memoria.

30. Indicatore frequenza di sistema e metodo
di scansione

31. Indicatore formato di registrazione
(dimensioni immagine) (pagina 99)
Visualizza le dimensioni dell’immagine
registrata su una scheda di memoria.

Informazioni visualizzate sulla schermata di

riproduzione

Le seguenti informazioni vengono sovraimposte

sull’immagine riprodotta.

ATW Modalita automatica

ATW Hold Pausa della modalita
automatica

W:P Modalita predefinita

W:A Modalita memoria A

W:B Modalita memoria B

Indicatore timecode (codice temporale)
(pagina 35)

. Indicatore filtro ND (pagina 29)

. Indicatore file di scena (pagina 43)
18.
19.
20.
21.

Indicatore valore di diaframma
Indicatore di avviso livello video
Indicatore guadagno (pagina 29)
Indicatore modalita otturatore/velocita
otturatore

Indicatore modalita AE/livello AE
(pagina 30)

Indicatore di livello audio
Visualizzazione VIDEO SIGNAL
MONITOR (forma d’onda/vettorscopio/
istogramma)

Indicatore nome clip

Indicatore assistenza visualizzazione
gamma (pagina 43)

. Indicatore gamma (pagina 82)

Visualizza le impostazioni di gamma.
Indicatore stato proxy

Indicatore formato di registrazione
(codec) (pagina 99)

=T |
8§ 9 10

. Indicatore di stato della rete

[
11 12 13

. Numero del clip/Numero totale dei clip

. Indicatore modalita di riproduzione

=W N =

. Indicatore formato di riproduzione
(frequenza fotogrammi)

5. Indicatore formato di riproduzione
(dimensioni immagine)

6. Indicatore carica residua della batteria o
tensione DC IN

7. Indicatore formato di riproduzione

(codec)

8. Indicatore supporto
A sinistra viene visualizzato il simbolo (3 se la
scheda di memoria & protetta da scrittura.

9. Indicatore dati temporali
I dati temporali sono visualizzati quando
Display On/Off >Timecode nel menu LCD/VF
¢ impostato su On e viene premuto il pulsante
DISPLAY.

10. Indicatore nome clip
11. Icona assistenza visualizzazione gamma
12. Indicatore di livello audio

13. Indicatore gamma



Icone di indicazione della connessione di rete

Modalita di  Stato della
rete connessione

Icona

Modalita punto  In operazione
di accesso come punto di
accesso

Errore nel m

funzionamento
come punto di
accesso

Modalita Station Wi-Fi connesso l’ h

> I

Intensita del
segnale Wi-Fi

Zebra2 Impostazione e livello Zebra2
On/Off
Gamma Categoria e curva Gamma

Gain Switch

Impostazione Gain<L>,
Gain<M>, Gain<H>

Handle Zoom Speed

Impostazione Handle Zoom

Scene File

File di scena corrente e ID
file

Schermata Audio Status

Visualizza le impostazioni di ingresso,
I’indicatore di livello audio e le impostazioni del
filtro di riduzione del rumore del vento per

ciascun canale.

(4 livelli)

Wi-Fi . CHI level meter Indicatore di livello CH1
d_isconnesso CHI1 Input Source Sorgente di ingresso CH1
fmcl‘ duTante CHI1 Ref./Sens. Livello di riferimento
installazione) ingresso CH1

Errore di

conneesilone k CHI1 Wind Filter Valore di riduzione del filtro
Wi—Fi“ antivento del microfono di

Schermate di stato

La schermata di stato consente di controllare le
impostazioni e lo stato del camcorder.

Utilizzo della schermata di stato

Per visualizzare la schermata di stato:
¢ Premere il pulsante STATUS CHECK.

Per cambiare schermata di stato:
* Ruotare la manopola SEL/SET o premere il
pulsante 4/¥.

Per nascondere la schermata di stato:
¢ Premere il pulsante STATUS CHECK.

Schermata Camera Status
Visualizza la qualita dell’immagine, le
impostazioni di zoom e lo stato.

CHI1

CH2 level meter

Indicatore di livello CH2

CH2 Input Source

Sorgente di ingresso CH2

CH2 Ref./Sens.

Livello di riferimento
ingresso CH2

CH2 Wind Filter

Valore di riduzione del filtro
antivento del microfono di
CH2

CH3 level meter

Indicatore di livello CH3

CH3 Input Source

Sorgente di ingresso CH3

CH3 Ref./Sens.

Livello di riferimento
ingresso CH3

CH3 Wind Filter

Valore di riduzione del filtro
antivento del microfono di
CH3

CH4 level meter

Indicatore di livello CH4

White Switch<B> Valore di regolazione del
bilanciamento del bianco

della memoria B

White Switch<A> Valore di regolazione del
bilanciamento del bianco

della memoria A

White Switch<P> Impostazione Preset White

ND<Preset> Impostazione da Presetl a 3
per ND Filter
Zebral Impostazione e livello Zebral

On/Off

CH4 Input Source Sorgente di ingresso CH4

CH4 Ref./Sens. Livello di riferimento
ingresso CH4

CH4 Wind Filter Valore di riduzione del filtro
antivento del microfono di
CH4

HDMI Output CH Impostazione combinazione
canali audio di uscita HDMI.

Analog Output CH Impostazione combinazione
canali audio di uscita
analogica.

Monitor CH Impostazione di
monitoraggio del canale

Headphone Out Impostazione del tipo di

uscita cuffie




Schermata System Status
Visualizza le impostazioni del segnale video.

Frequency/Scan Impostazioni frequenza di
sistema e metodo di
scansione

Codec Impostazione del codec

Simul Rec Stato On/Off della modalita
Simul Rec su 2 slot

Title Prefix Prefisso titolo nome clip

Picture Size

Dimensioni di immagine del
formato di registrazione

Rec Function

Impostazioni e formato di
registrazione speciale attivo

Clip Continuous Rec

Stato On/Off della funzione
Clip Continuous Rec

Picture Cache Rec

Stato On/Off e impostazione
della funzione Picture Cache
Rec

Number Suffisso numerico nome clip

Shooting Mode Impostazione modalita di
ripresa

Proxy Rec Stato On/Off e impostazione

della registrazione proxy

Schermata Video QOutput Status
Visualizza le impostazioni di uscita SDI, HDMI e

video.

SDI

Dimensioni immagine di
uscita

Stato Rec Control
Output On/Off

HDMI

Dimensioni immagine di
uscita

Stato Rec Control
Output On/Off

Gamma

Impostazione gamma

Color Gamut

Impostazione di Color Gamut

Gamma Display Assist

Impostazione assistenza
visualizzazione gamma

Schermata Assignable Button Status
Visualizza le funzioni assegnate ai pulsanti

programmabili.
1 Funzione assegnata al
pulsante Assign 1
2 Funzione assegnata al
pulsante Assign 2
3 Funzione assegnata al
pulsante Assign 3
4 Funzione assegnata al

pulsante Assign 4

5 Funzione assegnata al
pulsante Assign 5

6 Funzione assegnata al
pulsante Assign 6

7 Funzione assegnata al
pulsante Assign 7

8 Funzione assegnata al

pulsante Assign 8

Schermata Battery Status
Visualizza informazioni sulla batteria e la
sorgente di alimentazione collegata al connettore

DCIN.

Detected Battery

Tipo di batteria

Remaining Capacita rimanente (%)
Charge Count Numero di ricariche
Capacity Capacita rimanente (Ah)
Voltage Tensione (V)

Manufacture Date

Data di fabbricazione della
batteria

Video Light Remaining

Livello di carica rimanente
della batteria della luce video

Power Source

Sorgente di alimentazione

Supplied Voltage

Tensione fornita dalla
sorgente di alimentazione.

Schermata Media Status

Visualizza lo spazio rimanente, il tempo di
registrazione disponibile e la vita utile stimata del
supporto di registrazione (scheda di memoria A /
scheda di memoria B) e UTILITY.

Informazioni supporto
A

Visualizza I’icona della
scheda quando ¢ inserito un
supporto di registrazione
nello slot A.

Protezione supporto A

Visualizza I’icona di blocco
quando il supporto di
registrazione inserito nello
slot A ¢ protetto.

Indicatore capacita
rimanente supporto A

Visualizza la capacita
rimanente del supporto di
registrazione inserito nello
slot A come percentuale su
una barra.

Tempo di registrazione
rimanente supporto A

Visualizza il tempo stimato di
registrazione rimanente sul
supporto di registrazione
inserito nello slot A in minuti
nelle condizioni di
registrazione attuali.




Informazioni supporto

B

Visualizza I’icona della
scheda quando ¢ inserito un
supporto di registrazione
nello slot B.

Protezione supporto B

Visualizza I’icona di blocco
quando il supporto di
registrazione inserito nello
slot B ¢ protetto.

Indicatore capacita
rimanente supporto B

Visualizza la capacita
rimanente del supporto di
registrazione inserito nello
slot B come percentuale su
una barra.

Tempo di registrazione

rimanente supporto B

Visualizza il tempo stimato di
registrazione rimanente sul
supporto di registrazione
inserito nello slot B in minuti
nelle condizioni di
registrazione attuali.

Informazioni sul
supporto UTILITY

Visualizza I’icona del
supporto quando € inserito un
supporto di memoria nello
slot UTILITY SD/MS.

Schermata GPS Status
Visualizza informazioni sullo stato e sul
posizionamento GPS.

GPS Stato posizionamento segnale
GPS

Dilution of Precision Informazioni sulla precisione

di posizione

Latitude Informazioni sulla latitudine

Longitude Informazioni sulla
longitudine

Altitude Informazioni sull’altitudine

Positioning date and Posizionamento data e ora

time

Current date and time ~ Data e ora correnti

Time Zone Impostazione fuso orario

Schermata Network Status
Visualizza lo stato di connessione della
connessione di rete.

Wireless LAN Impostazioni e stato della

connessione wireless

Protezione del supporto

UTILITY

Visualizza I’icona di blocco
quando il supporto di
memoria inserito nello slot
UTILITY SD/MS ¢ protetto.

Indicatore capacita
rimanente supporto
UTILITY

Visualizza graficamente su
una barra la capacita
percentuale rimanente del
supporto di memoria inserito
nello slot UTILITY SD/MS.

Capacita rimanente
supporto UTILITY

Visualizza una stima in
minuti del tempo di
registrazione rimanente sul
supporto di registrazione
inserito nello slot UTILITY
SD/MS. In alternativa,
visualizza la capacita
rimanente in GB.

Schermata Rec Button Settings Status
Visualizza lo stato di impostazione del pulsante di
registrazione e del pulsante di registrazione della

maniglia.

Rec Button

Visualizza lo slot di
registrazione utilizzato dal
pulsante di registrazione.

Handle Rec Button

Visualizza lo slot di
registrazione utilizzato dal
pulsante di registrazione della
maniglia.

Impostazioni Wireless LAN

Visualizza-  Visualizza- Descrizione

zione Setting zione Status

Off -- L’impostazione
della LAN wireless
¢ Off.

Access Point Non Active Non operante come

Mode punto di accesso.
Appare in caso di
guasto del chip
Wi-Fi.

Active In operazione come

punto di accesso.




Visualizza-
zione Setting

Visualizza-
zione Status

Descrizione

Station Mode

Non Active

Non operante in
modalita Station.
Appare in caso di
guasto del chip
Wi-Fi.

Searching

Tentativo di
connessione in
corso all’ultima
rete connessa
(punto di accesso).

Disconnected

Non connesso a
nessuna rete (punto
di accesso).
Appare anche se
I’indirizzo IP non &
stato assegnato
tramite DHCP.

<SSID>

Connesso a rete
<SSID> (punto di
accesso).




Operazioni preliminari

Alimentazione

E possibile alimentare il camcorder con un pacco
batteria o da una presa elettrica di rete tramite un
adattatore CA.

Se ¢ collegato un adattatore CA, 1’adattatore CA
ha la priorita, anche se & montato un pacco
batteria.

Per sicurezza, utilizzare esclusivamente i
seguenti pacchi batterie e adattatori CA Sony.

Pacchi batteria agli ioni di litio
BP-U30 (in dotazione)
BP-U60

BP-U60T

BP-U90

Adattatori CA/Caricabatteria
BC-U1A (in dotazione)
BC-U2A

AVVERTENZA

Non conservare i pacchi batteria in luoghi esposti
alla luce solare diretta o a fiamme libere, oppure
in cui siano presenti elevate temperature.

¢ Perl’alimentazione da una presa di corrente, utilizzare
I’adattatore CA fornito.

Utilizzo di un pacco batteria

Per montare un pacco batteria, inserirlo fino in
fondo nell’apposita sede (pagina 8), quindi
spingerlo verso il basso per bloccarlo in
posizione.

Per rimuovere un pacco batteria, premere e
mantenere premuto il pulsante BATT RELEASE
(pagina 8), farlo scorrere verso I’alto e quindi
estrarlo dalla sede.

Prima dell’ uso, caricare la batteria con il caricabatterie
BC-U1A (in dotazione) o BC-U2A.

Se la batteria viene ricaricata immediatamente dopo
I’uso mentre & ancora calda, & possibile che non si
ricarichi completamente.

La batteria ad alta capacita BP-U90 ¢ voluminosa e
sporge dal camcorder quando ¢ montata. La batteria
BP-U90 ¢ consigliabile quando si utilizza il camcorder
montato su un treppiede per periodi di registrazione
prolungati.

Controllo della capacita rimanente

Mentre ¢ in corso la registrazione o la
riproduzione con alimentazione a batteria, sullo
schermo LCD o mirino viene visualizzata
un’icona che mostra il livello di carica della
batteria attuale e il tempo di utilizzo rimanente
(pagina 11).

Icona Capacita residua

Da 100% a 91%

Da90% a71%

Da 70% a 51%

Da 50% a 31%

Da30% a 11%

Da 10% a 0%

La videocamera indica il tempo di utilizzo
rimanente in minuti calcolando il tempo
disponibile della batteria qualora le operazioni
proseguano al tasso di consumo energetico
attuale.

Se il livello di carica della batteria
diventa insufficiente

Se il livello di carica rimanente della batteria
scende al di sotto di un determinato valore
durante 1’utilizzo (stato Low Battery), viene
visualizzato il messaggio di batteria prossima
all’esaurimento, I’indicatore di registrazione/tally
comincia a lampeggiare e viene emesso un
segnale acustico.

Se il livello di carica rimanente si abbassa oltre,
fino a raggiungere un livello al quale ¢
impossibile continuare I’ utilizzo dell’apparecchio
(stato Battery Empty), viene visualizzato il
messaggio di batteria esaurita.

Sostituire il pacco batteria esaurito con uno
carico.

Modifica dei livelli di avviso

Per impostazione predefinita, il livello Low
Battery ¢ impostato al 10% della carica completa
della batteria, mentre il livello Battery Empty &
impostato sul 3%. E possibile modificare le



percentuali dei livelli di avviso con 1’opzione

Battery Alarm (pagina 101) del menu System. Accensione e spegnimento del
camcorder
U“"ZZO de"’a"mentazmne CA Per accendere il camcorder, spostare il selettore

ON/STANDBY (pagina 8) sulla posizione ON
(). Per spegnere il camcorder, spostare il selettore

elettrica, & possibile utilizzarlo senza doversi ON/STANDBY sulla posizione STANDBY (d)).
preoccupare di ricaricare il pacco batteria.

* Mentre il selettore ON/STANDBY si trova sulla
posizione STANDBY, I’apparecchio continua ad
assorbire una certa quantita di corrente elettrica.
Rimuovere sempre la batteria se si prevede di non
utilizzare il camcorder per un periodo di tempo
prolungato.

* Prima di rimuovere la batteria o scollegare
I’alimentazione DC IN, spostare 1’ interruttore
alimentazione sulla posizione STANDBY ed attendere
che la spia di alimentazione si spenga. Se viene
interrotta I’alimentazione mentre 1’interruttore si trova
ancora nella posizione ON, si potrebbero verificare
guasti al camcorder o alle schede di memoria.

Collegando il camcorder a una presa di corrente

Connettore .
DC IN Spinotto dell’adattatore CA

1 Collegare il cavo di alimentazione all’adattatore CA.

2 Collegare I’adattatore CA al connettore DC IN del
camcorder.

3 Collegare il cavo di alimentazione alla presa elettrica
a parete.

Adattatori CA

* Non collegare e utilizzare un adattatore CA in
spazi ristretti, ad esempio fra una parete e un
mobile.

« In caso di problemi durante I’uso, estrarre
immediatamente la spina dalla presa elettrica.

* Non cortocircuitare lo spinotto dell’adattatore
CA con oggetti metallici. Questo ne causerebbe
il guasto.

* Non ¢ possibile ricaricare il camcorder
collegandolo all’adattatore CA.




Impostazione
dell’orologio

Alla prima accensione del camcorder dopo
I’acquisto o dopo lo scaricamento completo della
batteria di backup, sullo schermo LCD e sullo
schermo del mirino viene visualizzata la
schermata di impostazione iniziale.

Impostare la data e 1’ora dell’orologio interno in
questa schermata.

Time Zone

11 valore indica la differenza di orario rispetto
all’'UTC (Coordinated Universal Time).
Impostare questo valore secondo il caso.

Impostazione di data e ora

Spostare il cursore utilizzando il pulsante 4/%/«/
# (pagina 8) o lamanopola SEL/SET (pagina 9),
quindi premere il pulsante SET o la manopola
SEL/SET per impostare ciascun valore.

Al termine, spostare il cursore su [Finish] e
premere il pulsante SET o la manopola SEL/SET
per chiudere la schermata delle impostazioni e
concludere la regolazione dell’orologio.

In seguito, dopo la chiusura della schermata di
impostazione, ¢ possibile modificare data, ora e
fuso orario servendosi dell’opzione Clock Set
(pagina 101) del menu System.

* Se le impostazioni di data e ora sono andate perse
perché la batteria di backup si & scaricata
completamente a seguito di un lungo periodo di tempo
in cui il camcorder & rimasto senza alimentazione
(senza pacco batteria o alimentazione DC IN), verra
nuovamente visualizzata la schermata delle
impostazioni iniziali quando si riaccende nuovamente
il camcorder.

¢ Mentre ¢ visualizzata la schermata delle impostazioni

iniziali non & possibile eseguire alcuna operazione (ad

eccezione dello spegnimento) fino a quando non si
siano completate tutte le impostazioni di questa
schermata.

Se il camcorder non viene utilizzato per circa 3 mesi,

la batteria ricaricabile incorporata si scarica e le

impostazioni relative a data e ora scompaiono dalla
memoria. In tal caso, caricare la batteria ricaricabile,

quindi reimpostare la data e I’ora (pagina 106).

Montaggio degli
accessori

Montaggio del paraluce

Pulsante PUSH (sblocco paraluce)

Allineare i simboli sul paraluce ai simboli
sulla videocamera, quindi ruotare il
paraluce nella direzione della freccia @
fino a bloccarlo.

Rimozione del paraluce

Ruotare il paraluce nella direzione opposta alla
freccia nella figura mantenendo premuto il
pulsante PUSH (sblocco paraluce).

* Rimuovere sempre il paraluce prima di montare o
rimuovere un filtro di protezione o un filtro polarizzato
da ¢82 mm.

Montaggio dell’oculare grande

Allargare leggermente 1’ oculare e inserirlo
nell’apposita scanalatura sul mirino.

Oculare grande (fornito)



Regolazione degli
schermi

Regolazione dello schermo LCD

Aprire lo schermo LCD di 180 gradi (), quindi
ruotarlo all’angolazione pil adatta alla
registrazione o alla riproduzione @).

@ Aprire a
180 gradi Y &
® 90 gradi 4 = //Z
(max.) ‘ &
® 180 gradi | V™
(max.) [;

E possibile orientare il mirino in modo che sia
rivolto verso il soggetto. Le immagini sullo
schermo LCD vengono visualizzate come
immagini speculari, ma sono registrate come
immagini normali.

Regolazione della retroilluminazione

Utilizzare il pulsante LCD BRIGHT (pagina 10)
per regolare I’intensita della retroilluminazione.

Regolazione della luminosita

Regolare la luminosita utilizzando LCD Setting
>Brightness (pagina 88) nel menu LCD/VF. Le
modifiche alla luminosita dello schermo non
hanno effetto sulla luminosita delle immagini
registrate.

Regolazione del mirino

Per utilizzare il mirino, avvicinare I’occhio al
mirino con lo schermo LCD chiuso.

Se la visione attraverso il mirino non & chiara,
regolarla utilizzando la rotella di regolazione

diottrica situata sotto al mirino stesso.
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Comando di regolazione
diottrie

Ruotare fino ad ottenere la
massima nitidezza
dell'immagine.

Regolazione della luminosita

Regolare la luminosita utilizzando VF Setting
>Brightness (pagina 88) nel menu LCD/VF.

Regolazione della luminosita
dello schermo LCD o del mirino
mediante un pulsante
programmabile

Dopo aver assegnato la funzione LCD/VF Adjust
ad un pulsante programmabile (pagina 38), ¢
possibile visualizzare una barra di livello per
regolare la luminosita dello schermo LCD o del
mirino premendo tale pulsante.

1 Premereil pulsante programmabile a
cui & stata assegnata la funzione LCD/
VF Adjust per visualizzare la barra di
livello che consente la regolazione della
luminosita.

Ad ogni pressione del pulsante, lo schermo
visualizza in sequenza la barra di livello per
lo schermo LCD — la barra di livello per il
mirino — nessuna barra di livello.

2 Regolare il livello utilizzando il pulsante
4/¥%/«/% 0 1a manopola SEL/SET,
quindi premere il pulsante SET o la
manopola SEL/SET.

La barra di livello scompare.

Per nascondere la barra di livello, premere il
pulsante a cui ¢ assegnata la funzione LCD/



VF Adjust ed attendere 3 secondi senza
eseguire nessuna operazione.
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Utilizzo delle schede di
memoria

Questo camcorder registra audio e video su
schede di memoria (in vendita separatamente)
inserite negli appositi slot.

Informazioni sulle schede di
memoria

Schede di memoria supportate

Sono supportate le seguenti schede di memoria

Per informazioni dettagliate sui supporti di
registrazione e sui formati compatibili, vedere
pagina 109.

Schede di memoria SDXC (Class 10)

Inserimento delle schede di
memoria

1 Aprire il coperchio del vano con gli slot
per schede.

2 Inserire la scheda di memoria con
Petichetta rivolta a destra.
La spia di accesso (pagina 9) si accende in
rosso, poi diventa verde non appena la scheda
di memoria & pronta per I’uso.

3 Chiudereil coperchio.

* La scheda di memoria, lo slot e i dati di immagine
contenuti sulla scheda potrebbero subire danni se la
scheda venisse forzata nello slot con I’orientamento
errato.

Rimozione di una scheda di
memoria

1 Aprire il coperchio del vano degli slot
per schede ed esercitare una leggera
pressione sulla scheda da rimuovere.
La scheda di memoria viene parzialmente
espulsa.



Durante la registrazione, questo arresta la
registrazione.

2 Rimuovere la scheda di memoria.

¢ Seil camcorder viene spento o la scheda viene rimossa
durante I’accesso alla scheda, non ¢ possibile garantire
I’integrita dei dati contenuti sulla scheda. Tutti i dati
registrati sulla scheda potrebbero essere danneggiati.
Assicurarsi sempre che I’indicatore di accesso sia
illuminato con luce verde o sia spento prima di
spegnere il camcorder o rimuovere la scheda di
memoria.

Le schede di memoria appena estratte dal camcorder
dopo la registrazione potrebbero essere calde. Questo
non indica la presenza di guasti.

Passaggio da una scheda di
memoria all’altra

Se sono presenti schede di memoria in entrambi
gli slot A e B, ¢ possibile passare da una all’altra
per la registrazione premendo il pulsante SLOT
SELECT (pagina 9).

Se una scheda si riempie durante la registrazione,
il camcorder passa automaticamente all’altra
scheda.

11 pulsante SLOT SELECT ¢ disabilitato durante la
riproduzione. Non ¢ possibile passare da una scheda
all’altra premendo il pulsante. Il pulsante ¢ abilitato
mentre ¢ visualizzata la schermata delle miniature
(pagina 57).

Formattazione (inizializzazione) di
una scheda di memoria

Le schede di memoria devono essere formattate
prima di poter essere utilizzate sul camcorder.

E consigliabile che le schede di memoria da
utilizzare con questo camcorder siano formattate
con la funzione di formattazione del camcorder
stesso.

Qualora venga visualizzato un messaggio
all’inserimento della scheda di memoria nel
camcorder, formattare la scheda.

Se viene inserita una scheda di memoria
formattata in un formato non compatibile con
questo camcorder, verra visualizzato il messaggio
“Unsupported File System” sullo schermo LCD o
sul mirino.

Formattare la scheda come descritto di seguito.
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Per eseguire la formattazione

Utilizzando Format Media (pagina 95) nel
menu Media, specificare Media(A) (slot A)
o Media(B) (slot B), quindi selezionare
Execute.

Durante la formattazione & visualizzato un
messaggio e I’indicatore di accesso si illumina di
rosso.

Al termine della formattazione viene visualizzato
un messaggio di conferma.

 La formattazione di una scheda di memoria elimina
tutti i dati che contiene, compresi eventuali video
protetti. I dati non possono essere recuperati.
Utilizzo su un altro dispositivo di supporti di
memoria formattati con questo camcorder
Effettuare un backup del supporto, quindi
formattarlo utilizzando 1’altro dispositivo.

Controllo del tempo di
registrazione rimanente

Durante la registrazione (o lo standby di
registrazione), & possibile verificare lo spazio
rimanente sulle schede di memoria inserite nei
loro slot facendo riferimento all’indicazione di
stato e spazio rimanente sui supporti negli slot A/
B visualizzata sullo schermo LCD o sul mirino
(pagina 11).

1l tempo di registrazione rimanente & calcolato
sulla base della capacita rimanente della scheda di
ciascuno slot e del formato video corrente (bit rate
di registrazione) ed ¢ indicato in minuti.

« Se la scheda di memoria & protetta da scrittura viene
visualizzata I’icona @

Sostituzione di una scheda di memoria

* Se il tempo complessivo disponibile sulle due
schede ¢ inferiore a 5 minuti, I’utente viene
avvertito dal messaggio di avviso “Media Near
Full”, dalla spia di registrazione/controllo
lampeggiante e da un segnale acustico nelle
cuffie.

Sostituire con una scheda con spazio libero
sufficiente.

* Se si prosegue la registrazione fin quando il
tempo totale rimanente non corrisponde a zero,



il messaggio diventa “Media Full” e la
registrazione si interrompe.

¢ Ciascuna scheda di memoria consente di registrare fino
a circa 600 clip.
Se il numero di clip registrati raggiunge il valore
massimo consentito, viene visualizzata I’indicazione
che il numero massimo consentito € stato raggiunto.

Ripristino di una scheda di
memoria

Qualora si verifichi un errore su una scheda di
memoria, la scheda dovra essere ripristinata
prima di poter essere nuovamente utilizzata.

Se si inserisce una scheda di memoria che deve
essere ripristinata, lo schermo LCD o del mirino
visualizza un messaggio che chiede di confermare
il ripristino.

Ripristino di una scheda di memoria

Selezionare Execute utilizzando il pulsante
4/%/«/% 0 la manopola SEL/SET, quindi
premere il pulsante SET o la manopola
SEL/SET.

Durante la formattazione sono visualizzati un
messaggio e I’indicatore di avanzamento
dell’operazione (%). L’indicatore di accesso &
inoltre illuminato con luce rossa.

Al termine del ripristino viene visualizzato un
messaggio di conferma.

Se il ripristino non riesce

* Non ¢ possibile ripristinare schede di memoria
protette contro la scrittura o che contengono
errori di memoria. In tal caso viene visualizzato
un messaggio di avviso. Seguendo le istruzioni
del messaggio, rimuovere la protezione o
sostituire la scheda.

Le schede di memoria che contengono errori di
memoria potrebbero diventare nuovamente
utilizzabili se riformattate.

In alcuni casi, potranno essere ripristinati solo
alcuni clip e non altri. I clip ripristinati possono
essere riprodotti normalmente.

Se continua ad apparire il messaggio “Could not
Restore Some Clips” anche dopo ripetuti
tentativi di ripristino, potrebbe essere possibile
ripristinare la scheda di memoria utilizzando la
procedura descritta di seguito.

1 Utilizzare la funzione di copia (pagina 61) del
camcorder per copiare i clip desiderati su un’altra
scheda di memoria.

2 Formattare la scheda di memoria inutilizzabile con
il camcorder.

3 Copiare di nuovo i clip desiderati sulla scheda di
memoria appena formattata.

* Peril ripristino dei supporti, utilizzare sempre lo stesso
camcorder utilizzato per registrarli.
Questo camcorder non consente di ripristinare supporti
registrati con apparecchi diversi o con camcorder di
versione diversa (anche se dello stesso modello).

* I clip di durata inferiore a 1 minuto potrebbero non
essere ripristinabili.



Procedura base

Ripresa

Di seguito si descrive la procedura per eseguire
una semplice ripresa di base.

1 Montarei dispositivi necessari e
controllare che I’alimentazione sia
presente.

2 Inserire la scheda o le schede di
memoria.
Se vengono inserite due schede di memoria
negli slot A e B, la registrazione continua
passando automaticamente alla seconda
scheda quando lo spazio sulla prima si
esaurisce.

3 Spostare il selettore ON/STANDBY
sulla posizione ON.
Sullo schermo LCD/mirino viene
visualizzata la schermata di registrazione.

4 Premereil pulsante di registrazione
sulla maniglia o sul’impugnatura
(pagina 8).

La spia di registrazione/tally si accende e la
registrazione ha inizio.

O Per arrestare la registrazione premere
nuovamente il pulsante di registrazione.
La registrazione si arresta e il camcorder
entra in modalita STBY (standby).

Ripresa (modalita Full Auto)

Premere il pulsante FULL AUTO.
L’indicatore del pulsante si illumina.

La modalita Full Auto ¢ impostata su On, Auto
Exposure (pagina 77) ¢ attivata, e Auto ND
Filter, Auto Iris, AGC (Auto Gain Control), Auto
Shutter e ATW (Auto Tracing White balance)
sono impostati su On. Quindi, la luminosita e il
bilanciamento del bianco vengono regolati
automaticamente.

Per la regolazione manuale, disattivare la
modalita Full Auto.
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Registrazione continua sulle schede di
memotria (Relay Rec)

Quando sono presenti schede di memoria in
entrambi gli slot A e B, la registrazione passa
automaticamente alla seconda scheda di memoria
poco prima che la capacita rimanente sulla prima
scheda si esaurisca.

E possibile eseguire registrazioni continuate
ininterrottamente sostituendo ogni volta la scheda
di memoria piena con una nuova.

* Non espellere una scheda di memoria mentre & in corso
la registrazione su di essa. Rimuovere esclusivamente
la scheda di memoria nello slot la cui spia di accesso &
spenta durante la registrazione.

Se nell’altro slot viene caricata una scheda di memoria
registrabile quando il tempo rimanente sulla scheda di
memoria di registrazione ¢ inferiore a 1 minuto, viene
visualizzato il messaggio “Will Switch Slots Soon”. Il
messaggio scompare dopo il passaggio all’altro slot.
La funzione Relay Recording potrebbe non essere
utilizzabile se si avvia la registrazione quando il tempo
rimanente sulla scheda di memoria ¢ inferiore a 1
minuto. Per eseguire correttamente la registrazione in
modalita Relay Recording, assicurarsi che il tempo
rimanente sulla scheda di memoria sia superiore a 1
minuto.

I video creati con la funzione di registrazione relay del
camcorder non possono essere riprodotti senza
interruzione sul camcorder.

Per unire insieme video creato con la funzione di
registrazione relay del camcorder, utilizzare il
software Content Browser.



Informazioni sui clip

Clip (dati di registrazione)

Quando si arresta la registrazione, il video,
I’audio e i dati accessori dall’inizio alla fine
dellaregistrazione vengono salvati sulla scheda
di memoria come un unico clip.

Nome dei clip

Ad ogni clip registrato dal camcorder viene
assegnato automaticamente un nome
utilizzando la modalita di assegnazione del
nome impostata tramite la voce Clip Naming
(pagina 96) del menu Media.

Durata massima dei clip

La durata massima di un clip varia a seconda
del formato di registrazione.

La durata massima di una registrazione
continua ¢ identica alla durata massima di un
clip. Se il tempo di registrazione del clip supera
la lunghezza massima consentita, viene creato
automaticamente un nuovo clip e la
registrazione continua. Il nuovo clip apparira
sulla schermata delle miniature come un clip
separato.

Per informazioni dettagliate sul tempo
massimo di registrazione di ciascun clip per
ciascun formato di registrazione, vedere
“Tempo di registrazione massimo per un clip”
(pagina 110).

Eliminazione di clip

Per eliminare I’ultimo clip registrato, utilizzare la
funzione Last Clip Delete (pagina 100). Per
eliminare solo certi clip specificati, oppure tutti i
clip insieme, eseguire 1’operazione dalla
schermata delle miniature (pagina 62).
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Regolazione dello zoom

Utilizzo della levetta dello zoom elettrico

Eseguire lo zoom premendo la levetta dello zoom

elettrico [C].

Premere leggermente la levetta dello zoom
elettrico [C] per eseguire uno zoom lento.
Premerla a fondo per uno zoom piu rapido.

Ampio angolo di visuale: grandangolo
w T
ﬂ; 5

Ripresa ravvicinata: teleobiettivo

¥

wr=mT
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¢ La distanza minima di messa a fuoco fra il
camcorder e il soggetto & circa 1 cm per il
grandangolo e circa 80 cm per il teleobiettivo.

* In certe posizioni di zoom, potrebbe non essere
possibile mettere a fuoco soggetti che si trovano
a una distanza inferiore a 80 cm.

* Mantenere il dito sulla levetta dello zoom
elettrico [C]. Allontanando il dito dalla levetta
dello zoom elettrico , potrebbe essere
registrato anche il rumore prodotto dalla levetta
stessa

Utilizzo della levetta dello zoom della
maniglia

1. Impostare la velocita di azionamento dello
zoom della maniglia su “Low”, “High” o
“Variable” mediante Handle Zoom
(pagina 78) >Setting nel menu Camera.



* Se impostata su “Variable”, la velocita di
azionamento dello zoom varia in base alla
pressione applicata alla levetta.

Se impostata su “Low” o “High”, la
velocita dello zoom rimane costante,
indipendentemente dalla pressione
applicata alla levetta. E possibile impostare
la velocita su “Low” o “High” utilizzando
Handle Zoom nel menu Camera.
Assegnando la funzione Handle Zoom
>Setting a un pulsante programmabile
(pagina 38), ¢ possibile scegliere la
velocita di azionamento dello zoom della
maniglia premendo ripetutamente tale
pulsante.

2. Premere la levetta di zoom della maniglia
per eseguire lo zoom avanti o indietro.

« Il funzionamento della levetta dello zoom della
maniglia |A| puo essere disabilitato, impostando la
relativa velocita di azionamento su OFF.

Utilizzo della ghiera dello zoom

Eseguire lo zoom ruotando la ghiera dello zoom
[Bl.

La velocita di zoom dipende dalla velocita di
rotazione della ghiera dello zoom [B]. E inoltre
possibile effettuare una regolazione precisa.

Regolazione della messa a fuoco

Consigli per la messa a fuoco

« Spostare la levetta dello zoom elettrico verso T
(teleobiettivo) e regolare la messa a fuoco,
quindi spostarla verso W (grandangolo) per
regolare 1o zoom per la registrazione.

« Per registrare un’immagine ravvicinata di un
soggetto, spostare la levetta dello zoom elettrico
verso W (grandangolo) per ingrandire
completamente I’immagine, quindi regolare la
messa a fuoco.
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Modalita
AF/MF M

Regolazione in modalita Full MF

Per attivare la modalita Full MF di regolazione
completamente manuale della messa a fuoco,
spostare la ghiera di messa a fuoco |A] indietro,
verso il corpo del camcorder.

Ruotare quindi la ghiera per regolare la messa a
fuoco osservando I’immagine visualizzata sullo
schermo LCD o sul mirino.

Sulla ghiera di messa a fuoco sono riportati
indicatori di distanza, utili per la messa a fuoco in
modalita Full MF. La distanza di messa a fuoco
dell’immagine corrisponde alle posizioni degli
indicatori di distanza.

* Non forzare la rotazione della ghiera di messa a fuoco

all’arresto, una volta raggiunta I’estremita del campo

di rotazione consentito.

Nella modalita Full MF, le funzioni di messa a fuoco

automatica Auto Focus e Push Auto Focus non sono

utilizzabili.

» La modalita Macro & impostata su Off
indipendentemente dall’impostazione di Focus Macro
nel menu Camera.

Regolazione in modalita MF

La modalita MF (messa a fuoco manuale)
consente di utilizzare anche la messa a fuoco
automatica se desiderato.

Spostare in avanti la ghiera di messa a fuoco
(verso il paraluce) e spostare il selettore FOCUS
su MANUAL.



Messa a fuoco automatica temporanea (Push
Auto Focus)

In modalita MF, & possibile attivare la modalita di
messa a fuoco automatica premendo il pulsante
FOCUS PUSH AUTO/HOLD |C] dell’ obiettivo o
premendo il pulsante programmabile (pagina 38)
a cui ¢ assegnata la funzione Push AF/Push MF.
La messa a fuoco ritorna alla modalitd manuale
non appena si rilascia il pulsante.

Questa funzione ¢ utile per spostare la messa a
fuoco da un soggetto a un altro mentre ¢ attiva la
modalita di messa a fuoco manuale.

Regolazione in modalita AF

In modalita AF (auto focus), la messa a fuoco
viene regolata automaticamente.

Spostare in avanti la ghiera di messa a fuoco [A| e
spostare il selettore FOCUS su AUTO.

Messa a fuoco manuale temporanea (Push
Manual Focus)

In modalita AF, & possibile attivare la modalita di
messa a fuoco manuale premendo il pulsante
FOCUS PUSH AUTO/HOLD dell’ obiettivo o
premendo il pulsante programmabile (pagina 38)
a cui & assegnata la funzione Push AF/Push MF.
La messa a fuoco ritorna alla modalita automatica
non appena si rilascia il pulsante.

Uso della modalita Macro

Nelle modalita MF o AF, impostare Focus
(pagina 75) >Focus Macro nel menu Camera su
On oppure premere un pulsante programmabile a
cui ¢ assegnata la funzione Focus Macro
(pagina 38) per attivare la modalita macro che
consente la messa a fuoco nella zona macro.

La modalita macro non ¢ disponibile in modalita
Full MF.

Messa a fuoco usando la visualizzazione
ingrandita (Focus Magnifier)

Premendo un pulsante programmabile

(pagina 38) a cui & assegnata la funzione Focus
Magnifier, viene visualizzata la schermata di
ingrandimento della messa a fuoco che mostra
ingrandita la porzione centrale dell’immagine.
Con il formato di registrazione QFHD, ad ogni
pressione del pulsante I’ingrandimento passa da
4x a 8x e viceversa. E possibile spostare la
porzione ingrandita utilizzando il pulsante 4/%/«/
>

Nei formati di registrazione diversi da QFHD, il
centro dello schermo ¢ visualizzato ad un
ingrandimento di 2x.

Premere nuovamente il pulsante per tornare alla
schermata normale.

Questa funzione ¢ utile per controllare la messa a
fuoco.

¢ Anche se I'immagine appare ingrandita sullo schermo,
I’immagine registrata non ¢ ingrandita.

Monitoraggio dell’audio durante
le riprese

Collegando cuffie all’apposito jack (mini jack
stereo) (pagina 9) & possibile monitorare I’audio
durante la registrazione.

 Durante la ripesa (registrazione o standby di
registrazione), lo speaker incorporato ¢ disattivato.

Regolazione del volume dell’audio di

monitoraggio

Utilizzare i pulsanti VOLUME (pagina 10).

Scelta del canale di monitoraggio audio
Selezionare il canale utilizzando Audio Output
(pagina 86) nel menu Audio.
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Modifica delle
impostazioni di base

E possibile modificare le impostazioni in base
all’applicazione o alle condizioni di
registrazione.

Formato video

I formati disponibili e selezionabili variano a
seconda delle impostazioni della frequenza di
sistema e del codec.

Selezione della frequenza di sistema

Selezionare utilizzando Rec Format (pagina 99)
>Frequency nel menu System.

Il camcorder si riavvia automaticamente dopo la
selezione.

* Non ¢& possibile cambiare la frequenza di sistema
durante la registrazione o la riproduzione.

Selezione del codec

Selezionare utilizzando Rec Format (pagina 99)
>Codec nel menu System.

« Non ¢ possibile cambiare il codec durante la
registrazione o la riproduzione.

Selezione del formato

Selezionare utilizzando Rec Format (pagina 99)
>Video Format nel menu System.

11 segnale fornito in uscita dai connettori SDI
OUT e HDMI OUT sara nel formato selezionato
con questo menu.

* Non ¢ possibile cambiare il formato durante la
registrazione o la riproduzione.
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Regolazione della luminosita

(A}

E possibile regolare la luminosita variando
opportunamente i valori di diaframma, guadagno,
velocita dell’otturatore, nonché regolando il
livello di luce mediante i filtri ND.

Ripresa con diaframma automatico

Quando la modalita Full Auto (pagina 24) ¢ On
1l diaframma viene impostato sulla modalita
Auto.

Quando la modalita Full Auto & Off

Spostare il selettore IRIS su AUTO. Viene
impostata la modalita Auto.

L’impostazione di regolazione applicata quando
il selettore del diaframma AUTO/MANUAL si
trova sulla posizione MANUAL puo essere
configurata anche mediante Direct Menu
(pagina 35).

Ripresa con diaframma manuale

In modalita Full Auto Off, spostare il selettore
IRIS su MANUAL. Viene impostata la
modalitd Manual. Regolare I’apertura ruotando la
ghiera del diaframma [A].

L’impostazione di regolazione applicata quando
il selettore del diaframma AUTO/MANUAL si
trova sulla posizione MANUAL puo essere
configurata anche mediante Direct Menu
(pagina 35).



Attivazione temporanea della funzione di
diaframma automatico

Nella modalita di diaframma manuale, premere il
pulsante IRIS PUSH AUTO [H] per attivare la
funzione di diaframma automatico One-push.

Il diaframma automatico rimane attivo finché
rimane premuto il pulsante. Rilasciare il pulsante
per tornare alla modalita di diaframma manuale.

Ripresa in modalita di guadagno
automatico (AGC)

Quando la modalita Full Auto (pagina 24) ¢ On
Viene abilitata automaticamente la modalita
AGC (Auto Gain Control).

Quando la modalita Full Auto & Off

Impostare Auto Exposure >AGC (pagina 77) nel
menu Camera su On per attivare la modalita
AGC.

E possibile attivare e disattivare AGC anche
mediante Direct Menu (pagina 35).

La modalita di otturatore automatico puo essere
attivata anche selezionando Auto Shutter in
Direct Menu e impostandola su On.

Ripresa con otturatore fisso

Quando la modalita Full Auto & Off e Auto
Exposure >Auto Shutter (pagina 77) nel menu
Camera ¢ impostato su Off, spostare il selettore
SHUTTER |[F| sulla posizione ON per fissare
I’otturatore sulla modalita e sulla velocita
configurate tramite la voce Shutter (pagina 76)
del menu Camera.

Impostazione nel menu Camera

Selezionare Shutter (pagina 76) nel menu
Camera e scegliere la modalita e la velocita di
otturatore desiderate.

Impostazione con Direct Menu

E possibile attivare o disattivare la modalita ECS
(pagina 76) e impostare la velocita dell’ otturatore
anche con Direct Menu (pagina 35).

Ripresa con guadagno fisso

Regolazione del livello di luce (filtro ND)

1. Impostare la modalita Full Auto su Off.

2. Quando il guadagno & regolato
automaticamente, impostare Auto Exposure

>AGC (pagina 77) nel menu Camera su Off.

L’indicazione “AGC” scompare.

3. Spostare il selettore GAIN suH,MolL.
Lo schermo visualizza il valore di guadagno
corrispondente alla posizione in cui si trova il
selettore GAIN.

I valori di guadagno delle posizioni H, M ed
L possono essere impostati tramite la voce
Gain (pagina 75) del menu Camera.

E possibile impostare il valore di H, M ed L
anche in Direct Menu (pagina 35).

Ripresa in modalita otturatore
automatico

Quando la modalita Full Auto (pagina 24) ¢ On
L’otturatore viene impostato automaticamente
sulla modalita Auto Shutter.

Quando la modalita Full Auto & Off
Impostare Auto Exposure >Auto Shutter
(pagina 77) nel menu Camera su On per attivare

la modalita di velocita automatica dell’otturatore.
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Se la luminosita dell’ambiente di registrazione &
eccessiva, & possibile ridurre la luminosita del
soggetto ripreso a un valore appropriato
utilizzando il selettore ND FILTER [C].

1l camcorder offre due modalita di filtro ND. E
possibile scegliere la modalita desiderata
utilizzando il selettore della modalita ND
FILTER [D].

Modalita preset

Spostare il selettore della modalita ND FILTER
[D] su PRESET, quindi spostare il selettore ND
FILTER [C] sulle posizioni descritte di seguito
secondo il caso.

CLEAR: Il filtro ND non viene utilizzato.

1: Densita filtro impostata mediante ND Filter
>Preset] nel menu Camera. L’ impostazione
predefinita ¢ 1/4.

2: Densita filtro impostata mediante ND Filter
>Preset2 nel menu Camera. L’ impostazione
predefinita ¢ 1/16.

3: Densita filtro impostata mediante ND Filter
>Preset3 nel menu Camera. L’ impostazione
predefinita ¢ 1/64.

Modalita variabile

Spostare il selettore della modalita ND FILTER
|§| su PRESET, quindi spostare il selettore ND
FILTER [C] sulle posizioni descritte di seguito

secondo il caso.



CLEAR: 1l filtro ND non viene utilizzato.

1, 2, 3: La densita del filtro pud essere impostata
su qualsiasi valore compreso fra 1/4 e 1/128
utilizzando la manopola di regolazione ND [E].
La posizione del selettore ND FILTER |B] (1/2/3)
non ha effetto sulla regolazione della densita del
filtro.

Filtro ND automatico

Quando il selettore di modalita ND FILTER si
trova sulla posizione VARIABLE e il selettore
ND FILTER ¢ in posizione 1, 2 o 3, 1a densita del
filtro ND puo essere regolata automaticamente
impostando Auto Exposure >Auto ND Filter
(pagina 77) nel menu Camera su On.

E possibile anche attivare o disattivare Auto ND
Filter (On/Off) mediante Direct Menu

(pagina 35).

Se Auto ND Filter ¢ disattivato (Off), & possibile
selezionare la densita del filtro ND anche
mediante Direct Menu.

Impostazione dell’esposizione
automatica

La funzione di esposizione automatica consente
di ottenere il livello appropriato di luminosita
regolando opportunamente filtro ND, diaframma,
guadagno ed otturatore.

Impostare la modalita di regolazione utilizzando
Auto Exposure (pagina 77) >Mode nel menu
Camera ed impostando il livello mediante Level.
La modalita di regolazione e il livello di
correzione possono essere impostati anche
tramite Direct Menu (pagina 35).

Utilizzo della funzione di riduzione dello
sfarfallio

Impostare Flicker Reduce (pagina 78) >Mode nel
menu Camera su Auto o On, ed impostare
Frequency sulla frequenza dell’alimentazione
elettrica (50 Hz o 60 Hz).

» Se la frequenza di fotogrammi selezionata per la
ripresa ¢ vicina alla frequenza della rete di
alimentazione elettrica, la funzione di riduzione dello
sfarfallio potrebbe non essere in grado di eliminare
completamente lo sfarfallio. In tal caso, utilizzare
I’otturatore elettronico.
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Come ottenere colori naturali
(bilanciamento del bianco)

GAIN SEL/SET

WHT BAL

: = Y
@)
Ot | @ %

Bl
E possibile selezionare la modalita di regolazione
piu adatta per le condizioni di ripresa.

Modalita preset

Questa modalita regola la temperatura di colore
su un valore preimpostato (valore predefinito:
3200K). Selezionare questa modalita quando
manca il tempo per regolare il bilanciamento del
bianco oppure per fissarne il valore sul preset
impostato con White (pagina 80) >Preset White
nel menu Paint.

Modalita Memory A, modalita Memory B
Questa modalita imposta il bilanciamento del
bianco sul valore salvato rispettivamente nelle
memorie A o B.

Premere il pulsante WB SET |A| per eseguire la
regolazione automatica del bilanciamento del
bianco e memorizzare il valore regolato nella
memoria A o nella memoria B.

Modalita ATW (bilanciamento del bianco con
Auto-Tracing)

In questa modalita la videocamera regola
automaticamente il bilanciamento del bianco al
valore appropriato.

11 valore di bilanciamento del bianco viene
automaticamente regolato quando cambia la
temperatura di colore della sorgente luminosa.

E possibile selezionare la velocita di regolazione
(cinque livelli) con I’opzione White Setting
>ATW Speed (pagina 80) del menu Paint.

E possibile “congelare” il valore di bilanciamento
del bianco corrente assegnando la funzione ATW



Hold a un pulsante programmabile (pagina 38) e
premendo tale pulsante per sospendere
temporaneamente la modalita ATW.

* A seconda delle condizioni di illuminazione e del
soggetto, la funzione ATW puo non essere in grado di
ottimizzare sempre il colore.

Esempi:

— Quando il soggetto ¢ dominato da un unico colore,
ad esempio cielo, mare, prati o fiori.

— Quando la temperatura di colore & estremamente
alta o bassa.
Se non ¢ possibile ottenere 1’effetto opportuno
perché la velocita di regolazione automatica ATW
¢ insufficiente o per altri motivi, eseguire la
funzione di bilanciamento automatico del bianco.

Uso del selettore

Selezionare la modalita con il selettore WHT
BAL [B].

B: Modalita ATW o Memoria B

A: Modalita Memoria A

PRESET: Modalita Preset

Per impostazione predefinita di fabbrica, la
posizione B del selettore WHT BAL ¢ assegnata
alla modalita ATW. Se del caso, & possibile
cambiare questa impostazione e selezionare
invece la modalita Memory B utilizzando la voce
White Setting >White Switch<B> (pagina 80)
del menu Paint.

Impostando il camcorder sulla modalita Full Auto
(pagina 24) viene automaticamente attivata la
modalita ATW.

Assegnando la funzione di attivazione/
disattivazione ATW aun pulsante programmabile
(pagina 38) & possibile attivare/disattivare in
modo indipendente ATW quando la modalita Full
Auto ¢ disattivata.

Utilizzo di Direct Menu

Premere il pulsante DISPLAY (pagina 10) per
visualizzare la temperatura di colore e la modalita
selezionate sullo schermo (pagina 11).

ATW: Modalita ATW

W:A: Modalita Memoria A

W:B: Modalita Memoria B

W:P: Modalita Preset

La funzione Direct Menu (pagina 35) consente di
selezionare la modalita di regolazione come
descritto di seguito.

Con il selettore WHT BAL sulla posizione B &
possibile impostare 1la modalita ATW e la
modalitd Memory B.
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Con il selettore WHT BAL sulla posizione A ¢
possibile impostare la modalita ATW e la
modalita Memory A.

Con il selettore WHT BAL sulla posizione
PRESET ¢ possibile impostare la modalita ATW
e la modalita Preset.

Se non ¢ impostata la modalita ATW, Direct
Menu consente di impostare la temperatura di
colore.

Per cambiare la temperatura di colore in Direct
Menu, selezionare I’indicatore della temperatura
di colore. In modalita preset, ¢ possibile
impostare la temperatura di colore anche
premendo il pulsante WB SET.

Selezione della modalita Preset con un
pulsante programmabhile

Assegnare Preset White Select a un pulsante
programmabile (pagina 38). Premendo
ripetutamente il pulsante, diventa quindi possibile
selezionare la temperatura di colore desiderata
nella sequenza 3200K, 4300K, 5600K, 6300K.

Esecuzione del hilanciamento
automatico del bianco

1 Per salvare un valore di regolazione in
memoria, selezionare la modalita
Memory A o la modalita Memory B.

2 Collocare un foglio o un altro oggetto
bianco in una posizione con la stessa
sorgente di luce e le stesse condizioni di
illuminazione del soggetto, quindi
zoomare sul foglio fino a riempire lo
schermo di bianco.

3 Regolare la luminosita.

Regolare il diaframma come descritto in
“Ripresa con diaframma manuale”
(pagina 28).

4 Premereil pulsante WB SET [A].

Quando si esegue la regolazione in una delle
modalita di memoria, il valore regolato viene
salvato nella memoria A o B selezionata al
passo 1.

Se il bilanciamento automatico del bianco
viene eseguito nella modalita ATW, la
regolazione del bilanciamento del bianco



torna alla modalita ATW al termine della
regolazione.

¢ Laregolazione automatica del bilanciamento del
bianco non puo essere eseguita nella modalita Preset.

» Se laregolazione non riesce, lo schermo visualizza un
messaggio di errore. Se il messaggio di errore persiste
anche dopo ripetuti tentativi di impostazione del
bilanciamento del bianco, rivolgersi al servizio di
assistenza tecnica Sony.

Impostazione dell’audio da
registrare

L’audio da registrare puo essere selezionato
utilizzando i connettori, i selettori e le manopole
descritti di seguito.

y
) =)
MIC+48V MI

INPUT2
LINE MIC INT

T i
MIC+48V i [

[H]

Connettori e selettori di ingresso audio esterno
Connettore AUDIO INPUT1

Connettore AUDIO INPUT2

Selettore INPUT1

Selettore INPUT2 [H]

Selettori sorgente audio
Selettore CH1 (INT/EXT/MI SHOE) [D]
Selettore CH2 (INT/EXT/MI SHOE)

Selettori per I'impostazione del livello audio
Manopola AUDIO LEVEL (CH1) [E|
Manopola AUDIO LEVEL (CH2)
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Fare riferimento ai diagrammi a blocchi
(pagina 119).

Uso del microfono interno

E possibile registrare audio anche utilizzando il
microfono interno.
Registrazione su CH1, CH2

Spostare il selettore CH1 (INT/EXT/MI
SHOE) [D] e il selettore CH2 (INT/EXT/MI
SHOE) [G] su INT.

Registrazione su CH3, CH4

Selezionare Internal MIC con Audio Input
(pagina 85) >CH3 Input Select e CH4 Input
Select nel menu Audio.

Utilizzo di un dispositivo audio esterno

E possibile utilizzare mixer ed altri dispositivi
audio esterni.

Registrazione su CH1, CH2

1 Spostare il selettore CH1 (INT/EXT/MI
SHOE) [D] e il selettore CH2 (INT/EXT/
MI SHOE) [G] su EXT.

Quando Audio Input >CH2 EXT Input Select
nel menu Audio ¢ impostato su INPUT2,
I’audio in ingresso sul connettore AUDIO
INPUT]1 viene registrato su CHI e I’audio in
ingresso sul connettore AUDIO INPUT2
viene registrato su CH2.

Quando CH2 EXT Input Select ¢ impostato
su INPUTI, I’audio in ingresso sul
connettore AUDIO INPUT] viene registrato
su entrambi i canali CHI e CH2.

2 Spostare i selettori INPUT1 e INPUT2
((CI/[H]) su LINE.

3 Collegare un dispositivo audio esterno
ai connettori AUDIO INPUT1 e AUDIO
INPUT2 ((A)/[B)).

Registrazione su CH3, CH4

1 Selezionare INPUT1 con Audio Input
(pagina 85) >CH3 Input Select e
INPUT?2 con CH4 Input Select nel menu
Audio.

Quando ¢ selezionato INPUT1 in CH4 Input
Select, I’audio in ingresso sul connettore



AUDIO INPUT1 viene registrato su
entrambi i canali CH3 e CH4.

Eseguire i passi 2 e 3 descritti in
“Registrazione su CH1, CH2”.

Utilizzo di un microfono esterno

E possibile collegare e utilizzare per la
registrazione microfoni a condensatore electret o
altri dispositivi.

Registrazione su CH1, CH2

1

Spostare il selettore CH1 (INT/EXT/MI
SHOE) [D] e il selettore CH2 (INT/EXT/
MI SHOE) [G] su EXT.

Quando Audio Input >CH2 EXT Input Select
nel menu Audio ¢ impostato su INPUT?2,
I’audio in ingresso sul connettore AUDIO
INPUT!1 viene registrato su CHI1 e I’audio in
ingresso sul connettore AUDIO INPUT2
viene registrato su CH2.

Quando CH2 EXT Input Select ¢ impostato
su INPUTI, I’audio in ingresso sul
connettore AUDIO INPUT]1 viene registrato
su entrambi i canali CH1 e CH2.

Configurare i selettori INPUT1 e
INPUT?2 ([CI/[H]).

MIC: Per i microfoni che non richiedono
alimentazione phantom.

MIC+48V: Per i microfoni che richiedono
alimentazione phantom +48 V.

Se si seleziona MIC+48V, assicurarsi che il
microfono connesso sia compatibile con una
sorgente a +48 V per evitare di danneggiarlo.
Controllare sempre prima del collegamento.
In caso di problemi di rumore sui connettori ai
quali non & connesso nessun dispositivo,
impostare su LINE il selettore INPUT1 o
INPUT?2 secondo il caso.

Aprire il supporto microfono tirando
I’apposita maniglietta.

Montare un microfono, quindi chiudere
il supporto microfono per assicurare il
microfono.

Collegare il cavo del microfono ai
connettori AUDIO INPUT1 e AUDIO
INPUT2 ([Al/[B]).
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Se si utilizza un microfono stereo (due
spinotti XLR), collegare lo spinotto del
canale L (sinistro) al connettore AUDIO
INPUT]1 e lo spinotto del canale R (destro) al
connettore AUDIO INPUT?2.

Registrazione su CH3, CH4

1 Selezionare INPUT1 con Audio Input
(pagina 85) >CH3 Input Select e
INPUT?2 con CH4 Input Select nel menu
Audio.

Quando ¢ selezionato INPUT1 in CH4 Input
Select, I’audio in ingresso sul connettore
AUDIO INPUT]1 viene registrato su
entrambi i canali CH3 e CH4.

2 Eseguire i passi da 2 a 5 descritti in
“Registrazione su CH1, CH2”.

Utilizzo di un microfono compatibile con
la slitta multi interfaccia

Registrazione su CH1, CH2

1 Spostare il selettore CH1 (INT/EXT/MI
SHOE) D] e il selettore CH2 (INT/EXT/
MI SHOE) |G| su MI SHOE.

2 Collegare un microfono alla slitta multi-
interfaccia.

Registrazione su CH3, CH4

1 Selezionare Shoe CH1 con Audio Input
(pagina 85) >CH3 Input Select e Shoe
CH2 con CH4 Input Select nel menu
Audio.

2 Collegare un microfono alla slitta multi-
interfaccia.

* Non ¢ possibile collegare contemporaneamente due
microfoni alle due slitte multi interfaccia anteriore e
posteriore. Il microfono attivo sara sempre il primo
microfono collegato.



Regolazione del livello di registrazione
audio

Per CH1, CH2

Regolazione automatica (AGC):

Spostare le manopole AUDIO LEVEL
(CH1/CH2) ([EJ/[F]) sulla posizione AUTO.
E possibile specificare se i livelli di CH1 e CH2
devono essere regolati automaticamente in
maniera indipendente 1’uno dall’altro (Mono) o
insieme (Stereo) mediante Audio Input

(pagina 85) >CH1&2 AGC Mode nel menu
Audio.

Regolazione manuale:

Durante la ripresa o lo standby, regolare il
livello di registrazione ruotando le
manopole AUDIO LEVEL (CH1/CH2) ([E//
) dei canali desiderati sul valoreda0a 10
opportuno.

Per CH3, CH4

Regolazione automatica (AGC):

Impostare Audio Input (pagina 85) >CH3
Level Control/CH4 Level Control nel menu
Audio su Auto.

E possibile specificare se i livelli di CH3 e CH4
devono essere regolati automaticamente in
maniera indipendente 1’uno dall’altro (Mono) o
insieme (Stereo) mediante Audio Input

(pagina 85) >CH3&4 AGC Mode nel menu
Audio.

Regolazione manuale:

1 Impostare Audio Input (pagina 85)
>CH3 Level Control/CH4 Level
Control nel menu Audio su Manual.

2 Impostare il livello di registrazione
audio mediante CH3 Input Level/CH4
Input Level.

Per ridurre il rumore del vento, impostare Audio
Input >CH Wind Filter nel menu Audio su On
(pagina 85).

Registrazione dell’audio nelle modalita
di registrazione speciali

L’audio non viene registrato nelle modalita
Interval Rec e Slow & Quick Motion.
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Stabilizzazione dell’'immagine

Abilitando la funzione di stabilizzazione
dell’immagine (SteadyShot) € possibile evitare di
registrare immagini mosse causate dal
movimento della videocamera.

Impostare SteadyShot (pagina 78) >Setting
nel menu Camera su Active o Standard.

Standard: Riduce il “mosso” dell’immagine
dovuto al movimento dell’apparecchio.

Active: Riduce il “mosso” dell’immagine
dovuto al movimento rapido
dell’apparecchio, come ad esempio mentre si
cammina, utilizzando una correzione piu
forte di quella della modalita Standard.

Off: Disattiva la funzione di stabilizzazione
dell’immagine.

Assegnare la funzione SteadyShot a un pulsante

programmabile (pagina 38) per poter attivare in

sequenza le modalita Standard, Active e Off

premendo tale pulsante.

L’impostazione corrente ¢ visualizzata sullo

schermo LCD o sul mirino.

E possibile selezionare la modalita di

stabilizzazione dell’immagine Standard, Active o

Off anche mediante Direct Menu (pagina 35).

La modalita Active non ¢ disponibile nei casi descritti
di seguito.

— Quando Video Format & 3840x2160

— Durante la registrazione Slow & Quick Motion
Impostare SteadyShot su Off nelle riprese in cui si
utilizza un treppiede per stabilita.

Dati temporali

Impostazione del codice temporale

Specificare il codice temporale da registrare con
I’opzione Timecode (pagina 92) del menu TC/
UB.

Impostazione dei bit utente

E possibile aggiungere all’immagine registrata un
numero esadecimale a § cifre come bit utente. Il
bit utente puo essere anche impostato sull’ora
corrente.

Impostare utilizzando Users Bit (pagina 92) nel
menu TC/UB.



Visualizzazione dei dati temporali

Premere il pulsante DISPLAY per visualizzare i
dati temporali sullo schermo (pagina 11).

Ad ogni pressione del pulsante DURATION/TC/
U-BIT (pagina 10), I’indicazione passa dal
codice temporale ai bit utente alla durata della
registrazione.

Visualizzazione Descrizione
TCG ** %% %k 5%

CLK %ok sk ok

Codice temporale

Codice temporale (modalita
orologio)

UBG #% %% %% %%
DUR %% sk e

Bit utente

Durata dall’inizio della
registrazione
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Funzioni utili

Funzione Direct Menu

E possibile controllare lo stato e modificare le
impostazioni di alcune opzioni direttamente sullo
schermo LCD o mirino.

La funzione Direct Menu puo essere utilizzata
assegnandola a un pulsante programmabile.
Possono essere configurate le impostazioni
elencate di seguito.

* Modalita di messa a fuoco automatica

* SteadyShot

* ATW

* Preset White

¢ Color Temp <A>/Color Temp <B>

* Scene File

* Auto ND Filter

* Valore ND Filter

* Auto Iris

* Valore Iris

* AGC

» Valore Gain (H/M/L/Turbo)

* ECS

* Auto Shutter

* Valore Shutter Speed

* Valore Shutter Angle

* Auto Exposure Mode

* Auto Exposure Level

¢ S&Q Frame Rate

* Direct Menu non ¢ disponibile quando la modalita Full
Auto (pagina 24) & attiva (indicatore pulsante FULL
AUTO illuminato).

1 Premereil pulsante programmabile a
cui & assegnato Direct Menu.
Quando sono visualizzate informazioni sullo
schermo LCD o sul mirino con il pulsante
DISPLAY, ¢ possibile selezionare con il
cursore solo le voci che possono essere
configurate tramite Direct Menu.
Quando non sono visualizzate informazioni
sullo schermo LCD o sul mirino, sono
visualizzate e possono essere selezionate con
il cursore solo le voci che possono essere
configurate tramite Direct Menu.



2 Spostare il cursore sulla voce desiderata
utilizzando il pulsante 4#/%/«/» o0 la
manopola SEL/SET, quindi premere il
pulsante SET o la manopola SEL/SET.

Viene visualizzato Direct Menu per la voce
selezionata.

3 Selezionare un’impostazione
utilizzando il pulsante 4/% o la
manopola SEL/SET, quindi premere il
pulsante SET o la manopola SEL/SET.

11 cursore scompare e al suo posto viene
visualizzata la nuova impostazione.

Per chiudere Direct Menu, premere
nuovamente il pulsante programmabile a cui
¢ assegnato Direct Menu oppure attendere 3
secondi senza eseguire nessuna operazione.

E possibile aprire Direct Menu impostando Menu
Settings >Direct Menu with <SET> (pagina 102)
nel menu System su On e premendo il pulsante
SET o la manopola SEL/SET. In questo caso,
tuttavia, non sara piu disponibile la funzione di
rilevamento del viso con AF sul viso registrato.

AF con rilevamento del viso

Il camcorder ¢ in grado di individuare e mettere a
fuoco automaticamente il viso dei soggetti.
Questa funzione ¢ disponibile solo quando la
regolazione della messa a fuoco € in modalita AF
o durante Push Auto Focus.

I visi rilevati sono segnalati mediante riquadri
grigi. Il riquadro diventa bianco dopo la messa a
fuoco automatica. Se vengono rilevate pitt
persone, il soggetto principale ¢ determinato
automaticamente.

Scegliere ’azione desiderata per la funzione
di AF con rilevamento del viso utilizzando
la voce Focus (pagina 75) del menu Camera.

Face Only AF: Il camcorder rileva e mette a
fuoco il viso dei soggetti (persone). Finché
non viene rilevato un viso, la funzione AF
viene temporaneamente sospesa (MF) e
I’icona pausa messa a fuoco automatica
modalita Face Only AF [1] (pagina 11) &
visualizzata. Questa modalita & efficace
quando il rilevamento del viso non si ¢
ancora stabilizzato.

Face Priority AF: Il camcorderrileva il viso dei
soggetti (persone) e da priorita alla messa a
fuoco del viso. Se non viene rilevato nessun
viso, la messa a fuoco avviene in modalita
AF (impostazione predefinita).

Off: La funzione di AF con rilevamento del viso
¢ disabilitata.

Durante Push Auto Focus, viene attivata la modalita

Face Priority AF anche se ¢ selezionata la modalita

Face Only AF.

La funzione AF con rilevamento del viso non &

disponibile nei casi descritti di seguito.

— In modalita Full MF

— Quando il selettore FOCUS si trova in posizione
MANUAL (eccetto durante Push Auto Focus)

— Quando il formato di registrazione ¢ DVCAM

Se si spegne il camcorder mentre & selezionata Face

Only AF, alla successiva riaccensione verra

automaticamente ripristinata la modalita Face Priority

AF.

Nascondere i riquadri di rilevamento visi

La voce Display On/Off >Face Detection Frame
(pagina 90) nel menu LCD/VF consente di
visualizzare o nascondere i riquadri di
rilevamento visi.

Messa a fuoco su un viso registrato

Mentre ¢ attiva la funzione AF con rilevamento

del viso, ¢ possibile registrare il viso di un

soggetto specifico per mantenerlo a fuoco.

E possibile registrare un solo viso. La

registrazione di un viso sovrascrive I’eventuale

registrazione precedente.

Se & presente un viso registrato, il riquadro di

registrazione appare con una doppia cornice e

viene visualizzata I’icona del viso registrato ¢

(pagina 11).

Nella modalita AF con rilevamento del viso,

avranno luogo le azioni descritte di seguito in

base alla combinazione fra viso registrato e

modalitd operativa della funzione AF con

rilevamento del viso.

Face Priority AF (con viso registrato): Se il
camcorder rileva il viso registrato, lo mette a
fuoco. Se il viso registrato non viene rilevato,
si attiva la normale modalita Face Priority
AF.

Face Only AF (con viso registrato): Se
rileva il volto registrato, il camcorder mette a
fuoco quel volto. Finché il viso non registrato
non ¢ rilevato, la funzione AF viene



temporaneamente sospesa (MF) e I’icona
pausa messa a fuoco automatica modalita
Face Only AF [1] (pagina 11) & visualizzata.
Questa modalita ¢ efficace quando si
desidera mantenere automaticamente a fuoco
una persona specifica.

Impostazione del viso registrato

Spostare il cursore di selezione del viso
(sottolineatura arancione) sul viso da
registrare utilizzando il pulsante 4/¥/«/%,
quindi premere il pulsante SET o la
manopola SEL/SET.

Riquadro del viso registrato

Altri visi (grigio) (doppia cornice bianca)

Cursore di selezione del viso (arancione)

Annullamento della registrazione del viso
Spostare il cursore di selezione sul viso registrato
utilizzando il pulsante 4/%/<«/# quindi premere il
pulsante SET o la manopola SEL/SET.

La registrazione del viso viene annullata, la
doppia cornice scompare e viene sostituita da una
cornice singola, mentre I’icona della
registrazione del viso scompare.

Se, durante il rilevamento dei visi, appare il
cursore arancione di selezione del viso, ma non
appare il riquadro di identificazione del viso
registrato, & possibile annullare la registrazione
del viso premendo due volte il pulsante SET o la
manopola SEL/SET.

In certe condizioni dell’ambiente di registrazione, del
soggetto o delle impostazioni, il rilevamento dei visi
potrebbe non essere possibile.

In certi ambienti di registrazione, potrebbe non essere
possibile ottenere il risultato corretto, oppure
potrebbero essere rilevati come visi oggetti diversi. In
tal caso, impostare la funzione di rilevamento del volto
AF su Off.

E consigliabile registrare il viso del soggetto
desiderato prima dell’inizio della ripresa.

Alcune condizioni (acconciature, trucco) - o se il volto
non ¢ direttamente rivolto verso il camcorder -
potrebbero impedire la corretta registrazione del viso.
In tal caso, la cornice del viso puo diventare una
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cornice doppia, ma I’icona del viso registrato non
viene visualizzata.

Se & gia stato registrato un viso, & consigliabile
annullare tale registrazione prima di procedere alla
registrazione di un nuovo viso.

La funzione di registrazione del viso non ¢ disponibile
quando Menu Settings >Direct Menu with <SET>
(pagina 102) nel menu System ¢ impostato su On.

Selezione della modalita AF con
rilevamento del viso tramite un pulsante
programmabile

Assegnare Face Detection AF a un pulsante
programmabile (pagina 38). Premendo
ripetutamente tale pulsante, diventa possibile
cambiare la modalita AF con rilevamento del viso
nella sequenza Face Priority AF, Face Only AF,
Off.

Impostazione con Direct Menu

La modalita operativa AF con rilevamento del
viso puo essere selezionata anche con Direct
Menu (pagina 35).

Barre di colore/Tono di
riferimento

E possibile emettere in uscita barre di colore
invece dell’immagine della videocamera
impostando Color Bars (pagina 77) >Setting nel
menu Camera su On. Impostare su Off per
ripristinare I’uscita normale.

E possibile anche emettere un tono audio di
riferimento a 1 kHz insieme alle barre di colore
impostando Audio Input (pagina 85) >1kHz
Tone on Color Bars nel menu Audio su On.

Le barre di colore e il segnale audio di riferimento
sono emessi sui connettori SDI OUT e HDMI
OUT.

E possibile selezionare il tipo di barre di colore
utilizzando Color Bars >Type nel menu Camera.

* Le barre di colore non possono essere emesse in uscita
mentre il camcorder si trova in modalita Slow & Quick
Motion.

* Non ¢ possibile attivare le barre di colore durante la
registrazione (& tuttavia possibile tornare dalle barre di
colore all’immagine ripresa).



Revisione di una registrazione
(Rec Review)

E molto semplice rivedere sullo schermo I’ultimo
clip registrato (Rec Review).

Mentre la registrazione e arrestata,
premere il pulsante programmabile a cui &
assegnata la funzione Rec Review.

Vengono visualizzati gli ultimi 3 secondi,

10 secondi o I’intero clip, a seconda
dell’impostazione di Rec Review (pagina 94) nel
menu Recording.

1l clip viene riprodotto fino alla fine e il
camcorder esce dalla funzione Rec Review e
torna alla modalita di STBY (standby).

Arresto di Rec Review

Premere il pulsante STOP/CAM o il
pulsante programmabile a cui ¢ assegnato
Rec Review.

» Lafunzione Rec Review non ¢ supportata se il formato
video ¢ stato cambiato dopo la registrazione del clip.
¢ I menu di configurazione non sono utilizzabili durante

Rec Review.

Pulsanti programmabili

Il camcorder & dotato di otto pulsanti
programmabili (pagina 6) a cui possono essere
assegnate varie funzioni.

Modifica delle funzioni

Utilizzare Assignable Button (pagina 100) nel
menu System.

Le funzioni assegnate sono visualizzate nella
schermata Assignable Button Status (pagina 14).

Funzioni assegnate per impostazione predefinita

Pulsante 1 ~ Zebra

Pulsante 2 Peaking

Pulsante 3  Video Signal Monitor
Pulsante 4  Off

Pulsante 5  Off

Pulsante 6  Off

Pulsante 7 Direct Menu

Pulsante 8 Focus Magnifier

Funzioni assegnabili
Per informazioni dettagliate su ciascuna
funzione, vedere pagina 100.
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* Off

¢ Push AF/Push MF

* Face Detection AF

* Focus Macro

* Auto ND Filter

¢ Push Auto ND

¢ Push Auto Iris

e Turbo Gain

* AGC

* Shutter

* Auto Exposure Level
* Spotlight

» Backlight

 Flash Band Reduce

* Digital Extender x2
* Handle Zoom

* SteadyShot

¢ Color Bars

* Preset White Select
* ATW

« ATW Hold

e Marker

e Zebra

* Peaking

* Video Signal Monitor
* Focus Magnifier

¢ Lens Info

* LCD/VF Adjust

* VF Mode

* Gamma Display Assist
* Display

* Rec

¢ S&Q Motion

* Clip Continuous Rec
¢ Picture Cache Rec

* Proxy Rec Start/Stop
* Rec Review

* Last Clip Delete

¢ Thumbnail

* NFC

¢ Direct Menu

* User Menu

* Menu

Registrazione a intervalli (Interval
Rec)

E possibile registrare automaticamente immagini
a intervalli predefiniti impostando il numero di
fotogrammi per ciascuna ripresa (Number of



Frames) e I’intervallo fra le riprese (Interval
Time).

Questa funzione ¢ efficace per riprendere soggetti
che cambiano molto lentamente.

Intervallo fra le riprese (Interval Time)

——

Numero di fotogrammi in ciascuna ripresa
(Number of Frames)

Si consiglia di montare il camcorder su un
treppiede o altro supporto analogo e utilizzare la
funzione di telecomando Web per avviare ed
arrestare la registrazione, invece di premere il
pulsante di registrazione del camcorder.

In modalita Interval Rec non viene registrato audio.
La modalita Interval Rec non pud essere impostata su
On contemporaneamente a Picture Cache Rec, S&Q
Motion, Clip Continuous Rec, Simul Rec su 2 slot e
Proxy Rec. Quando Interval Rec ¢ impostata su On,
queste altre modalita di registrazione vengono
automaticamente impostate su Off.

Configurazione prima della ripresa

Configurare Interval Rec (pagina 93) nel menu
Recording prima della ripresa.

Impostando Setting su On, viene attivata la
modalita Interval Rec e I’indicazione “Int Stby”
appare sullo schermo.

Se & montata una luce video compatibile con la
slitta multi interfaccia, & possibile impostare
Interval Rec >Pre-Lighting nel menu Recording
su On in modo che la luce si accenda
automaticamente 2 secondi, 5 secondi oppure
10 secondi prima dell’avvio della registrazione.

¢ Quando Pre-Lighting & impostato su On, la luce video
rimane sempre accesa se il tempo in cui dovrebbe
rimanere spenta risulta inferiore a 5 secondi in base
alle impostazioni di Interval Time, anche se Video
Light Set & impostato su Rec Link o Rec Link + Stby
nel menu Camera.

39

Registrazione in modalita Interval Rec

Avviare la registrazione dopo aver completato
I’impostazione richiesta.

Premere il pulsante di registrazione.

Dopo I’avvio della registrazione, I’indicazione
“Int Stby” scompare e vengono visualizzate in
alternanza le indicazioni “Int @Rec” e “Int
@Stby”.

Mentre la registrazione in modalita Interval Rec ¢ in
corso, Interval Time e Number of Frames non possono
essere modificati. Per modificare queste impostazioni,
€ necessario arrestare prima la registrazione.

Dopo I’avvio della registrazione in modalita Interval
Rec, la funzionalita di Rec Review non & disponibile,
nemmeno durante I’intervallo fra le riprese.

Durante la registrazione in modalita Rec Run, il codice
temporale viene registrato in modalita (pagina 92).
Durante la modalita Interval Rec, se si arresta la
registrazione o si cambia lo slot della scheda mentre la
registrazione & sospesa, potrebbero essere registrati
alcuni fotogrammi extra.

Interval Rec >Setting viene automaticamente
impostato su Off quando il selettore ON/STANDBY &
spostato sulla posizione STANDBY. Ciononostante, le
impostazioni Interval Time e Number of Frames sono
mantenute.

Registrazione continuata (Clip
Continuous Rec)

Normalmente, viene creato un nuovo file di clip
ogni volta che si avvia e arresta la registrazione.
La modalita Clip Continuous Rec, invece,
consente di avviare e arrestare la registrazione
continuando a registrare lo stesso clip finché la
funzione resta abilitata.

E comoda se non si desidera generare numerosi
clip brevi e se si preferisce registrare senza
preoccuparsi di superare il numero limite di clip.
E comunque facile trovare i punti iniziali, perché
ogni volta che si avvia una registrazione viene
inserito un marcatore Rec Start nel punto iniziale
della registrazione.

Per informazioni dettagliate sui formati di
registrazione compatibili con Clip Continuous
Rec, vedere (pagina 109).

Configurazione prima della ripresa

Configurare Clip Continuous Rec (pagina 93) nel
menu Recording prima della ripresa.



Impostando Setting su On, viene attivata la
modalita Clip Continuous Rec e I’indicazione
“Cont Stby” appare sullo schermo (pagina 11).

Configurazione tramite pulsanti programmabili
E anche possibile assegnare Clip Continuous Rec
a un pulsante programmabile (pagina 38) e
impostare la modalita Clip Continuous Rec On o
Off premendo tale pulsante.

La modalita Clip Continuous Rec non puo essere
impostata su On contemporaneamente a Interval Rec,
Picture Cache Rec, S&Q Motion e Simul Rec su 2 slot.
Quando Clip Continuous Rec & impostata su On,
queste altre modalita di registrazione vengono
automaticamente impostate su Off.

Non ¢ possibile utilizzare la modalita Clip Continuous
Rec durante la registrazione.

Registrazione in modalita Clip
Continuous Rec

Avviare la registrazione dopo aver completato
I’impostazione richiesta.

Premere il pulsante di registrazione.

Dopo I’avvio della registrazione, I’indicazione
“Cont Stby” scompare e appare al suo posto
I’indicazione “Cont @Rec” (@ diventa rosso).

Per evitare di dover ripristinare la scheda di memoria,
non rimuovere la scheda di memoria o la batteria e non
scollegare I’alimentazione durante la registrazione o
nella modalita di standby di registrazione (quando &
visualizzata I’indicazione “Cont Stby”). Rimuovere la
scheda di memoria solo dopo avere annullato la
modalita Clip Continuous Rec. Le schede di memoria
possono essere rimosse quando 1’indicazione “Cont
Stby” lampeggia (una volta al secondo).

Arrestare la registrazione dopo aver registrato per
almeno due secondi.

Per uscire, arrestare la registrazione.

Annullamento della modalita Clip Continuous
Rec

In modalita standby di registrazione, impostare
Clip Continuous Rec (pagina 93) >Setting nel
menu Recording su Off, oppure premere il
pulsante programmabile a cui ¢ assegnato Clip
Continuous Rec.

Limitazioni

Non ¢ possibile creare un singolo clip continuo se
si esegue una delle seguenti operazioni mentre la
videocamera sta registrando o & nella modalita di
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attesa della registrazione. Al successivo avvio

della registrazione verra creato un nuovo clip.

* Operazioni su un clip (blocco, eliminazione o
ridenominazione di un clip)

* Cambiamento dello slot per schede di memoria

* Cambiamento del formato di registrazione

» Spostamento del selettore ON/STANDBY su
STANDBY

* Visualizzazione della schermata delle miniature

 Riproduzione di un clip

* Annullamento della modalita Clip Continuous
Rec

Registrazione cache immagine
(Picture Cache Rec)

Il camcorder mantiene sempre nella memoria
interna una cache di dati video ed audio di una
certa durata (max. 28 secondi) durante le riprese.
Questo consente di registrare alcuni secondi di
riprese precedenti all’effettivo comando di avvio
della registrazione.

La modalita Picture Cache Rec puo essere
utilizzata quando il formato di registrazione
(pagina 99) ¢ impostato su XAVC-L.

La modalita Picture Cache Rec non puo essere
impostata su On contemporaneamente a Interval Rec,
Clip Continuous Rec, S&Q Motion, Simul Rec su 2
slot e Proxy Rec. Quando Picture Cache Rec &
impostata su On, queste altre modalita di registrazione
vengono automaticamente impostate su Off.

Non ¢ possibile selezionare la modalita Picture Cache
Rec durante la registrazione o Rec Review.

Quando Picture Cache Rec ¢ impostato su On, il codice
temporale viene registrato in modalita Free Run
indipendentemente dall’impostazione nel menu TC/
UB (pagina 92).

Configurazione prima della ripresa

Configurare Picture Cache Rec (pagina 93) nel
menu Recording prima della ripresa.
Impostando Setting su On, viene attivata la
modalita Picture Cache Rec e I’indicazione
“Cache” appare sullo schermo.

Configurazione tramite pulsanti programmabili
Assegnare Picture Cache Rec a un pulsante
programmabile (pagina 38) e impostare la
funzione On o Off premendo tale pulsante.



Registrazione in modalita Picture Cache
Rec

Avviare la registrazione dopo aver completato
I’impostazione richiesta.

Premere il pulsante di registrazione.

Dopo I’avvio della registrazione, I’indicazione
“Cache” scompare e appare al suo posto
I’indicazione “@Rec”.

Per uscire, arrestare la registrazione.

Per annullare la modalita Picture Cache Rec
Impostare Picture Cache Rec >Setting nel menu
Recording su Off, oppure premere il pulsante
programmabile a cui & assegnato Picture Cache
Rec.

» Se si cambia il formato di registrazione, il video gia
esistente nella memoria cache viene eliminato e la
memoria cache inizia a registrare nuovo video. Di
conseguenza, non ¢ possibile registrare le immagini
presenti nella cache prima del cambiamento del
formato se la registrazione viene avviata
immediatamente dopo il cambiamento stesso.

Se Picture Cache Rec viene attivata o disattivata
immediatamente dopo I’inserimento di una scheda di
memoria, & possibile che i dati della cache non
vengano registrati sulla scheda.

11 video viene memorizzato nella memoria cache a
partire dal momento in cui la modalita Picture Cache
Rec viene impostata su On. Prima dell’impostazione
su On della funzione, il video non viene memorizzato.
« Non viene memorizzato video nella cache durante
I’accesso a una scheda di memoria, ad esempio durante
riproduzione, Rec Review o visualizzazione delle
miniature. Durante tale periodo non & possibile
registrare immagini di cache.

Se ¢ montata una luce video compatibile con la slitta
multi interfaccia, la registrazione della cache prima
dell’avvio della registrazione non ¢ possibile, anche se
Video Light Set nel menu Camera menu € impostato su
Rec Link o Rec Link + Stby. La luce si accende e
spegne quando si preme il pulsante di registrazione.

Slow & Quick Motion

Quando ¢ impostato uno dei formati di
registrazione (pagina 99) elencati di seguito, &
possibile specificare una frequenza fotogrammi
di registrazione diversa dalla frequenza
fotogrammi di riproduzione.
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Formato di Frequenzadi S&Q Frame
registrazione sistema Rate
XAVC-L 1080P 59.94/29.97/ Dal a 60 fps

23.98/50/25
XAVC-L2160P 59.94/50

(1 unita FPS)

* La funzione Slow & Quick Motion non puo essere
impostata durante la registrazione, la riproduzione o
mentre ¢ visualizzata la schermata delle miniature.
La modalita Slow & Quick Motion non puod impostata
su On contemporaneamente a Interval Rec, Clip
Continuous Rec, Picture Cache Rec, Simul Rec su 2
slot e Proxy Rec. Quando Slow & Quick Motion &
impostata su On, queste altre modalita di registrazione
vengono automaticamente impostate su Off.

La modalita Slow & Quick Motion non consente la
registrazione di audio.

Configurazione prima della ripresa

Configurare S&Q Motion (pagina 92) nel menu
Recording prima della ripresa.

Impostando Setting su On, viene attivata la
modalita Slow & Quick Motion e I’indicazione
“S&Q Stby” appare sullo schermo.

Impostazione della frequenza fotogrammi di
registrazione con Direct Menu

E possibile impostare la frequenza fotogrammi di
registrazione in modalita Slow & Quick Motion
mediante Direct Menu (pagina 35).

Configurazione tramite pulsanti programmabili
Assegnare S&Q Motion a un pulsante
programmabile (pagina 38) per impostare la
modalita Slow & Quick Motion On o Off
premendo tale pulsante.

E possibile impostare la frequenza fotogrammi di
registrazione premendo e mantenendo premuto
un pulsante programmabile per visualizzare la
schermata di configurazione della frequenza
fotogrammi di registrazione.

Registrazione in modalita Slow & Quick
Motion

Avviare la registrazione dopo aver completato
I’impostazione richiesta.
Premere il pulsante di registrazione.

Dopo I’avvio della registrazione, I’indicazione
“S&Q Stby” scompare ed appare al suo posto
“S&Q @Rec”.



Non ¢ possibile modificare I'impostazione Frame Rate
durante la registrazione in modalita Slow & Quick
Motion. Per modificare queste impostazioni, &
necessario arrestare prima la registrazione.

La funzionalita di Rec Review non ¢ disponibile
durante registrazione Slow & Quick Motion.

1l codice temporale viene registrato in modalita Rec
Run durante la registrazione Slow & Quick Motion
(pagina 92).

Se si esegue la registrazione con una frequenza di
fotogrammi lenta, il camcorder potrebbe continuare la
registrazione per alcuni secondi dopo la pressione del
pulsante di registrazione per I’arresto della
registrazione.

Per uscire, arrestare la registrazione.

Per annullare la modalita Slow & Quick Motion
In modalita standby di registrazione, impostare
S&Q Motion >Setting nel menu Recording su
Off, oppure premere il pulsante programmabile a
cui ¢ assegnato S&Q Motion.

Registrazione simultanea in due
slot (Simul Rec)

E possibile registrare simultaneamente su
entrambe le schede di memoria A e B.

Configurazione prima della ripresa

Configurare Simul Rec (pagina 93) nel menu
Recording prima della ripresa.

La modalita Simul Rec su 2 slot non puo essere
impostata su On contemporaneamente a Interval Rec,
Clip Continuous Rec, Picture Cache Rec e S&Q
Motion. Quando Simul Rec su 2 slot & impostata su
On, queste altre modalita di registrazione vengono
automaticamente impostate su Off.

Ripresa in modalita Simul Rec su 2 slot

Avviare la registrazione dopo aver completato
I’impostazione richiesta.

Premere il pulsante di registrazione.

Per la modalita di registrazione Simul Rec su 2 slot &
necessario utilizzare schede dello stesso tipo e delle
stesse dimensioni.

La modalita Simul Rec su 2 slot non puo essere
impostata durante la registrazione, la riproduzione o
mentre ¢ visualizzata la schermata delle miniature.

¢ All’esaurimento dello spazio della scheda di memoria
di uno slot, la registrazione continua normalmente

sulla scheda nell’altro slot, se la seconda scheda &
registrabile. Quando si sostituiscono schede di
memoria durante una registrazione continua normale,
la modalita di registrazione simultanea e la modalita di
registrazione Relay non sono disponibili.

* Quando si avvia laregistrazione in modalita Simul Rec
su 2 slot, se ¢ inserita una scheda in un solo slot, oppure
se lascheda di uno slot & piena, il video viene registrato
solo sulla scheda registrabile.

Per uscire, arrestare la registrazione.

Per annullare la modalita Simul Rec su 2 slot
In modalita standby di registrazione, impostare
Simul Rec >Setting nel menu Recording su Off.

Modifica dell’impostazione del pulsante
di registrazione e del pulsante di
registrazione della maniglia

E possibile avviare o arrestare la registrazione
sulla scheda di memoria di ciascuno slot
indipendentemente, utilizzando il pulsante di
registrazione dell’impugnatura e il pulsante di
registrazione della maniglia.
Nell’impostazione predefinita, la registrazione
sulle schede di memoria A e B viene avviata o
arrestata contemporaneamente utilizzando uno
qualsiasi dei pulsanti.

* Rec Button:[ A »| [ B » Handle Rec
Button:| A+ | B »

Per modificare 'impostazione

Selezionare Simul Rec >Rec Button Set nel
menu Recording.

Rec Button Set Pulsanti e schede di

memoria

Avvia/arresta laregistrazione
Rec Button:| A » .
simultanea su entrambe le

Handle Rec schede di memoria A e B

Button: II premendo uno qualsiasi dei

pulsanti.




Rec Button Set Pulsanti e schede di

memoria

11 pulsante di registrazione
avvia o arresta la
registrazione sulla scheda di
memoria A mentre il
pulsante di registrazione
della maniglia avvia o arresta
la registrazione sulla scheda
di memoria B.

Rec Button:

Handle Rec

Button:| B »

11 pulsante di registrazione
avvia o arresta la
registrazione sulla scheda di
memoria B mentre il pulsante
di registrazione della
maniglia avvia o arresta la
registrazione sulla scheda di
memoria A.

Rec Button:| B »

Handle Rec

Button:| A »

Registrazione in modalita High
Dynamic Range (HDR)

Il camcorder dispone della modalita di imaging
ad elevata gamma dinamica HDR (High Dynamic
Range) per la registrazione e I’emissione in uscita
di immagini con spazio colore equivalente a
BT.20202 e una pit ampia gamma dinamica.

« Non disponibile per i formati di file DVCAM.

Impostazione della gamma dinamica

Per attivare la modalita ad alta gamma dinamica,
impostare Base Setting (pagina 99) >Shooting
Mode nel menu System su HDR.

Impostazione del tipo di HLG

Quando ¢ selezionata la modalita High Dinamic
Range, ¢ possibile impostare il tipo di HLG.

Per informazioni dettagliate, vedere (pagina 79).

Impostazione della funzione di assistenza alla
visualizzazione di gamma

Lo schermo LCD e il mirino del camcorder non
sono compatibili con la modalita HDR e non
consentono la visualizzazione in HDR. E tuttavia
possibile migliorare la visualizzazione e facilitare
le riprese utilizzando la funzione di assistenza alla
visualizzazione gamma.

Per scegliere I’impostazione della funzione di
assistenza alla visualizzazione di gamma,
utilizzare Gamma Display Assist (pagina 90) nel
menu LCD/VF.
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La funzione di assistenza alla visualizzazione di
gamma ha effetto solo sullo schermo LCD e sul
mirino. Non ha effetto sull’immagine registrata e
sull’immagine emessa in uscita.

Salvataggio e caricamento dei
dati di configurazione

E possibile salvare la configurazione del menu di
impostazione nella memoria interna del
camcorder oppure su una scheda SD o “Memory
Stick” contenuta nello slot UTILITY SD/MS.
Questo consente di richiamare rapidamente un set
di impostazioni precedentemente ottimizzato per
la situazione attuale.

I dati di configurazione sono salvati nelle
seguenti categorie:

File utente

I file utente salvano le impostazioni e i dati del
menu User personalizzabile.

Possono essere salvati fino a 64 file su una scheda
SD o “Memory Stick”.

Caricando questo file nella memoria del
camcorder, & possibile personalizzare la
configurazione del menu User.

File ALL (tutte le impostazioni)

Ifile ALL salvano i dati di configurazione di tutti
i menu. Possono essere salvati fino a 64 file su
una scheda SD o “Memory Stick™.

« I dati specifici di dispositivo (shading, livelli di uscita
ed altri dati che richiedono una regolazione specifica
per ogni dispositivo) non vengono salvati.

File di scena

I file di scena salvano le impostazioni delle voci

del menu Paint configurate per le scene. Possono

essere salvati fino a 5 file nella memoria interna
del camcorder e fino a 64 file su ciascuna scheda

SD o “Memory Stick”.

Supporti memoria compatibili per il
salvataggio dei dati di configurazione

Schede di memoria SDXC*
Schede di memoria SDHC*
Schede di memoria SD*
“Memory Stick PRO-HG Duo”**
“Memory Stick PRO Duo”**

* Denominate “schede SD” in questo documento.



*#* Denominate schede “Memory Stick” in questo
documento.

I dati di configurazione sono memorizzati sul

supporto nella seguente directory:

/PRIVATE/SONY/PRO/CAMERA/

PXW-Z190V/ (0 PXW-Z190T)

Formattazione di supporti di memoria
(inizializzazione)

E necessario formattare schede SD e “Memory
Stick” la prima volta che vengono utilizzate nel
camcorder.

Le schede SD e “Memory Stick” che devono
essere utilizzate con questo camcorder devono
essere formattate con la funzione di formattazione
del camcorder stesso. Se, al momento
dell’inserimento della scheda SD o “Memory
Stick” nel camcorder compare un messaggio,
formattare la scheda.

1 InserirelaschedaSD o “Memory Stick”
nello slot UTILITY SD/MS (pagina 8)
con I’etichetta rivolta verso destra.

2 Selezionare Format Media (pagina 95)
> Utility SD/MS >Execute nel menu
Media. Quando appare il messaggio di
conferma, selezionare nuovamente
Execute.

Durante la formattazione sono visualizzati un
messaggio e I’indicatore di avanzamento
dell’operazione. L’indicatore di accesso &
inoltre illuminato in rosso.

Al termine della formattazione, viene
visualizzato un messaggio per confermare
che I’operazione ¢ stata completata. Premere
il pulsante SET o la manopola SEL/SET per
chiudere il messaggio.

¢ La formattazione di una scheda SD o “Memory Stick”
elimina tutti i dati che contiene. I dati non possono
essere recuperati.

Controllo della capacita rimanente

E possibile controllare la capacita rimanente su
una scheda SD o “Memory Stick” nella schermata
Media Status (pagina 14).

* Se la scheda SD o “Memory Stick” ¢ protetta viene
visualizzata I’icona @
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* Per utilizzare supporti di memoria formattati con
questo camcorder su un altro dispositivo, eseguire il
backup di tutti i dati contenuti e quindi riformattare i
supporti sull’altro dispositivo.

Salvataggio di file utente o ALL

1 InserirelaschedaSD o “Memory Stick”
nello slot UTILITY SD/MS (pagina 8)
con ’etichetta rivolta verso destra.

2 Per un file utente, selezionare User File
(pagina 96) >Save Utility SD/MS
>Execute nel menu File.

Per un file ALL, selezionare All File
>Save Utility SD/MS >Execute nel
menu File.

Viene visualizzata la schermata di
destinazione per il salvataggio del file.

3 Selezionare una riga “No File” nella
finestra della destinazione di
salvataggio utilizzando il pulsante 4/¥/
<«/% 0 la manopola SEL/SET, quindi
premere il pulsante SET o la manopola
SEL/SET.

Se la riga selezionata contiene un File ID, il
file selezionato viene sovrascritto.

11 File ID viene generato automaticamente,
ma & possibile modificarlo.

4 Selezionare Execute nella schermata di
conferma utilizzando il pulsante 4/¥%/«/
* 0 la manopola SEL/SET, quindi
premere il pulsante SET o la manopola
SEL/SET.

Caricamento di file utente o ALL

1 InserirelaschedaSD o “Memory Stick”
contenente il file desiderato nello slot
UTILITY SD/MS (pagina 8) con
P’etichetta rivolta verso destra.

2 Per un file utente, selezionare User File
(pagina 96) >Load Utility SD/MS
>Execute nel menu File.

Per un file ALL, selezionare All File
>Load Utility SD/MS >Execute nel
menu File.

Viene visualizzato un elenco dei file.



3 Selezionare il file da caricare
utilizzando il pulsante 4#/%/«/» o0 la
manopola SEL/SET, quindi premere il
pulsante SET o la manopola SEL/SET.

Viene visualizzata una schermata di
conferma.

4 Selezionare Execute utilizzando il
pulsante 4/¥/«/% 0 la manopola SEL/
SET, quindi premere il pulsante SET o
la manopola SEL/SET.

« Il camcorder si riavvia automaticamente dopo il
caricamento dei dati di configurazione.

¢ Quando All File >Load Network Data nel menu File ¢
impostato su Off, saranno caricate tutte le impostazioni
contenute nel file ALL, eccetto le impostazioni del
menu Network.

Salvataggio di un file di scena

Salvataggio nella memoria interna

1 Selezionare Scene File >Store Internal
Memory >Execute nel menu File
(pagina 96).

Viene visualizzata una schermata contenente
I’elenco dei file di scena.

Se il File ID & impostato sulla destinazione
“Standard” saranno salvate le impostazioni
standard preconfigurate.

2  Selezionare la destinazione di
salvataggio utilizzando il pulsante 4/%/
<«/% o0 la manopola SEL/SET, quindi
premere il pulsante SET o la manopola
SEL/SET.

11 file di scena viene salvato sovrascrivendo
eventuali file esistenti nella destinazione
selezionata.

3 Selezionare Execute nella schermata di
conferma utilizzando il pulsante 4/¥/«/
» 0 la manopola SEL/SET, quindi
premere il pulsante SET o la manopola
SEL/SET.

Salvataggio su scheda SD o “Memory Stick”
1 InserirelaschedaSD o “Memory Stick”

nello slot UTILITY SD/MS (pagina 8)
con P’etichetta rivolta verso destra.
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2 Selezionare Scene File >Save Utility SD/
MS >Execute nel menu File (pagina 96).
Viene visualizzata la schermata di
destinazione di salvataggio del file di scena.

3 Selezionare una riga “No File” nella
finestra della destinazione di
salvataggio utilizzando il pulsante 4/¥/
<«/% 0 la manopola SEL/SET, quindi
premere il pulsante SET o la manopola
SEL/SET.

Se la riga selezionata contiene un File ID, il
file selezionato viene sovrascritto.

11 File ID viene generato automaticamente,
ma & possibile modificarlo.

4 Selezionare Execute nella schermata di
conferma utilizzando il pulsante 4/¥%/«/
# 0 la manopola SEL/SET, quindi
premere il pulsante SET o la manopola
SEL/SET.

Caricamento di un file di scena

Caricamento dalla memoria interna

1 Selezionare Scene File >Recall Internal
Memory >Execute nel menu File
(pagina 96).

Viene visualizzata una schermata contenente
I’elenco dei file di scena.

2 Selezionare il file da caricare
utilizzando il pulsante 4#/%/«/% o la
manopola SEL/SET, quindi premere il
pulsante SET o la manopola SEL/SET.
Viene visualizzata una schermata di
conferma.

3 Selezionare Execute utilizzando il
pulsante 4/%/«/% o la manopola SEL/
SET, quindi premere il pulsante SET o
la manopola SEL/SET.

I file di scena possono essere caricati sul
camcorder anche mediante Direct Menu
(pagina 35).

Caricamento da scheda SD o “Memory Stick”

1 InserirelaschedaSD o “Memory Stick”
contenente il file desiderato nello slot



UTILITY SD/MS (pagina 8) con
P’etichetta rivolta verso destra.

2 Selezionare Scene File >Load Utility
SD/MS >Execute nel menu File
(pagina 96).

Viene visualizzata una schermata contenente
I’elenco dei file di scena.

3 Selezionare il file da caricare
utilizzando il pulsante 4#/%/«/% o0 la
manopola SEL/SET, quindi premere il
pulsante SET o la manopola SEL/SET.
Viene visualizzata una schermata di
conferma.

4 Selezionare Execute utilizzando il
pulsante 4/¥/«/% o0 la manopola SEL/
SET, quindi premere il pulsante SET o
la manopola SEL/SET.

Per modificare il File ID

1 Per un file utente, selezionare User File
>File ID nel menu File (pagina 96).
Per un file ALL, selezionare All File
>File ID nel menu File (pagina 96).
Per un file di scena, selezionare Scene
File >File ID nel menu File (pagina 96).
Viene visualizzata una schermata per la
modifica del File ID.

2 Selezionare un carattere utilizzando il
pulsante 4/¥/«/% o la manopola SEL/
SET, quindi premere il pulsante SET o
la manopola SEL/SET.

3 Ripetere il passo 2 tutte le volte
necessarie.

4 Altermine dell’immissione di caratteri,
selezionare Done utilizzando il pulsante
4/%/«/% 0 la manopola SEL/SET,
quindi premere il pulsante SET o la
manopola SEL/SET.

Acquisizione delle informazioni di
posizione (GPS)

Quando la funzione di posizionamento ¢& abilitata,
durante la registrazione di video vengono
registrate sul supporto di memoria inserito nello
slot del camcorder informazioni relative alla
posizione, alla data e all’ora. Queste informazioni
possono essere emesse sull’uscita SDI.

1. Premere il pulsante MENU nella modalita di
standby.

2. Impostare GPS su On nel menu System.
Durante la ricerca dei satelliti GPS, il
camcorder mostra I’icona M@ . Una volta
acquisito il posizionamento, le informazioni
di posizione sono registrate con il video
ripreso.

» L’icona visualizzata nel mirino varia a seconda della
qualita di ricezione del segnale proveniente dai satelliti
GPS.

Stato di Visualiz- Stato della ricezione
posiziona- zazione GPS

mento

Off Nessuna ~ GPS impostato su Off o si

visualizza- & verificato un errore.
zione

Non ¢ possibile acquisire
informazioni di posizione

Posiziona- NO GPS
mento non SIGNAL

disponibile perché non ¢ possibile
ricevere il segnale GPS.
Spostarsi in un luogo che
permetta una visione del
cielo senza impedimenti.

Ricerca di Py Ricerca di satelliti in

satelliti in O\Q corso. L’acquisizione dei

corso satelliti puo richiedere
alcuni minuti.

Posiziona- P 11 segnale GPS ricevuto &

mento P aal | molto debole.

P 11 segnale GPS ricevuto &
O\|| adeguato. E possibile
acquisire informazioni di
posizione.

11 segnale GPS ricevuto &
buono. E possibile
acquisire informazioni di
posizione.

* Per impostazione predefinita, la funzione GPS &
impostata su On. Mentre la funzione di



posizionamento ¢ attiva, il camcorder registra le
informazioni di posizione, data e ora del video
ripreso. Per registrare informazioni di
posizione, impostare GPS su On.

L’avvio del posizionamento dopo I’accensione
del camcorder potrebbe richiedere un certo
tempo.

Se tuttavia I’icona di posizionamento non
appare entro alcuni minuti, & possibile che vi
siano problemi con la ricezione del segnale.
Avviare la ripresa senza informazioni di
posizione o spostarsi in un luogo che permetta
una visione del cielo senza impedimenti. Se
I’icona di posizionamento non ¢ visualizzata, le
informazioni di posizione non saranno
registrate con le riprese.

11 segnale GPS pud non essere ricevibile
durante le riprese in interni o in prossimita di
edifici di una certa altezza. Spostarsi in un
luogo che permetta una visione del cielo senza
impedimenti.

A seconda dell’intensita del segnale ricevuto, la
registrazione delle informazioni di posizione
potrebbe interrompersi anche se 1’icona di
posizionamento rimane visualizzata.
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Registrazione proxy

E possibile registrare dati proxy su una scheda SD
contenuta nello slot UTILITY SD/MS
contemporaneamente alla registrazione sulle
schede di memoria degli slot per schede di
memoria.

Schede SD supportate

Schede di memoria SDXC* (Speed Class: 4 o
superiore)

Schede di memoria SDHC* (Speed Class: 4 o
superiore)

Schede di memoria SD* (Speed Class: 4 o
superiore)

* Denominate “schede SD” in questo documento.

Formattazione (inizializzazione) di
schede SD

E necessario formattare le schede SD la prima
volta che vengono utilizzate nel camcorder.

Le schede SD da utilizzare con questo camcorder
dovrebbero essere formattate con la funzione di
formattazione di questo camcorder. Se viene
visualizzato un messaggio quando la scheda SD
viene inserita nel camcorder, formattare la scheda
SD.

1 Inserire la scheda SD nello slot
UTILITY SD/MS (pagina 8) con
Petichetta rivolta verso destra.

2 Selezionare Format Media (pagina 95)
>Utility SD/MS >Execute nel menu
Media. Quando appare il messaggio di
conferma, selezionare nuovamente
Execute.

Durante la formattazione sono visualizzati un
messaggio e I’indicatore di avanzamento
dell’operazione. L’indicatore di accesso ¢
inoltre illuminato in rosso.

Al termine della formattazione, viene
visualizzato un messaggio per confermare
che I’operazione ¢ stata completata. Premere
il pulsante SET o la manopola SEL/SET per
chiudere il messaggio.



¢ La formattazione di una scheda SD elimina tutti i dati
presenti su di essa. La scheda non pud essere
ripristinata.

¢ Le schede SDXC sono formattate exFAT, le schede
SDHC sono formattate FAT32 e schede SD sono
formattate FAT.

Controllo della capacita
rimanente

E possibile controllare la capacita rimanente su
una scheda SD nella schermata Media Status
(pagina 14).

» Se la scheda SD ¢ protetta viene visualizzata ’icona

Utilizzo su un altro dispositivo di supporti di
memoria formattati con questo camcorder
Eseguire il backup di tutti i dati registrati sulla scheda,
quindi riformattare la scheda nel dispositivo in cui deve
essere utilizzata.

Registrazione proxy (Proxy Rec)

Configurazione prima della ripresa

1 Impostare Proxy Rec >Setting nel menu
Recording su On.

2 Inserire la scheda SD nello slot
UTILITY SD/MS (pagina 8) con
P’etichetta rivolta verso destra.

La modalita Proxy Rec non puo essere impostata su On
contemporaneamente a Interval Rec, Picture Cache
Rec e S&Q Motion. Quando Proxy Rec & impostata su
On, queste altre modalita di registrazione vengono
automaticamente impostate su Off.

Registrazione di proxy

Avviare la registrazione dopo aver completato
I’impostazione richiesta.

Premere il pulsante di registrazione.

» Se il camcorder viene spento o la scheda SD viene
rimossa durante 1’accesso, non & possibile garantire
I’integrita dei dati contenuti su di essa. Tutti i dati
registrati sulla scheda potrebbero essere danneggiati.
Assicurarsi sempre che I’indicatore di accesso sia
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spento prima di spegnere il camcorder o rimuovere la
scheda SD.

* Prestare attenzione per evitare che la scheda SD salti
fuori dal camcorder durante 1’inserimento o
I’espulsione.

Per uscire, arrestare la registrazione.
Quando si arresta la registrazione su una scheda
di memoria, viene arrestata anche la registrazione

proxy.

Modifica delle impostazioni di
registrazione proxy

Impostazione delle dimensioni
dell’immagine

Selezionare Proxy Rec >Proxy Format nel menu
Recording ed impostare le dimensioni
dell’immagine.

Impostazione del canale audio

Selezionare Proxy Rec >Audio Channel nel menu
Recording ed impostare il canale audio per la
registrazione proxy.

Informazioni sul file registrato

L’estensione del nome del file & “.mp4”.
Anche il timecode viene registrato
simultaneamente.

Destinazione di salvataggio del
file registrato

11 file registrato viene salvato nella directory
“/PRIVATE/PXROOT/Clip”.

Informazioni sul nome file

11 nome del file consiste del nome del clip
registrato sulle schede di memoria negli slot per
schede di memoria, seguito da un suffisso
numerico consecutivo.

Nella modalita Simul Rec su 2 slot, il nome del
clip delo slot A ha la precedenza.

* Il numero consecutivo viene mantenuto anche dopo lo
spegnimento del camcorder. Il numero consecutivo
ritorna a 0001 eseguendo All Reset.



Per informazioni dettagliate sui nomi dei clip, vedere
Clip Naming (pagina 96) nel menu Media.

Registrazione di soli dati proxy

E possibile registrare solo i dati proxy,
indipendentemente, sulla scheda SD contenuta
nello slot UTILITY SD/MS senza laregistrazione
sulla scheda di memoria di uno slot per schede di
memoria.

11 formato di registrazione dei dati proxy ¢ lo
stesso utilizzato per la registrazione simultanea.
11 nome del file, tuttavia, & derivato dal codice
temporale al momento di inizio della
registrazione.

Ad esempio, se il codice temporale all’inizio della
registrazione ¢ “14:30:20:05”, allora il nome del
file diventa “14_30_20_05.mp4”.

Configurazione prima della ripresa

1 Assegnare Proxy Rec Start/Stop a un
pulsante programmabile (pagina 38).

2 Impostare Proxy Rec >Setting nel menu
Recording su On.

3 Inserire la scheda SD nello slot
UTILITY SD/MS (pagina 8) con
I’etichetta rivolta verso destra.

Registrazione

Avviare la registrazione dopo aver completato
I’impostazione richiesta.

Premere il pulsante programmabile a cui &
assegnato Proxy Rec Start/Stop.

Per arrestare la registrazione premere il pulsante
programmabile.

Connessione ad altri
dispositivi tramite LAN

Il camcorder in grado di collegarsi a smartphone,
tablet e altri dispositivi tramite connessione LAN.

Collegando il camcorder a un dispositivo su una
rete LAN, la funzione di telecomando Web
(pagina 55) o I’applicazione “Content Browser
Mobile” consentono di eseguire le operazioni
descritte di seguito.
* Comando a distanza tramite LAN
E possibile comandare a distanza il camcorder
mediante uno smartphone, un tablet o un
computer connesso tramite LAN.
* Monitoraggio video tramite LAN
E possibile creare uno stream (H.264) del video
ripreso o di riproduzione del camcorder e
monitorare tale video mediante 1’applicazione
“Content Browser Mobile” da un dispositivo
connesso a una LAN.

Applicazione “Content Browser Mobile”
L’applicazione “Content Browser Mobile”
consente di azionare il camcorder a distanza e
configurarne impostazioni tramite un dispositivo
durante il monitoraggio.

Per informazioni dettagliate sull’applicazione
“Content Browser Mobile” rivolgersi al proprio
rappresentante commerciale o di assistenza
tecnica Sony.

Connessione con la modalita
Punto di accesso LAN wireless

La videocamera funziona come un punto di
accesso e si connette a un dispositivo tramite
LAN wireless.



Smartphone/
tablet

Computer

Connessione a un dispositivo NFC
compatibile con un’operazione
One-touch

I dispositivi che supportano la funzione NFC
possono essere collegati tramite tale funzione
(connessione “One-Touch”).

1 Aprire [Settings] sul dispositivo,
selezionare [More] e contrassegnare
con un segno di spunta la casella di
controllo [NFC].

E

Accendere la videocamera.

Attivare la funzione NFC.

Mantenere premuto (per 3 secondi) il
pulsante programmabile a cui ¢ stata
assegnata la funzione NFC oppure
selezionare Wireless LAN >NFC nel menu
Network per attivare la modalita di
connessione NFC.

La funzione NFC ¢ disponibile solo quando
sullo schermo & visualizzato [§] .
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4 Toccare il camcorder con il dispositivo.

11 dispositivo si connette al camcorder ed

avvia “Content Browser Mobile”.

» Disabilitare in anticipo le modalita sleep e di blocco
schermo.

 Toccare e mantenere fermo il dispositivo fino a quando
non si avvia I’applicazione “Content Browser Mobile”
(1 0 2 secondi).

Connessione a un dispositivo WPS
compatibile

E possibile utilizzare la funzione di collegamento
WPS con i dispositivi che la supportano.

1 Selezionare Wireless LAN >Setting
>Access Point Mode nel menu Network.

2 Selezionare Wireless LAN >WPS
>Execute nel menu Network.

3 Aprire le impostazioni di rete o Wi-Fi
del dispositivo ed attivare Wi-Fi.

4 per eseguire il collegamento,
selezionare il SSID del camcorder
nell’elenco dei SSID in Wi-Fi Network
sul dispositivo, quindi selezionare WPS
Push Button in Option sul dispositivo.

« Il metodo di funzionamento dipende dal dispositivo.

* Per il SSID e la password del camcorder, fare
riferimento a AP Mode Settings (pagina 98) >Camera
SSID & Password nel menu Network.

5 Visualizzare il telecomando Web
(pagina 55). In alternativa, collegarsi



tramite I’applicazione Content Browser
Mobile.

Connessione mediante inserimento di
SSID e password su un dispositivo

E possibile connettere il camcorder a un
dispositivo immettendo sul dispositivo SSID e
password corrispondenti.

1 Selezionare Wireless LAN >Setting

>Access Point Mode nel menu Network.

2 Aprire le impostazioni di rete o Wi-Fi
del dispositivo ed attivare Wi-Fi.

3 Collegare il dispositivo al camcorder
selezionando il SSID del camcorder
nell’elenco dei SSID in Wi-Fi Network e
immettendo la password.

Per il SSID e la password del camcorder, fare
riferimento a AP Mode Settings (pagina 98)
>Camera SSID & Password nel menu
Network.

« Il metodo di funzionamento dipende dal dispositivo.

4 Visualizzare il telecomando Web
(pagina 55). In alternativa, collegarsi
tramite ’applicazione Content Browser
Mobile.

Connessione con la modalita
Wireless LAN Station

La videocamera si connette a un punto di accesso
esistente nella LAN wireless come client. La
videocamera e il dispositivo si connettono
attraverso il punto di accesso.

La cronologia mostra gli ultimi 10 punti di
accesso a cui ci si € collegati.

La cronologia viene salvata nel file ALL, ma le
password di accesso non vengono salvate. E
sempre necessario immettere la password la
prima volta che si esegue la connessione dopo
aver caricato un file ALL.
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Smartphone/
tablet

Computer

Punto di
accesso

Connessione a un punto di accesso
mediante WPS

Se il punto di accesso € compatibile con la
funzione WPS, ¢ possibile connettersi al punto di
accesso con impostazioni semplificate.

1 Accendereil punto di accesso.
2 Accendere la videocamera.

3 Selezionare Wireless LAN >Setting >
Station Mode nel menu Network.

4 Selezionare Wireless LAN >WPS
>Execute nel menu Network.

9 Premereil pulsante WPS del punto di
accesso.

Per informazioni dettagliate sull’uso del
pulsante WPS, consultare le istruzioni per
I’uso del punto di accesso.

Una volta realizzata correttamente la
connessione, I’icona di indicazione dello
stato della rete indichera un livello di
intensita del segnale sul monitor LCD o
mirino di almeno 1.

« Se la connessione non riesce, ripetere la procedura dal
punto 1.



6 Connettere il dispositivo al punto di

accesso.

Per informazioni dettagliate sulla
connessione, consultare le istruzioni per
I’uso del dispositivo.

Visualizzare il telecomando Web
(pagina 55). In alternativa, collegarsi
tramite ’applicazione Content Browser
Mobile.

Collegamento a un punto di accesso
mediante la funzione di rilevamento
automatico della rete 0 manualmente

E possibile configurare la connessione a un punto
di accesso desiderato dal menu di configurazione.
E possibile configurare la connessione a un punto
di accesso desiderato utilizzando la funzione di
rilevamento automatico della rete.

Connessione tramite la funzione di rilevamento
automatico della rete

1

Eseguire i passi da 1 a 3 descritti in
“Connessione a un punto di accesso
mediante WPS” (pagina 51).

Selezionare ST Mode Settings > Scan
Networks (pagina 98) >Execute nel
menu Network.

1l camcorder avvia la ricerca di destinazioni
di connessione.

Le destinazioni di connessione individuate
sono visualizzate nell’elenco dei risultati
della ricerca di Scan Networks.

Selezionare una connessione utilizzando
il pulsante 4/%/«/# o la manopola SEL/
SET, quindi premere il pulsante SET o
la manopola SEL/SET.

Appare momentaneamente la schermata dei
dettagli della rete (punto di accesso). La
connessione selezionata ¢ visualizzata in
SSID.

Selezionare Password, quindi
impostare la password nella schermata
di immissione della password.

Se ¢ presente una connessione prima del
rilevamento automatico della rete, la
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selezione del SSID visualizza la schermata
della password.

Impostare la password per tornare alla
schermata dei dettagli di rete (punto di
accesso).

Configurare le impostazioni di
connessione indicate di seguito.

* DHCP

Configurare I’impostazione DHCP.
Quando ¢ impostato su On, I’indirizzo IP
viene assegnato al camcorder
automaticamente.

Per assegnare manualmente 1’indirizzo IP
al camcorder, impostare su Off.

IP Address

Inserire 1’indirizzo IP della videocamera.
Questa impostazione ¢ disponibile solo
quando DHCP ¢ impostato su Off.

Subnet Mask

Inserire la subnet mask della videocamera.
Questa impostazione ¢ disponibile solo
quando DHCP ¢ impostato su Off.
Gateway

Inserire il gateway predefinito per il punto
di accesso.

Questa impostazione ¢ disponibile solo
quando DHCP ¢ impostato su Off.

DNS Auto

Impostare per acquisire DNS
automaticamente.

Quando impostato su On, I’indirizzo del
server DNS viene acquisito
automaticamente. Questa impostazione ¢
disponibile solo quando DHCP & impostato
su On.

Primary DNS Server

Inserire il server DNS primario per il punto
di accesso.

Questa impostazione ¢ disponibile solo
quando DNS Auto & impostato su Off.
Secondary DNS Server

Inserire il server DNS secondario per il
punto di accesso.

Questa impostazione ¢ disponibile solo
quando DNS Auto & impostato su Off.

Al termine, selezionare Connect per
connettersi al punto di accesso.



Connessione manuale

1

Eseguire i passi da 1 a 3 descritti in
“Connessione a un punto di accesso
mediante WPS” (pagina 51).

Selezionare ST Mode Settings > Manual
Register (pagina 98) >Execute nel menu
Network.

Appare momentaneamente la schermata dei
dettagli della rete (punto di accesso).

Configurare le impostazioni di
connessione indicate di seguito.

* SSID
Immettere il SSID del punto di accesso
della connessione.
* Security
Selezionare il metodo di crittografia.
* Password
Immettere la password del punto di
accesso.
Disponibile quando la voce Security non ¢
impostata su None.
DHCP
Configurare I’impostazione DHCP.
Quando ¢ impostato su On, I’indirizzo IP
viene assegnato al camcorder
automaticamente.
Per assegnare manualmente 1’indirizzo IP
al camcorder, impostare su Off.
IP Address
Inserire I’indirizzo IP della videocamera.
Questa impostazione ¢ disponibile solo
quando DHCP ¢ impostato su Off.
Subnet Mask
Inserire la subnet mask della videocamera.
Questa impostazione ¢ disponibile solo
quando DHCP ¢ impostato su Off.
Gateway
Immettere I’indirizzo del gateway.
Questa impostazione ¢ disponibile solo
quando DHCP ¢ impostato su Off.
DNS Auto
Impostare per acquisire DNS
automaticamente.
Quando impostato su On, I’indirizzo del
server DNS viene acquisito
automaticamente. Questa impostazione &
disponibile solo quando DHCP ¢ impostato
su On.
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* Primary DNS Server
Immettere 1’indirizzo del server DNS
primario.
Questa impostazione & disponibile solo
quando DNS Auto & impostato su Off.
» Secondary DNS Server
Immettere 1’indirizzo del server DNS
secondario.
Questa impostazione ¢ disponibile solo
quando DNS Auto ¢ impostato su Off.

Al termine, selezionare Connect per
connettersi al punto di accesso.



Elenco delle funzioni per le connessioni di rete

La seguente tabella mostra la disponibilita delle funzioni di rete nelle varie modalita di connessione.

Funzione di rete Modalita di connessione di rete

Access Point Station Off
Monitoraggio ob ob X
(pagina 49)
Telecomando del camcorder ob ob x
(pagina 55)

1) Funzioni del dispositivo connesso al camcorder tramite rete.

54



Utilizzo del telecomando
Web

E possibile accedere al telecomando Web
integrato del camcorder tramite tablet o computer
collegati in rete.

11 telecomando Web permette di azionare a
distanza il camcorder. E possibile avviare e
arrestare la registrazione nonché regolare le
impostazioni di registrazione da un dispositivo
connesso. Questa funzione ¢ utile per configurare
camcorder ubicati in luoghi non accessibili, ad
esempio su una giraffa, ecc.

Schermata Camera Control

Schermata Main

= Camera Control * Connected

00:00

Assign __ Main Cursor

Lock =™

Playback

V4. M8 116,

Shutter

1/60 STDS

Auto ND Filter

Auto White

« Stato

 Pulsante Start/Stop registrazione

¢ Cursore ND

* Cursore Iris (diaframma)

* Cursore Focus (messa a fuoco)

¢ Cursore Zoom

 Impostazioni di ripresa
S&Q FPS, Shutter, White, Gamma, Auto Iris, Auto
Shutter, AGC, Auto ND Filter, ATW, Gain, Color
Bars, Auto White

55

Schermata Playback

= Camera Control

00:00:00.00

Assign

* Stato
¢ Comandi di riproduzione:
F Rev, Play/Pause, F Fwd, Prev, Stop, Next

Schermata Cursor

= Camera Control
00:00:00.0

Assign Main  Playback _ Cursor

Menu

Thumbnail

Status

« Stato

* Pulsante spostamento cursore:
Su, Sinistra, Set, Destra, Giu, Cancel/Back, Menu,
Status, Thumbnail

Schermata Assign

= Camera Control

(h 37min
00:00:00.00 ==

12 p 9%9min
Main

Playback  Cursor

Y Y

@ or @ or

* Stato
* Pulsanti programmabili:
Pulsanti programmabilida 1 a 8

Visualizzazione del telecomando Web

1 Collegare il camcorder al dispositivo
tramite una connessione di rete
(pagina 49).



2 Avviare un browser sul dispositivo,
quindi aprire “http://indirizzo IP del
camcorder/rm.html”.

Esempio: Se I'indirizzo IP € 192.198.122.1,
immettere http://192.168.1.1/rm.html nella
barra degli indirizzi.

E possibile reperire 1'indirizzo IP del
camcorder nella schermata Network Status
(pagina 15).

3 Immettere nome utente e password
(menu Network — Access
Authentication — User Name e
Password) nel browser.

Una volta stabilita la connessione, sul
dispositivo viene visualizzata la schermata
del telecomando Web.

E possibile quindi azionare il camcorder
dalla schermata del telecomando Web.

E possibile disattivare il funzionamento del
pulsante facendo scorrere il selettore Lock
verso destra.

Nelle circostanze elencate di seguito, & possibile che la

schermata del telecomando Web non corrisponda alle

impostazioni del camcorder. In tal caso, ricaricare la

finestra del browser.

— Se il camcorder viene riavviato mentre ¢ connesso.

— Se il camcorder viene azionato direttamente mentre
€ connesso.

— Se il dispositivo si & riconnesso.

— Se sono stati utilizzati i pulsanti avanti/indietro del
browser.

La funzione di telecomando Web potrebbe non

funzionare correttamente se I’intensita del segnale

wireless ¢ insufficiente.

Dispositivi compatibili per il comando a
distanza tramite Web

E possibile utilizzare tablet o computer per
configurare e azionare il camcorder. La seguente
tabella indica i dispositivi, i sistemi operativi e i
browser supportati.

Dispositivo Sistema Browser
operativo

Tablet Android 6/7 Chrome
i0S 11 Safari

Computer Windows 7/8.1/ Chrome
10
macOS 10.12/  Safari
10.13
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Per informazioni dettagliate sui dispositivi
supportati dall’applicazione “Content Browser
Mobile” rivolgersi al proprio rappresentante
commerciale o di assistenza tecnica Sony.



Schermata delle miniature

Configurazione della schermata delle miniature

Quando si preme il tasto THUMBNAIL (pagina 10), i clip registrati sulla scheda di memoria vengono
visualizzati come miniature sullo schermo.

La schermata delle miniature consente di selezionare un clip e avviarne la riproduzione. L’immagine in
riproduzione ¢ visibile sullo schermo LCD/mirino e sui monitor esterni.

Premere di nuovo il pulsante THUMBNAIL per chiudere la schermata delle miniature e tornare
all’immagine della videocamera.

¢ La schermata delle miniature mostra solo i clip registrati nel formato di registrazione correntemente selezionato. Se un
clip registrato che avrebbe dovuto essere presente non ¢ visualizzato, controllare il formato di registrazione. Prestare
attenzione a questo fatto prima di procedere con la formattazione (inizializzazione) dei supporti di memoria.

Nella parte inferiore dello schermo vengono visualizzate le informazioni relative al clip su cui &
posizionato il cursore.

Indicatore della scheda di memoria selezionata
(Se la scheda & protetta, viene visualizzata I'icona del lucchetto).

Numero del clip/Numero totale dei clip

coroe 1T, 40 B, Bl

v
TCR00:00:00:12  TCR 00:00:00:15  TCR 00:00:00:34

-
TCR00:00:02:02  TCR 00:00:02:35

1. Miniatura (immagine indice) 3. Formato di registrazione video
Visualizza I’immagine indice del clip. Quando Visualizza il formato del file del clip
si registra un clip, il primo fotogramma viene selezionato.
Impostato automaticamente come immagine 4. Informazioni sulla registrazione speciale

indice.

Sotto la miniatura vengono visualizzate
informazioni sul clip e sul fotogramma. E
possibile modificare le informazioni
visualizzate utilizzando Customize View

(pagina 62) >Thumbnail Caption nel menu
Thumbnail. 5. Durata del clip

Se il clip ¢ stato registrato con una modalita di
registrazione speciale, ne indica la modalita.
Se il clip ¢ registrato in modalita Slow & Quick
Motion, ne viene indicata la frequenza
fotogrammi sulla destra.

2. Nome del clip 6. Data di creazione

Visualizza il nome del clip selezionato.
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Riproduzione di clip

Riproduzione dei clip registrati

E possibile riprodurre i clip registrati mentre il
camcorder si trova in modalita standby (Stby) di
registrazione.

1 Inserire la scheda di memoria da
riprodurre.

2 Premereil pulsante PLAY/PAUSE di
comando della riproduzione.

3 Cercareil clip desiderato premendo i
tasti PREV o NEXT.

4 Premereil pulsante PLAY/PAUSE.
L’immagine in riproduzione viene
visualizzata nel mirino.

E possibile comandare la riproduzione con i

seguenti pulsanti:

Pulsante PLAY/PAUSE: Mette in pausa la
riproduzione. Per riprendere la riproduzione,
premere nuovamente questo pulsante.

Pulsante F FWD/pulsante F REV:
Riproduzione accelerata. Per tornare alla
riproduzione normale, premere il pulsante
PLAY/PAUSE.

Pulsante STOP/CAM: Arresta la riproduzione
o la registrazione.

Selezione della prima miniatura
Premere e mantenere premuto il pulsante F REV
e premere il pulsante PREV.

Selezione dell’ultima miniatura
Premere e mantenere premuto il pulsante F FWD
e premere il pulsante NEXT.

Riproduzione in sequenza del clip
selezionato e dei clip successivi

1 Premereil pulsante 4#/%/«/% o ruotare
la manopola SEL/SET per spostare il
cursore sul clip da riprodurre.

2 Premereil pulsante SET o la manopola
SEL/SET.

La riproduzione si avvia dall’inizio del clip
selezionato.

Nel passaggio da un clip a un altro la visualizzazione
dell’immagine potrebbe momentaneamente
frazionarsi o arrestarsi. Durante questo periodo non &
possibile azionare il camcorder.

Quando si seleziona un clip nella schermata delle
miniature e ha inizio la riproduzione, potrebbero
verificarsi temporanei frazionamenti dell’immagine
all’inizio del clip. Per avviare la riproduzione senza
distorsioni, mettere in pausa la riproduzione subito
dopo averla avviata, premere il pulsante PREV di
comando della riproduzione per tornare all’inizio del
clip, quindi riavviare la riproduzione.

Monitoraggio dell’audio durante
la riproduzione

Nella modalita di riproduzione normale &
possibile monitorare i segnali audio registrati
tramite 1’altoparlante incorporato o le cuffie
collegate.

Collegando cuffie al connettore delle cuffie
(pagina 9) si disattiva 1’altoparlante incorporato.
Regolare il volume con i pulsanti VOLUME
(pagina 10).

E possibile selezionare il canale da monitorare
utilizzando Audio Output (pagina 86) nel menu
Audio.



Operazioni con i clip

Il menu Thumbnail consente di proteggere ed
eliminare clip, verificarne le proprieta ed eseguire
altre attivita.

Utilizzo del menu Thumbnail

Il menu Thumbnail puo essere utilizzato solo
quando & visualizzata una schermata di miniature.

1 Premereil pulsante THUMBNAIL.

Viene visualizzata la schermata delle
miniature.

2 Premereil pulsante MENU.

Viene visualizzata la schermata del menu.

3 Selezionare Thumbnail utilizzando il
pulsante 4/¥/«/% o la manopola SEL/
SET, quindi premere il pulsante SET o
la manopola SEL/SET.

Per uscire dal menu Thumbnail, premere
nuovamente il pulsante MENU.

Selezionare le voci principali e secondarie del
menu come descritto di seguito.

Selezionare una voce principale o
secondaria utilizzando il pulsante 4/%/«/% o
la manopola SEL/SET, quindi premere il
pulsante SET o la manopola SEL/SET.
Premere il pulsante CANCEL/BACK (pagina 9)
per ritornare alla schermata precedente.

* Quando la scheda di memoria ¢ protetta da scrittura,
alcune operazioni non sono disponibili.

« A seconda dello stato operativo del camcorder quando
viene visualizzato il menu, alcune voci potrebbero non
essere selezionabili.
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Selezionare Display Clip Properties nel menu Thumbnail.

45 6 7
Clip Properties @100
(clipooo1 ]
1
[7C Index 00:05:00:02)| Video codec  XAVC-L50
2 Start 00:05:00:00||| Size 1920x1080
End 00:08:19:23||| FPS 59.94P 8

(Duration 00:03:19:23||| Audio Codec  LPCM
J'Created Il chrBit 4ch 24bit

Aug-23-201410:58:42 | o Mode Interval Rec

3 Modified
—[‘ Muo03.2014 10:50.42 | ReG Device  PXW-Z190V(SN00001014)

1. Immagine del clip corrente

2. Indicatore del timecode (codice
temporale)
TC Index: Timecode del fotogramma
visualizzato
Start: Timecode del punto di inizio della
registrazione
End: Timecode del punto di fine della
registrazione
Duration: Durata del clip

3. Data e ora di creazione e modifica

4. Scheda di memoria attualmente
selezionata

5. Icona di protezione del supporto
6. Numero del clip/Numero totale dei clip
7.Icona della batteria

8. Informazioni sul clip
Nome del clip
Formato di registrazione
Informazioni sulla registrazione speciale
Nome del dispositivo di registrazione
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Protezione dei clip

E possibile proteggere uno o piil clip per evitarne
I’eliminazione accidentale.

(3 ¢ aggiunto alle miniature dei clip protetti.

E possibile applicare la protezione ai clip nella
schermata delle miniature.

Protezione di un clip specifico

1

Selezionare Lock/Unlock Clip >Select
Clip >Execute nel menu Thumbnail.

Appare la schermata di selezione dei clip.

Selezionare il clip da proteggere.

11 clip selezionato ¢ contrassegnato da un
segno di spunta.

Premere il pulsante MENU.

Viene visualizzata una schermata di
conferma.

Selezionare Execute.

Viene applicata la protezione al clip ed
appare un messaggio di conferma.

Premere il pulsante SET o la manopola
SEL/SET per chiudere il messaggio.

Protezione di tutti i clip

1

Selezionare Lock/Unlock Clip >Lock
All Clips nel menu Thumbnail.

Viene visualizzata una schermata di
conferma.

Selezionare Execute.

Viene applicata la protezione a tutti i clip ed
appare un messaggio di conferma.

Premere il pulsante SET o la manopola
SEL/SET per chiudere il messaggio.

Shlocco di tutti i clip

1

Selezionare Lock/Unlock Clip >Unlock
All Clips nel menu Thumbnail.

Viene visualizzata una schermata di
conferma.
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2 Selezionare Execute.

Viene rimossa la protezione da tutti i clip ed
appare un messaggio di conferma.

3 Premereil pulsante SET o la manopola
SEL/SET per chiudere il messaggio.

Copia di clip

E possibile copiare clip su un’altra scheda di
memoria.
I clip vengono copiati sulle schede di memoria di

destinazione con lo stesso nome dei clip originali.

 Se un clip con lo stesso nome ¢ gia contenuto nella

scheda di memoria di destinazione della copia, al nome

originale viene aggiunto un numero tra parentesi.

esiste nella destinazione della copia.

Esempi: ABCD0002 — ABCDO0002(1)
ABCDO0002(1) — ABCD0002(2)
ABCDO0005(3) — ABCD0005(4)

destinazione della copia perché il clip & stato copiato
piu di 1000 volte, non sara possibile eseguire altre
copie del clip con tale nome.

Qualora lo spazio sulla scheda di memoria di

destinazione non sia sufficiente, viene visualizzato un

messaggio di avvertenza. Sostituire la scheda ed
inserirne una con maggiore spazio libero.

pili clip registrati, potrebbe non essere possibile
copiare tutti i clip, in base alle caratteristiche della
memoria e di utilizzo delle schede, anche se le due
schede di memoria hanno la stessa capacita.

Il numero tra parentesi ¢ il numero pil piccolo che non

Se esistono gia numeri tra parentesi da (1) a (999) nella

Durante la copia di una scheda di memoria contenente

Copia di un clip specifico

1 Selezionare Copy Clip >Select Clip
>Execute nel menu Thumbnail.

Appare la schermata di selezione dei clip.

2 Selezionare il clip da copiare.

Il clip selezionato € contrassegnato da un
segno di spunta.

3 Premereil pulsante MENU.

Viene visualizzata una schermata di
conferma.

4 Selezionare Execute.

1l clip viene copiato ed appare un messaggio
di conferma.



O Premereil pulsante SET o la manopola
SEL/SET per chiudere il messaggio.

Copia di tutti i clip

E possibile copiare contemporaneamente tutti i
clip contenuti su una scheda di memoria ad
un’altra scheda di memoria.

1 Selezionare Copy Clip > All Clips nel
menu Thumbnail.

Viene visualizzata una schermata di
conferma.

2 Selezionare Execute.

Tutti i clip vengono copiati ed appare un
messaggio di conferma.

3 Premereil pulsante SET o la manopola
SEL/SET per chiudere il messaggio.

Eliminazione di clip

E possibile eliminare clip dalle schede di
memoria.

« I clip protetti non possono essere eliminati. Prima di
poterli eliminare, & necessario sbloccarli.

Eliminazione di un clip specifico

1 Selezionare Delete Clip >Select Clip
>Execute nel menu Thumbnail.

Appare la schermata di selezione dei clip.

2 Selezionare il clip da eliminare.

1l clip selezionato & contrassegnato da un
segno di spunta.

3 Premereil pulsante MENU.

Viene visualizzata una schermata di
conferma.

4 Selezionare Execute.

11 clip viene eliminato ed appare un
messaggio di conferma.

O Premereil pulsante SET o la manopola
SEL/SET per chiudere il messaggio.
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Eliminazione di tutti i clip

1 Selezionare Delete Clip > All Clips nel
menu Thumbnail.
Viene visualizzata una schermata di
conferma.

2 Selezionare Execute.

Tutti i clip vengono eliminati ed appare un
messaggio di conferma.

3 Premereil pulsante SET o la manopola
SEL/SET per chiudere il messaggio.

Filtraggio di clip (fotogrammi)
utilizzando la schermata delle
miniature degli indicatori di
identificazione

Quando sul clip & stato registrato un contrassegno
di avvio registrazione, ¢ possibile visualizzare
solo le miniature dei fotogrammi che lo
contengono.

Questa schermata & denominata schermata delle
miniature con Essence Mark.

Selezionare Thumbnail View >Essence

Mark Thumbnail nel menu Thumbnail per

scegliere il tipo di Essence Mark da filtrare.

All: Tutti i fotogrammi con Essence Mark
aggiunti

Rec Start: Fotogrammi con un contrassegno di
inizio registrazione e primo fotogramma di
clip senza contrassegno di inizio
registrazione.

Viene visualizzata la schermata delle miniature
con Essence Mark filtrata il base all’Essence
Mark selezionato.

Scelta delle informazioni
visualizzate nella schermata delle
miniature

E possibile scegliere le informazioni sui clip o sui
fotogrammi visualizzate sotto la miniatura.



Selezionare Customize View >Thumbnail

Caption nel menu Thumbnail, quindi

selezionare le informazioni da visualizzare.

Date Time: Data e ora di creazione e dell’ultima
modifica del clip.

Time Code: Codice temporale

Duration: Durata

Sequential Number: Numero della miniatura
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Connessione di un dispositivo esterno

Connessione di monitor e dispositivi di registrazione

esterni

Per visualizzare le immagini di registrazione e
riproduzione del camcorder su un monitor
esterno, selezionare il segnale di uscita del
camcorder e utilizzare il cavo appropriato per il
monitor esterno da collegare.

E possibile anche collegare dispositivi di
registrazione, ad esempio un VTR, e registrare il
segnale in uscita dal camcorder.

E possibile visualizzare sul monitor esterno le
stesse informazioni che sono visibili nel mirino,
ad esempio informazioni di stato e menu.
Impostare Output Display (pagina 87) nel menu
Video su On per il tipo di segnale da inviare al
monitor.

Connettore SDI OUT (tipo BNC)

Configurare I'impostazione di attivazione/
disattivazione dell’uscita e il formato di uscita nel
menu Video (pagina 87).

Per la connessione, utilizzare un cavo coassiale da
75 Q disponibile in commercio.

« Controllare la messa a terra della connessione fra il
camcorder e il dispositivo esterno prima di accendere i
dispositivi.

(Si consiglia di accendere il camcorder e il dispositivo
esterno dopo la connessione del cavo coassiale da

75 Q).

Se il dispositivo esterno deve essere collegato al
camcorder mentre il camcorder ¢ acceso, collegare il
cavo coassiale da 75 Q al dispositivo esterno per primo
e successivamente collegarlo al camcorder.

Per avviare la registrazione simultaneamente
sul camcorder e sul dispositivo esterno

Con I’uscita di segnale SDI abilitata, impostare
SDI/HDMI Rec Control (pagina 87) >Setting nel
menu Video su On per abilitare I’emissione di un
segnale di trigger REC diretto al dispositivo
esterno connesso al connettore SDI OUT. Questo
sincronizzera la registrazione sul dispositivo
esterno con il camcorder.

« Se il dispositivo esterno connesso non & compatibile
con il segnale di trigger REC, il dispositivo non pud
essere comandato.

Connettore HDMI OUT (tipo A)

Configurare I’impostazione di attivazione/
disattivazione dell’uscita e il formato di uscita nel
menu Video (pagina 87).

Per la connessione, utilizzare un cavo HDMI ad
alta velocita disponibile in commercio.

Connettore multi/micro USB

E possibile emettere in uscita segnali audio a
2 canali utilizzando il cavo VMC-15MR2 AV (in
vendita separatamente).



Gestione ed editing di
clip con un computer

Connessione con cavo USB

Collegare il camcorder a un computer con il cavo
USB fornito, quindi inserire una scheda di
memoria nello slot. La scheda di memoria viene
riconosciuta come un’unita di estensione del
computer.

Se sono presenti due schede di memoria sul
camcorder, il computer le riconosce come due
unita di estensione indipendenti.

¢ L’alimentazione di bus proveniente dal computer non
¢ sufficiente ad alimentare il camcorder. Provvedere a
una sorgente di alimentazione separata.
« Il camcorder non viene riconosciuto come un’unita di
estensione nei seguenti casi.
— Durante la registrazione (incluso le modalita di
registrazione speciali)
— Durante la riproduzione (incluso la riproduzione ad
alta velocita e se in pausa)
— Durante la visualizzazione delle miniature
— Durante la formattazione (inizializzazione) di
supporti di memoria
— Quando si ripristinano schede di memoria o si
aggiornano file di gestione (anche durante la
conferma prima dell’esecuzione)

1 Connettere il connettore multi/micro
USB del camcorder al computer
utilizzando un cavo USB.

2 Spostare il selettore ON/STANDBY su
ON.

Sullo schermo LCD o sul mirino viene
visualizzato un messaggio che invita a
confermare 1’abilitazione del collegamento
USB.

Se il messaggio di conferma scompare, scollegare
e ricollegare il cavo USB. Il messaggio di
conferma non & visualizzato durante la
visualizzazione delle schermate di registrazione,
riproduzione o miniature.

3 Selezionare Execute utilizzando il
pulsante 4/¥/«/% o la manopola SEL/
SET.
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4 su Windows, controllare che la scheda
sia aggiunta come disco rimovibile nella
finestra “My Computer”.

Su Macintosh, controllare che una
cartella con il nome “NO NAME” o
“Untitled” (modificabile) sia stata
creata sul Desktop.

Non eseguire le seguenti operazioni se I’indicatore di

accesso & illuminato in rosso.

— Spegnere I’apparecchio o scollegare il cavo di
alimentazione

— Rimozione della scheda di memoria

— Scollegare il cavo USB

Durante la rimozione di una scheda di memoria da un

computer Macintosh, non selezionare “Card Power

Off” dall’icona della scheda di memoria visualizzata

sulla barra dei menu.

11 funzionamento non & garantito su tutti i computer.

Utilizzo di software applicativo

Prima di poter copiare clip sul disco locale del
computer, & necessario scaricare ed installare sul
computer 1’apposito software applicativo. Per
ulteriori informazioni su come scaricare il
software, vedere “Download di software”
(pagina 124).

Anche se i dati relativi al materiale registrato sono
memorizzati su piu file e cartelle, & possibile
gestire facilmente i clip senza considerare la
struttura di directory e dati, utilizzando lo
specifico software applicativo.

« Se si eseguono operazioni sui clip, ad esempio,
copiando i clip sulla scheda di memoria mediante
Explorer (Windows) o Finder (Macintosh), i dati
ausiliari dei clip potrebbero andare perduti.

Utilizzo di un sistema di editing non
lineare

In un sistema di editing non lineare, & necessario
utilizzare un software di editing (opzione) che
supporti i formati registrati dal camcorder.
Utilizzare un software applicativo dedicato per
salvare in anticipo sul disco rigido del computer i
clip di cui eseguire 1’editing.



Connessione a supporti di
memoria HDD/USB esterni

Quando un disco HDD o un supporto di memoria
USB ¢ connesso al connettore USB 3.0 (HOST)
del camcorder, & possibile copiare clip dal
supporto di registrazione inserito nello slot per
schede di memoria al disco HDD o supporto di
memoria USB esterno.

Copia di clip verso il supporto di
memoria USB

1 Selezionare USB >Select Folder
(pagina 95) nel menu Media.

2 Selezionare la cartella di destinazione
della copia nell’elenco delle cartelle e
premere il pulsante SET o la manopola
SEL/SET.

E possibile anche selezionare New sullo
schermo per creare una nuova cartella.

Se non viene specificata nessuna cartella, i clip
verranno copiati in una cartella creata
automaticamente e avente come nome la data di
creazione del primo clip da copiare.

3 Selezionare USB >Copy to USB
(pagina 95) nel menu Media, inserire il
supporto di registrazione di
destinazione della copia e selezionare la
scheda di memoria.

Media(A) to USB: Copia tutti i clip dal
supporto di registrazione inserito nello slot
A.

Media(B) to USB: Copia tutti i clip dal
supporto di registrazione inserito nello slot
B.

Media(A)(B) to USB: Copia tutti i clip dai
supporti di registrazione inseriti negli slot
AeB.

¢ Quando viene specificata una cartella di
destinazione della copia al passo 2 ed &
selezionato Media(A)(B) to USB, i clip dello slot
A vengono copiati sulla cartella di destinazione
specificata. I clip dello slot B vengono invece
copiati su una cartella creata automaticamente
avente come nome la data di creazione del primo
clip.
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4 Selezionare Execute utilizzando il
pulsante 4/%/«/% o la manopola SEL/
SET, quindi premere il pulsante SET o
la manopola SEL/SET.

Tutti i clip contenuti nel supporto di
registrazione specificato sono copiati sul
supporto USB.

« Se nella cartella di destinazione esistono gia clip
con lo stesso nome dei clip da copiare, tali clip
non verranno copiati.

Visualizzazione dell’elenco dei clip
contenuti sul supporto di memoria HDD/
USB esterno

E possibile visualizzare I’elenco dei clip
contenuti sul supporto di memoria HDD/USB
utilizzando USB >View Clip List (pagina 95) nel
menu Media.

Rinomina di una cartella su un supporto
di memoria HDD/USB esterno

1 Selezionare USB >Rename Folder
(pagina 95) nel menu Media.

2 Selezionare la cartella a cui assegnare il
nuovo nome nell’elenco delle cartelle e
premere il pulsante SET o la manopola
SEL/SET.

Viene visualizzata una schermata per
I’immissione del nome di file.

3 Immettere il nome desiderato per la
cartella e selezionare Done.

La cartella viene rinominata.

Controllo di errori di lettura nella copia

E possibile controllare la presenza di errori di
lettura dopo la scrittura dei clip impostando USB
>Error Check (pagina 95) nel menu Media su On.

Formattazione (inizializzazione) di
supporti di memoria HDD/USB esterni

1 Selezionare USB >Format USB
(pagina 95) nel menu Media.



2 Selezionare Execute utilizzando il registrazione inserito in uno slot per schede di

pulsante 4/%/«/% o la manopola SEL/ memoria. ) : )
L. . * Non ¢ possibile registrare clip mentre viene fornita

SET, quindi premere il pulsante SET o alimentazione al connettore USB 3.0 (HOST). Per

la manopola SEL/SET. avviare la registrazione di clip, terminare 1’operazione

e . con la voce del menu USB nel menu Media.
La procedura di inizializzazione

(formattazione) ha inizio.

3 Al termine della formattazione viene
visualizzato un messaggio. Selezionare
OK.

Controllo della capacita rimanente su un
supporto di memoria HDD/USB esterno

La capacita rimanente su un supporto di memoria
HDD/USB esterno viene visualizzata sulla riga
Media Remain della schermata visualizzata
selezionando la voce USB nel menu Media.

Alimentazione del supporto di memoria
HDD/USB esterno

L’alimentazione viene fornita automaticamente
al supporto di memoria HDD/USB esterno dal
connettore USB 3.0 (HOST) quando si esegue
un’operazione con la voce di menu USB nel menu
Media.

Si osservi tuttavia che 1’alimentazione non viene
avviata nelle condizioni descritte di seguito,
anche se si esegue un’operazione con la voce di
menu USB nel menu Media. Per avviare
I’erogazione dell’alimentazione, procedere come
descritto nella tabella.

Stato Soluzione

Durante la registrazione e Terminare I’operazione
riproduzione di clip, la precedente.
visualizzazione di miniature,

la registrazione proxy, la

formattazione o ripristino di

supporti di memoria,

I’aggiornamento del file di

gestione, 1’aggiornamento di

software, il reset del

camcorder, il reset della rete,

la connessione di computer,

la visualizzazione di

schermate di conferma

Tensione di alimentazione  Sostituire la batteria o
insufficiente I’alimentazione di
ingresso.

« I clip presenti su un supporto di memoria HDD/USB
esterno non possono essere copiati sul supporto di

67



Struttura e configurazione del menu di impostazione

Premere il pulsante MENU per visualizzare sullo
schermo LCD o mirino il menu di impostazione
in cui specificare le opzioni necessarie per la
ripresa, la registrazione e la riproduzione (il menu
puo essere visualizzato anche su un monitor
esterno). Il menu di impostazione comprende i
menu elencati di seguito:

User Menu: Menu con voci configurate
dall’utente (modificare utilizzando Edit User
Menu).

Menu Edit User Menu: Menu per la modifica
delle voci del menu User.

Menu Camera: Contiene opzioni relative alla
ripresa.

Menu Paint: Contiene opzioni relative alla
qualita dell’immagine.

Menu Audio: Contiene opzioni relative
all’audio.

Menu Video: Contiene opzioni relative
all’uscita video.

Menu LCD/VF: Contiene opzioni per la
visualizzazione su schermo LCD e mirino.

Menu TC/UB: Contiene opzioni relative al
codice temporale e ai bit utente.

Menu Recording: Contiene opzioni relative
alla registrazione.

Menu Thumbnail: Contiene opzioni relative
alla visualizzazione delle miniature.

Menu Media: Contiene opzioni relative ai
supporti di memorizzazione.

Menu File: Contiene opzioni relative ai file.

Menu Network: Contiene opzioni relative alle
reti.

Menu System: Contiene opzioni relative al
sistema.

Struttura del menu di

impostazione
MENU
User Base Setting
Rec Format
S&Q Motion
Picture Cache Rec
Simul Rec
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+ Edit User Menu

- Camera

 Paint

 Audio

 Video

- Proxy Rec

— Output Format

I Assignable Button
- Delete Clip

— Wireless LAN

- Format Media

— Menu Settings

L Edit User Menu

Add ltem
Customize Reset

— Focus

- ND Filter

— Gain

— Shutter

— Auto Exposure

- Color Bars

I Flicker Reduce

- Flash Band Reduce
- SteadyShot

- Handle Zoom

- Speed Zoom

- Auto Black Balance
L Video Light Set

—— HDR Paint Setting
— White

— White Setting
— Offset White
 Black

— Gamma

- Knee

— White Clip

- Detail(QFHD)
- Detail(HD)
 Detail(SD)

- Skin Detail

— Aperture

— Matrix

L Maintenance

—I: Audio Input
Audio Output

Output On/Off
Qutput Format



— LCD/VF

- TC/UB

— Recording

— Thumbnail

— Media

- File

— Network

L System

I Output Display
I SDI/HDMI Rec Control
L Down Converter

— LCD Setting

— VF Setting

I Peaking

— Marker

- Zebra

- Gamma Display Assist
L Display On/Off

— Timecode
 Users Bit
L HDMI TC Out

— S&Q Motion

— Interval Rec

- Picture Cache Rec
 Clip Continuous Rec
— Simul Rec

- Proxy Rec

- Rec Review

— Display Clip Properties
- Lock/Unlock Clip

- Delete Clip

- Copy Clip
 Thumbnail View

L Customize View

— Update Media
- Format Media
— USB

L Clip Naming

— User File
- All File
L Scene File

— Access Authentication
— Wireless LAN

- AP Mode Settings

- ST Mode Settings

L Network Reset

— Base Setting

— Rec Format

- Assignable Button
— Tally

- Language

 Clock Set

- Hours Meter

- GPS

I Battery Alarm

- DC Voltage Alarm
- Menu Settings

— Fan Control

— All Reset

L Version

69



Operazioni del menu di
impostazione

Premere il pulsante MENU per visualizzare sullo
schermo LCD o mirino il menu di impostazione
in cui specificare le opzioni necessarie per la
ripresa, laregistrazione e la riproduzione (il menu
puo essere visualizzato anche su un monitor
esterno).

Comandi del menu

Pulsante MENU (pagina 9)
Attiva o disattiva la modalita di menu che
consente di utilizzare il menu di impostazione.

Manopola SEL/SET (pagina 9)

Ruotare la manopola per spostare il cursore verso
I’alto o il basso e selezionare voci di menu o
impostazioni.

Premere la manopola SEL/SET per applicare la
voce selezionata.

Pulsante CANCEL/BACK (pagina 9)
Premere per tornare al menu precedente. Le
modifiche non completate vengono annullate.

Pulsante 4/¥/«/»/SET

Premere i pulsanti 4/%/«/# per spostare il cursore
verso 1’alto, il basso, sinistra o destra e
selezionare voci o impostazioni del menu.
Premere la manopola SET per applicare la voce
selezionata.

« Il menu di impostazione non puo essere utilizzato
quando il camcorder si trova in modalita di
ingrandimento della messa a fuoco (pagina 27).

Impostazione delle voci dei menu

Spostare il cursore sulla voce desiderata
premendo il pulsante 4/%/«/# o ruotando la
manopola SEL/SET, quindi premere il pulsante
SET o la manopola SEL/SET per applicare
I’impostazione.

» L’area di selezione della voce di menu pud
mostrare fino a 9 righe. Se non possono essere
visualizzate contemporaneamente tutte le
opzioni disponibili per una determinata voce,
scorrere le opzioni spostando il cursore verso
I’alto o verso il basso.
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* Se la gamma di opzioni disponibili per una voce
secondaria & molto ampia (ad esempio da—99 a
+99), I’area di selezione non viene visualizzata.
Viene invece evidenziato il valore corrente per
indicare che tale valore puo essere modificato.

* Per eseguire una funzione, selezionare Execute.

* Se si seleziona una voce che richiede conferma
prima dell’esecuzione, il menu verra
momentaneamente nascosto e verra
visualizzato un messaggio di conferma.
Controllare il messaggio e quindi scegliere se
eseguire o annullare la funzione.

Immissione di una stringa di caratteri

Quando si seleziona una voce, come il nome di un
file, che richiede I’immissione di caratteri, viene
visualizzata la schermata di inserimento caratteri.

Edit File Name

Kurokawa_Scene_ 001 a

1 Ruotarela manopola SEL/SET per
selezionare il set di caratteri desiderato,
quindi premere la manopola.

ABC: Caratteri alfabetici maiuscoli
abc: Caratteri alfabetici minuscoli
123: Caratteri numerici

1#$: Caratteri speciali

2 Selezionare il carattere desiderato nel
set specificato, quindi premere la
manopola.

11 cursore si sposta sul campo successivo.
Space: Inserisce uno spazio alla posizione del
cursore.

«/%: Sposta la posizione del cursore.

BS: Elimina il carattere alla sinistra del
cursore (backspace).

3 Al termine, selezionare Done e premere
la manopola.



« Se tali funzioni erano gia assegnate a pulsanti
programmabili, la loro assegnazione viene disabilitata
automaticamente al momento del blocco del menu.

La stringa di caratteri viene confermata e la
schermata di inserimento dei caratteri si
chiude.

Blocco e shlocco del menu

E possibile bloccare il menu di impostazione in
modo che venga visualizzato solo il menu User.

Blocco del menu

1

Premere e mantenere premuta la
manopola SEL/SET e premere il
pulsante MENU.

Selezionare Menu Settings >User Menu
with Lock nel menu System.

¢ Quando viene premuto solo il pulsante MENU
per visualizzare il normale menu di impostazione,
I’indicazione User Menu Only & visualizzata
sotto Menu Settings nel menu System. Premere e
mantenere premuta la manopola SEL/SET e
quindi premere il pulsante MENU per
visualizzare User Menu with Lock.

Impostare su On e premere il pulsante
SET o la manopola SEL/SET.

Lo schermo LCD o il mirino visualizza la
schermata di immissione del numero di
codice di accesso (PIN).

Immettere un numero arbitrario.

Immettere un numero di 4 cifre compreso fra
0000 e 9999. 11 valore predefinito & 0000.
Immettere un numero e premere il pulsante
SET o la manopola SEL/SET per spostare il
cursore sulla cifra successiva.

Dopo aver immesso tutte le cifre, spostare il
cursore su SET.

Premere il pulsante SET o la manopola
SEL/SET.

11 valore immesso viene applicato.

Viene visualizzato un messaggio di conferma
e la schermata passa alla visualizzazione del
menu User.

¢ Se il menu viene bloccato senza aver registrato le voci

del menu di impostazione elencate nelle seguenti
tabelle del menu User, tali funzioni non potranno
essere assegnate a pulsanti programmabili.
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Voci del menu di
impostazione

Opzioni di
selezione dei
pulsanti
programmabili

Camera >Focus >Face
Detection AF

Face Detection AF

Camera >Focus >Focus
Macro

Focus Macro

Camera >Gain >Gain
<Turbo>

Turbo Gain

Camera >Auto Exposure
>Level

Auto Exposure Level

Camera >Auto Exposure Spotlight
>Mode

Camera >Auto Exposure Backlight
>Mode

Camera >Auto Exposure Auto ND Filter
>Auto ND Filter

Camera >Auto Exposure AGC

>AGC

Camera >Auto Exposure Shutter

>Auto Shutter

Camera >Color Bars Color Bars
>Setting

Camera >Flash Band Reduce Flash Band Reduce
>Setting

Camera >SteadyShot SteadyShot
>Setting

Camera >Handle Zoom
>Setting

Handle Zoom

Paint >White >Preset White

Preset White Select

LCD/VF >VF Setting >Color
Mode

VF Mode

LCD/VF >Peaking >Setting Peaking
LCD/VF >Marker >Setting ~ Marker
LCD/VF >Zebra >Setting Zebra

LCD/VF >Gamma Display =~ Gamma Display Assist
Assist >Setting

LCD/VF >Display On/Off ~ Lens Info

>Lens Info

LCD/VF >Display On/Off ~ Video Signal Monitor

>Video Signal Monitor

Recording >S&Q Motion
>Setting

S&Q Motion

Recording >Picture Cache
Rec >Setting

Picture Cache Rec

Recording >Clip Continuous
Rec >Setting

Clip Continuous Rec

Recording >Rec Review
>Setting

Rec Review




Voci del menu di Opzioni di

impostazione selezione dei
pulsanti
programmabili

Network >Wireless LAN NFC

>NFC

User User Menu

Sblocco del menu

1 Premere e mantenere premuta la
manopola SEL/SET e premere il
pulsante MENU.

2 Selezionare Menu Settings >User Menu
with Lock nel menu System.

¢ Quando viene premuto solo il pulsante MENU
per visualizzare il normale menu di impostazione,
I’indicazione User Menu Only ¢ visualizzata
sotto Menu Settings nel menu System. Premere e
mantenere premuta la manopola SEL/SET e
quindi premere il pulsante MENU per
visualizzare User Menu with Lock.

3 Impostare su Off e premere il pulsante
SET o la manopola SEL/SET.

Lo schermo LCD o il mirino visualizza la
schermata di immissione del numero di
codice di accesso (PIN).

4 Immettere il numero PIN usato per
bloccare il menu.

Immettere un numero e premere il pulsante
SET o la manopola SEL/SET per spostare il
cursore sulla cifra successiva.

Dopo aver immesso tutte le cifre, spostare il
cursore su Set.

O Premereil pulsante SET o la manopola
SEL/SET.

1l valore immesso viene applicato.

Se il numero PIN immesso corrisponde al
numero PIN utilizzato per bloccare il menu,
il menu viene sbloccato e viene visualizzato.

¢ Se il numero PIN immesso non corrisponde al numero
PIN utilizzato per bloccare il menu, il menu non verra
sbloccato.

« Si consiglia di annotare il numero PIN per evitare di
dimenticarlo. Se si dimentica il numero PIN, contattare
il rappresentante dell’assistenza tecnica Sony.

Modifica del menu User

E possibile modificare il menu User
aggiungendo, eliminando o spostando voci per
renderlo piu funzionale. Per modificare il menu
User, utilizzare la funzione Edit User Menu.

Aggiunta di voci principali e secondarie

1 Selezionare Edit User Menu >Add Item
nel menu User.

Vengono visualizzate le voci che possono
essere aggiunte.

2 Selezionare la voce da aggiungere.

Viene visualizzata una schermata per la
selezione delle voci secondarie da
aggiungere.

3 Selezionare la voce secondaria da
aggiungere.
Inserire un segno di spunta nella casella di
controllo All per aggiungere tutte le voci
secondarie.
Inserire un segno di spunta nelle singole
caselle di controllo per specificare le voci
secondarie che devono essere aggiunte.

4 Selezionare OK e quindi premere il
pulsante SET o la manopola SEL/SET.

Le voci principali o secondarie vengono
aggiunte.

* Non ¢ possibile registrare due volte la stessa voce
principale o secondaria.
Non ¢ possibile inoltre modificare il nome della voce
principale o secondaria.

Modifica delle voci secondarie

E possibile specificare le voci secondarie che
devono essere visualizzate.

1 Selezionare Edit User Menu nel menu
User, quindi selezionare la voce da
modificare.

Viene visualizzato 1’elenco delle funzioni
modificabili.



Selezionare Edit Sub Item.

Viene visualizzata la schermata Edit Sub
Item.

Quando la schermata viene aperta per la
prima volta, tutte le voci secondarie sono
selezionate (funzione per visualizzare tutte le
voci).

Rimuovere il segni di spunta delle voci
secondarie che non devono essere
visualizzate nel menu User.

Selezionare OK e quindi premere il
pulsante SET o la manopola SEL/SET.

Questo completa la modifica.

Eliminazione di una voce

1

Selezionare Edit User Menu nel menu
User, quindi selezionare la voce da
eliminare.

Viene visualizzato 1’elenco delle funzioni
modificabili.
Selezionare Delete.

La voce viene eliminata.

Spostamento di una voce

1

Selezionare Edit User Menu nel menu
User, quindi selezionare la voce da
spostare.

Viene visualizzato 1’elenco delle funzioni
modificabili.

Selezionare Move.

La voce da spostare viene evidenziata,
mentre la posizione di destinazione &
identificata da un simbolo triangolare e una
linea.

Spostare il simbolo triangolare e la linea
sulla destinazione desiderata della voce
e quindi premere il pulsante SET o la
manopola SEL/SET.

La voce viene spostata.
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Ripristino delle impostazioni predefinite
di fabbrica del menu User

1 Selezionare Edit User Menu
>Customize Reset nel menu User.
Viene visualizzata la schermata Customize
Reset.

2 Selezionare Reset e quindi premere il
pulsante SET o la manopola SEL/SET.
Viene visualizzata una schermata di
conferma.

3 Selezionare Execute e quindi premere il
pulsante SET o la manopola SEL/SET.
Le impostazioni predefinite di fabbrica del
menu User vengono ripristinate.



Elenco delle voci del menu di impostazione

Questa sezione descrive le funzioni e le impostazioni delle voci di ogni menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Menu User

User

Voci registrate per impostazione Descrizione

predefinita

Base Setting Voce System >Base Setting

Rec Format Voce System >Rec Format

S&Q Motion Voce Recording >S&Q Motion
Picture Cache Rec Voce Recording >Picture Cache Rec
Simul Rec Voce Recording >Simul Rec
Proxy Rec Voce Recording >Proxy Rec

Output Format

Voce Video >Output Format

Assignable Button

Voce System >Assignable Button

Delete Clip

Voce Thumbnail >Delete Clip

Wireless LAN

Voce Network >Wireless LAN

Format Media

Voce Media >Format Media

Menu Settings

Voce System >Menu Settings

Edit User Menu

Visualizza la schermata Edit User Menu.

Menu Edit User Menu

Edit User
Menu

Voce Voci secondarie e Descrizione
impostazioni
Add Item - Aggiunge voci principali e secondarie.
Customize Reset Ripristina le impostazioni predefinite di fabbrica del menu
Reset User.

Voci visualizzate Delete

Elimina una voce.

quando &
selezionata la voce

Move

Sposta una voce.

registrata. Edit Sub Item

Modifica una voce.
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Menu Camera

Camera

Voce Voci secondarie e Descrizione
impostazioni
Focus Face Detection AF Abilita o disabilita la modalita AF con rilevamento del viso.

Impostazioni AF
con rilevamento
del viso

Face Only AF/
Face Priority AF / Off

Focus Macro

Attiva o disattiva la modalita Macro.

On / Off
ND Filter Preset] Imposta il valore di preset 1 del filtro ND.
Impostazioni del 17128/ 1/64 / 1/32/ 1/16/
filtro ND 1/8/1/4
Preset2 Imposta il valore di preset 2 del filtro ND.
1/128/ 1/64/1/32 /1116 /
1/871/4
Preset3 Imposta il valore di preset 3 del filtro ND.
1/128/1/64 /1/32/ 1/16 /
1/871/4
Gain Gain<L> Imposta il guadagno quando il selettore GAIN si trova sulla
Impostazioni di 18dB /15dB /12dB /9dB /6dB posizione L.
guadagno /3dB/0dB /-3dB

Gain<M>
18dB / 15dB / 12dB / 9dB /
6dB /3dB /0dB /-3dB

Imposta il guadagno quando il selettore GAIN si trova sulla
posizione M.

Gain<H>
18dB / 15dB / 12dB / 9dB /
6dB /3dB /0dB /-3dB

Imposta il guadagno quando il selettore GAIN si trova sulla
posizione H.

Gain <Turbo>
30dB / 18dB / 15dB /

12dB /9dB / 6dB / 3dB / 0dB /

Imposta il valore di guadagno quando viene premuto un
pulsante programmabile a cui & assegnata la funzione Turbo
Gain.

-3dB

High Sensitivity Mode Attiva o disattiva la modalita di alta sensibilita.
On / Off

Shockless Gain Attiva o disattiva la funzione di guadagno fluido.
On / Off
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Camera

Voce Voci secondarie e Descrizione

impostazioni
Shutter Mode Seleziona la modalita operativa dell’ otturatore elettronico.
Impostazione delle Speed / Angle Consente di eseguire riprese nitide di soggetti in rapido
condizioni di movimento. Seleziona la modalita di impostazione della
funzionamento velocita dell’otturatore in secondi (Speed) o in gradi (Angle).
dell’otturatore Shutter Speed Imposta la velocita dell’otturatore quando & selezionata la

64F, 32F, 16F, 8F, TF, 6F, 5F,
4F, 3F, 2F, 1/24, 1/25, 1/30,
1/32, 1/33, 1/40, 1/48, 1/50,
1/60, 1/96, 1/100, 1/120, 1/125,
17250, 1/500, 1/1000, 1/2000,
174000, 1/8000

modalita Speed. I valori disponibili variano a seconda della
frequenza fotogrammi del formato video selezionato.

Shutter Angle
64F /32F / 16F / 8F / TF /
6F /5F/4F / 3F / 2F /
360.0° /300.0° /270.0° /
240.0°/216.0°/210.0° /
180.0°/172.8°/150.0° /
144.0° /120.0° 7 90.0° / 86.4° /
72.0°/45.0°/30.0°/22.5°/
11.25°/5.6°

Imposta I’angolo dell’otturatore quando & selezionata la
modalita Angle.

ECS
On / Off

Attiva o disattiva la modalita ECS.
Consente la ripresa senza visualizzare barre orizzontali in
movimento sullo schermo LCD o sul mirino.

ECS Frequency
Da 8000 a 23.99
(area NTSC: 60.00, area PAL:
50.00)

Imposta la frequenza ECS quando & selezionata la modalita
ECS. I valori disponibili variano a seconda della frequenza
fotogrammi del formato video selezionato.
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Camera

Descrizione

Voce Voci secondarie e
impostazioni

Auto Exposure Level

Impostazioni di +3.0/42.75/42.5/+2.25/

luminosita per +2.0/+1.75/+1.5/+1.25/

I’esposizione +1.0/+40.75/+0.5/+0.25/

automatica +0/-0.25/-0.5/-0.75/

-1.0/-125/-1.5/-1.75/
—2.0/-225/-25/-275/

Imposta il livello di compensazione.

-3.0
Mode Imposta la modalita di regolazione.
Backlight / Standard / Backlight: Modalita controluce (i soggetti ripresi in controluce
Spotlight appaiono meno scuri)
Standard: Modalita standard
Spotlight: Modalita riflettore (limita la sovraesposizione delle
alte luci quando il soggetto & illuminato da riflettori)
Speed Imposta la velocita di regolazione.
Da —99 a +99 (x0)
Auto ND Filter Attiva o disattiva la funzione di regolazione automatica della
On / Off densita del filtro ND.
AGC Attiva o disattiva la funzione AGC (controllo del guadagno
On / Off automatico).
AGC Limit Imposta il guadagno massimo della funzione AGC.
0dB /3dB/6dB /9dB / 12dB /
15dB / 18dB
AGC Point Imposta il valore di apertura (F-stop) del diaframma a cui ha
F2.8/F4/F5.6 inizio il funzionamento della funzione AGC quando la

funzione AGC & On.

Auto Shutter

Attiva o disattiva la funzione di otturatore automatico.

On / Off

A.SHT Limit Imposta la velocita massima della funzione di otturatore
1/100/ 1/150/ 1/200 / automatico.
1/250/ 1/2000

A.SHT Point Imposta il valore di apertura (F-stop) del diaframma a cui ha

F5.6/F8/F11

inizio il funzionamento della funzione di otturatore
automatico.

Clip High light Attiva o disattiva la funzione che ignora le zone piti luminose
On / Off per dare una reazione piu piatta alle luminanze elevate.
Detect Window Imposta la gamma di misura della luce per la regolazione

1/2/3/74/5/6

automatica della luce secondo la luminosita del soggetto.
(Non disponibile quando I’esposizione viene regolata
manualmente)

Detect Window Indication

Attiva o disattiva la funzione di visualizzazione di Detect

On / Off Window con un marcatore.
Color Bars Setting Attiva o disattiva la barra colori.
Impostazioni della ~ On/ Off
barra colori Type Seleziona il tipo di barre di colore.

ARIB / 100% / 75% / SMPTE
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Camera

Voce Voci secondarie e Descrizione
impostazioni

Flicker Reduce Mode Imposta la modalita di correzione dello sfarfallio.
Impostazioni di Auto / On / Off
correzif)ne dello  Frequency Consente di specificare la frequenza della sorgente di
starfallio 50Hz / 60Hz alimentazione del dispositivo di illuminazione che causa lo

(area NTSC: 60.00, area PAL: sfarfallio.

50.00)
Flash Band Setting Attiva o disattiva le funzione di correzione della flashband.
Reduce On / Off Riduce la sovraesposizione delle alte luci nelle sezioni
Impostazioni di superiore ed inferiore dell’immagine se si eseguono riprese
correzione della con un flash per fotocamera.
flashband
SteadyShot Setting Imposta la funzione di stabilizzazione dell’immagine.
Impostazioni della Active / Standard / Off
funzione di m
stabilizzazione » La modalita Active non & disponibile nei casi descritti di
dell’immagine seguito.

— Quando Video Format ¢ 3840x2160
— Durante la registrazione Slow & Quick Motion
Handle Zoom  Setting Imposta la velocita dello zoom della maniglia.
Impostazioni della Off / Low / High / Variable
velocita dello High Imposta la velocita dello zoom della maniglia quando &
zoom della Dala8(8) selezionata la velocita High.
maniglia — — N
Low Imposta la velocita dello zoom della maniglia quando &

Dala8(3) selezionata la velocita Low.
Speed Zoom  Setting Attiva o disattiva la funzione di velocita dello zoom.
Impostazioni della On / Off

funzione di
velocita dello

zoom
Auto Black Auto Black Balance Esegue la funzione di bilanciamento automatico del nero.
Balance Execute / Cancel m

Impostazioni del

bilanciamento * Non puo essere impostato durante la registrazione o la

automatico del
nero

visualizzazione della barra colori.

« Non pud essere impostato in modalita Interval Rec, in
modalita di registrazione fotogramma per fotogramma e in
modalita Otturatore lento.

Video Light
Set

Impostazioni della
luce video

Video Light Set
Power Link / Rec Link / Rec
Link + Stby

Imposta il metodo di comando dell’illuminazione per la luce

video montata sulla slitta multi interfaccia.

Power Link: Accende e spegne la luce video in sincronia con
I’accensione o spegnimento del camcorder.

Rec Link: Accende e spegne la luce video in sincronia con
I’avvio e I"arresto della registrazione.

Rec Link + Stby: La luce si accende o passa in modalita
standby in sincronia con 1’avvio e I’arresto della
registrazione.
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Menu Paint

Voce Voci secondarie e Descrizione

impostazioni
HDR Paint HLG Type Seleziona il tipo di HLG quando Shooting Mode & impostato
Setting HLG/HLG1/HLG2/HLG3 suHDR.
Impostazione della HLG: Impostazione equivalente a ITU-R BT.2100.
modalitd gamma HLG1: Impostazione che offre una soppressione del rumore
dinamica superiore rispetto a HLG2. Tuttavia, la gamma dinamica

che pud essere ripresa ¢ pitl limitata.

HLG2: Impostazione con bilanciamento tra gamma dinamica
e soppressione del rumore.

HLG3: Impostazione che offre una gamma dinamica pit
ampia rispetto a HLG2. Il livello del rumore tuttavia
aumentera.

HLG1, HLG2 e HLG3 utilizzano la stessa caratteristica di
curva di gamma, ma con gamme dinamiche e bilanciamenti
di rumore differenti.

HDR Black Offset
Da-95 a+103 (x0)

Imposta I’ offset del nero di HDR in relazione all’impostazione
di SDR (Master Black) quando Shooting Mode & impostato su
HDR.

HDR Knee
On / Off

Attiva o disattiva la funzione di correzione del knee per il
segnale HDR quando Shooting Mode ¢ impostato su HDR.

HDR Knee Point
Da -99 a +99 (x0)

Imposta il punto knee dei segnali HDR quando HDR Knee &
impostato su On.

HDR Knee Slope
Da -99 a +99 (x0)

Imposta la pendenza del knee dei segnali HDR quando HDR
Knee & impostato su On.
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Voce Voci secondarie e Descrizione
impostazioni
White Preset White Regola la temperatura di colore di preset quando nella

Impostazioni del
bilanciamento del
bianco

Da 10000K a 2100K (3200K)

modalita di bilanciamento del bianco & selezionato un preset.

* Non ¢ possibile controllare la variazione sullo schermo,
nemmeno se I'impostazione di Preset White viene
modificata quando non ¢ selezionato nessun preset nella
modalita di bilanciamento del bianco.

Color Temp <A>
Da 50000K a 1500K (3200K)

Visualizza la temperatura di colore di bilanciamento del
bianco salvata nella memoria A.

Color Temp Balance <A>
Da -99 a +99 (x0)

Imposta il valore di guadagno del bilanciamento del bianco
salvato nella memoria A (correlato al guadagno R e al
guadagno B).

R Gain <A>
Da -99 a +99 (x0)

Imposta il valore di guadagno R del bilanciamento del bianco
salvato nella memoria A.

B Gain <A>
Da -99 a +99 (x0)

Imposta il valore di guadagno B del bilanciamento del bianco
salvato nella memoria A.

Color Temp <B>
Da 50000K a 1500K (3200K)

Visualizza la temperatura di colore del bilanciamento del
bianco salvata nella memoria B.

Color Temp Balance <B>
Da —99 a +99 (x0)

Imposta il valore di guadagno del bilanciamento del bianco
salvato nella memoria B (correlato al guadagno R e al
guadagno B).

R Gain <B> Imposta il valore del guadagno R del bilanciamento del bianco
Da —99 a +99 (x0) salvato nella memoria B.
B Gain <B> Imposta il valore del guadagno B del bilanciamento del bianco
Da -99 a +99 (+0) salvato nella memoria B.
White Setting  Shockless White Imposta la velocita di risposta del bilanciamento del bianco
Impostazioni di Off/1/2/3 quando si cambia la modalita di bilanciamento del bianco.
regolazione del Off: Risposta istantanea.
bilanciamento del Da 1 a 3: La risposta avviene pill lentamente (piu alto il
bianco numero, minore la velocita).
ATW Speed Imposta la velocita di risposta in modalita ATW.
1/2/3/4/5 1: Piu alta velocita di risposta
White Switch<B> Seleziona la modalita di regolazione del bilanciamento del
Memory / ATW bianco che viene selezionata quando I’interruttore WHT BAL
€ impostato su B.
Filter White Memory Attiva o disattiva la funzione che imposta I’area di memoria
On / Off del bilanciamento del bianco per ciascun filtro ND.
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Voce Voci secondarie e Descrizione

impostazioni
Offset White  Offset White <A> Seleziona se aggiungere (On) o non aggiungere (Off) un
Impostazioni di On/ Off valore di correzione al valore di bilanciamento del bianco

correzione del

della memoria A.

bilanciamento del
bianco

Warm Cool <A>
Da -99 a +99 (+0)

Quando Offset White <A> & impostato su On, specifica (come
temperatura del colore) 1’offset da aggiungere al
bilanciamento del bianco della memoria A. (Si osservi che
I’errore aumenta con le temperature di colore di offset pil alte.
Eseguire la regolazione controllando I’immagine
effettivamente visualizzata).

Warm Cool Balance <A>
Da -99 a +99 (x0)

Imposta una temperatura di colore pill precisa, da utilizzare
quando non & possibile ottenere un’immagine soddisfacente
con I’impostazione Warm Cool <A>.

Offset White <B>
On/ Off

Seleziona se aggiungere (On) o non aggiungere (Off) un
valore di correzione al valore di bilanciamento del bianco
della memoria A.

Warm Cool <B>
Da -99 a +99 (x0)

Quando Offset White <B> & impostato su On, specifica (come
temperatura del colore) I’offset da aggiungere al
bilanciamento del bianco della memoria B. (Si osservi che
I’errore aumenta con le temperature di colore di offset pil alte.
Eseguire la regolazione controllando I’immagine
effettivamente visualizzata).

Warm Cool Balance <B>
Da -99 a +99 (x0)

Imposta una temperatura di colore piil precisa, da utilizzare
quando non & possibile ottenere un’immagine soddisfacente
con I’impostazione Warm Cool <B>.

Offset White<ATW> Seleziona se aggiungere (On) o non aggiungere (Off) un
On / Off valore di offset al bilanciamento del bianco ATW.
Warm Cool<ATW> Imposta come temperatura di colore 1’offset aggiunto al

Da-99 a +99 (+0)

bilanciamento del bianco ATW quando Offset White<ATW> ¢
impostato su On.

Warm Cool Balance<ATW>
Da -99 a +99 (x0)

Imposta una temperatura di colore piil precisa, da utilizzare
quando non & possibile ottenere un’immagine soddisfacente
con I'impostazione Warm Cool<ATW>.

Black
Impostazioni del

nero

Setting Attiva o disattiva la correzione del nero
On/ Off
Master Black Imposta il livello del nero master.

Da -99 a +99 (x0)

81



Voce Voci secondarie e Descrizione

impostazioni
Gamma Setting Attiva o disattiva la funzione di correzione della gamma.
Impostazioni di On/ Off

correzione della
gamma

Master Gamma
Da -99 a +99 (x0)

Imposta il livello di gamma master.

Gamma Category
STD/HG

Sceglie la gamma standard (STD) o HG.

Gamma Select

Quando Gamma Category &
impostato su STD:
STD1 DVW /STD2 x4.5/
STD3 x3.5 / STD4 240M /
STD5 R709 / STD6 x5.0

Quando Gamma Category &
impostato su HG:
HGI 3250G36/

Seleziona la tabella di gamma da utilizzare nella correzione
gamma.

HG2 4600G30 /
HG3 3259G40 /
HG4 4609G33
Knee Setting Attiva o disattiva la funzione di correzione del knee
Impostazioni di On/ Off (Abilitata quando Gamma >Gamma Category ¢ impostata su
correzione del STD)
knee Auto Knee Consente di attivare e disattivare la funzione di knee
On / Off automatico.
Point Imposta il punto knee
Da 75% a 109% (90%)
Slope Imposta la pendenza del knee
Da -99 a +99 (x0)
Knee Saturation Abilita o disabilita la correzione della saturazione knee
On / Off (corregge il colore sopra il punto di knee).
Knee Saturation Level Imposta il livello di correzione del colore sopra il punto knee
Da -99 a +99 (+0) (saturazione knee)
White Clip Setting Attiva o disattiva la funzione di regolazione del clipping del
Impostazioni di On/ Off bianco.
regolazione del 1 evel Specifica il livello di clip del bianco.

clip del bianco

Da 90.0% a 109.0%
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Voce Voci secondarie e Descrizione
impostazioni
Detail(QFHD) Manual Setting Attiva o disattiva la funzione di regolazione dei dettagli.
Impostazioni di On / Off
regolaz}ione dei Level Imposta il livello del dettaglio.
dettagli (QFHD) Da 99 a +99 (+0)
Frequency Imposta la frequenza centrale del dettaglio (spessore di
Da -99 a +99 (x0) dettaglio). Il dettaglio & tanto piu sottile quanto piu alta & la
frequenza centrale e tanto piti spesso quanto pill bassa la
frequenza centrale.
Knee Aperture Attiva o disattiva la funzione di correzione dell’apertura del
On / Off knee.
Knee Aperture Level Imposta il livello di apertura knee.
Da —99 a +99 (x0)
White Limit Imposta il valore di limitazione del dettaglio verso il bianco.
Da -99 a +99 (x0)
Black Limit Imposta il valore di limitazione del dettaglio verso il nero.
Da -99 a +99 (x0)
V Detail Creation Imposta la sorgente del segnale per la creazione del dettaglio
NAM/Y/G/G+R V su NAM (G o R, qualunque sia maggiore), Y, G o G+R.
Detail(HD) Manual Setting Attiva o disattiva la funzione di regolazione dei dettagli.
Impostazioni di On / Off
regolazione dei Level Imposta il livello del dettaglio.
dettagli (HD) Da -99 a +99 (x0)
Frequency Imposta la frequenza centrale del dettaglio (spessore di

Da -99 a +99 (x0)

dettaglio).

11 dettaglio € tanto pil sottile quanto piu alta & la frequenza
centrale e tanto pill spesso quanto piu bassa la frequenza
centrale.

Knee Aperture
On / Off

Attiva o disattiva la funzione di correzione dell’apertura del
knee.

Knee Aperture Level
Da -99 a +99 (x0)

Imposta il livello di apertura knee.

White Limit Imposta il valore di limitazione del dettaglio verso il bianco.
Da —99 a +99 (x0)
Black Limit Imposta il valore di limitazione del dettaglio verso il nero.

Da -99 a +99 (x0)

V Detail Creation
NAM/Y/G/G+R

Imposta la sorgente del segnale per la creazione del dettaglio
V su NAM (G o R, qualunque sia maggiore), Y, G o G+R.
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Voce Voci secondarie e Descrizione
impostazioni
Detail(SD) Manual Setting Attiva o disattiva la funzione di regolazione dei dettagli.
Impostazioni di On / Off
regolaz}ione dei Level Imposta il livello del dettaglio.
dettaglio (SD) Da 99 a +99 (+0)
Frequency Imposta la frequenza centrale del dettaglio (spessore di
Da -99 a +99 (+0) dettaglio).
11 dettaglio & tanto pit sottile quanto piu alta ¢ la frequenza
centrale e tanto pill spesso quanto pitt bassa la frequenza
centrale.
Knee Aperture Attiva o disattiva la funzione di correzione dell’apertura del
On / Off knee.
Knee Aperture Level Imposta il livello di apertura knee.
Da -99 a +99 (x0)
White Limit Imposta il valore di limitazione del dettaglio verso il bianco.
Da —99 a +99 (x0)
Black Limit Imposta il valore di limitazione del dettaglio verso il nero.
Da —99 a +99 (x0)
V Detail Creation Imposta la sorgente del segnale per la creazione del dettaglio
NAM/Y/G/G+R V su NAM (G o R, qualunque sia maggiore), Y, G o G+R.
Skin Detail Setting Attiva o disattiva la funzione di correzione del dettaglio pelle.
Impostazioni di On / Off

correzione del

Area Detection

Identifica il colore utilizzato per la correzione del dettaglio

dettaglio pelle Execute / Cancel pelle.
Execute: Esegue la funzione.
Area Indication Attiva o disattiva la funzione che visualizza il motivo zebra
On / Off nella zona di colore in cui agisce la correzione del dettaglio
pelle.
Level Imposta il livello del dettaglio pelle.
Da -99 a +99 (x0)
Saturation Imposta la saturazione del colore su cui applicare la
Da -99 a +99 (x0) correzione del dettaglio pelle.
Hue Imposta la tonalita (hue) del colore su cui applicare la
Da 0 a 356 correzione del dettaglio pelle.
Width Specifica il campo della tonalita (hue) del colore su cui
Da 0 a 90 (40) applicare la correzione del dettaglio pelle.
Aperture Setting Abilita o disabilita la funzione di correzione dell’apertura, un
Impostazioni di On/ Off processo che permette di migliorare la risoluzione
correzione aggiungendo sul segnale video un segnale di apertura ad alta
dell’apertura frequenza che corregge il degrado dovuto alle caratteristiche
delle alte frequenze.
Level Imposta il livello della correzione di apertura.

Da -99 a +99 (+0)

84



Voce Voci secondarie e Descrizione
impostazioni
Matrix Setting Attiva o disattiva la funzione di correzione della matrice.
Impostazioni di On/ Off
correzione della  Adaptive Matrix Attiva o disattiva la funzione di matrice adattiva.
matrice On / Off
Preset Matrix Attiva o disattiva la funzione di matrice preimpostata.
On/ Off
Preset Select Seleziona una matrice preimpostata.
1:SMPTE 240M /

2:ITU-709 / 3:SMPTE Wide /
4:NTSC/5:EBU/ 6:PAL

Maintenance
Impostazioni di
manutenzione

Test Saw
On / Off

Attiva o disattiva il segnale di prova.

Menu Audio

Voce

Voci secondarie e
impostazioni

Descrizione

Audio Input

Impostazioni di

CH2 EXT Input Select
INPUT1 /INPUT2

Seleziona I’ingresso per la registrazione sul canale 2. Abilitato
solo quando ¢ selezionata la sorgente audio EXT.

ingresso audio

CH3 Input Select
Off / INPUT1 / Internal MIC /
Shoe CH1

Seleziona I’ingresso per la registrazione sul canale 3.

CH4 Input Select
Off /INPUT1 / INPUT2 /
Internal MIC / Shoe CH2

Seleziona I’ingresso per la registrazione sul canale 4.

INPUT1 MIC Reference
-80dB /-70dB / -60dB /
—50dB / —40dB /-30dB

Seleziona il livello di ingresso di riferimento quando il
selettore INPUT1 & impostato su MIC.

INPUT2 MIC Reference
-80dB /-70dB / —60dB /
-50dB / —40dB / -30dB

Seleziona il livello di riferimento di ingresso quando il
selettore INPUT?2 ¢ impostato su MIC.

Internal MIC Level
—-12dB / -6dB / 0dB / +6dB /
+12dB

Seleziona il livello del microfono interno. Questo livello pud
essere selezionato indipendentemente dalla posizione della
manopola AUDIO LEVEL.

Line Input Reference
+4dB /0dB / -3dB / EBUL

Seleziona il livello di riferimento di ingresso quando il
selettore INPUT1/INPUT?2 ¢ impostato su LINE.

Reference Level
—20dB /-18dB /-16dB /

Seleziona il livello di registrazione del segnale di tono di
riferimento a 1 kHz.

—12dB / EBUL
CH1 Wind Filter Attiva o disattiva il filtro di riduzione del rumore del vento per
On / Off la registrazione sul canale 1.
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Voce Voci secondarie e Descrizione
impostazioni
Audio Input CH2 Wind Filter Attiva o disattiva il filtro di riduzione del rumore del vento per
Impostazioni di On / Off la registrazione sul canale 2.
ingresso audio CH3 Wind Filter Attiva o disattiva il filtro di riduzione del rumore del vento per
On / Off la registrazione sul canale 3.
CH4 Wind Filter Attiva o disattiva il filtro di riduzione del rumore del vento per
On / Off la registrazione sul canale 4.
CH3 Level Control Seleziona la regolazione automatica o manuale del livello di
Auto / Manual ingresso per la registrazione sul canale 3.
CH4 Level Control Seleziona la regolazione automatica o manuale del livello di
Auto / Manual ingresso per la registrazione sul canale 4.
CH3 Input Level Imposta il livello di ingresso per la registrazione sul canale 3
Da 0a 99 (49) quando ¢ selezionata la regolazione manuale.
CH4 Input Level Imposta il livello di ingresso per la registrazione sul canale 4
Da 0a 99 (49) quando ¢ selezionata la regolazione manuale.
Limiter Mode Seleziona la caratteristica di limitazione (livello di

Off /-6dB / —9dB / -12dB /

—-15dB /-17dB

saturazione) per i segnali di ingresso di livello elevato quando
il livello di ingresso audio viene regolato manualmente.

CH1&2 AGC Mode
Mono / Stereo

Seleziona la modalita di regolazione automatica del livello per
la registrazione sui canali 1 e 2. Quando ¢ selezionato Stereo,
AGC ¢ sincronizzato sui due canali.

CH3&4 AGC Mode Seleziona la modalita di regolazione automatica del livello per
Mono / Stereo la registrazione sui canali 3 e 4. Quando ¢ selezionato Stereo,
AGC ¢ sincronizzato sui due canali.
AGC Spec Seleziona la caratteristica AGC (livello di saturazione) per i
—6dB /-9dB /-12dB / segnali di ingresso di livello elevato quando il livello di
—-15dB /-17dB ingresso audio viene regolato manualmente.

1kHz Tone on Color Bars
On / Off

Attiva o disattiva I’emissione del segnale di tono di
riferimento a 1 kHz durante la visualizzazione delle barre
colore.

Audio Output
Impostazioni
uscita audio

Monitor CH Seleziona I'uscita del canale audio sul jack cuffie e
CH1/CH2 / CH3/CH4 / MIX  sull’altoparlante incorporato.
ALL/CHI1/CH2/CH3/CH4

Headphone Out Imposta su mono (Mono) o stereo (Stereo) I’uscita cuffie.

Mono / Stereo

Alarm Level Imposta il volume dell’allarme.
Da0a7(4)

HDMI Output CH Seleziona la combinazione dei canali audio sull’uscita HDMI.
CH1/CH2 / CH3/CH4

Analog Output CH Seleziona la combinazione dei canali audio sull’uscita audio
CH1/CH2 / CH3/CH4 analogica.
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Menu Video

Voce Voci secondarie e Descrizione
impostazioni
Output On/Off SDI Attiva o disattiva I’uscita SDIL
Impostazioni di On / Off
uscita video HDMI Attiva o disattiva I’'uscita HDMI.
On/ Off
Output Format SDI Imposta la risoluzione dell’uscita SDI.
Impostazioni del SET: Imposta la funzione.
formato di uscita
* Perinformazioni
dettagliate su - - -
queste HDMI Imposta la risoluzione dell’uscita HDMI.
impostazioni, SET: Imposta la funzione
vedere “Formati
video e segnali di
uscita”

(pagina 111).

Output Display
Impostazioni del
segnale di uscita

SDI/HDMI
On / Off

Sceglie se aggiungere il menu o lo stato al segnale di uscita
SDI/HDMI.

SDI/HDMI Rec
Control
Impostazioni di
comando del
dispositivo esterno
collegato

Setting
On / Off

Attiva o disattiva ’avvio e I’arresto della registrazione su un
dispositivo esterno tramite i segnali di uscita SDI/HDMI.

Down
Converter
Modalita d’uso
con il Down
Converter

Down Converter

Edge Crop / Letter Box /

Squeeze

Imposta la modalita di uscita (aspetto) dei segnali SD.

Edge Crop: Taglia i lati di un’immagine 16:9 per fornire in
uscita un’immagine 4:3.

Letter Box: Maschera le sezioni superiore e inferiore
dell’immagine 4:3 e la visualizza come immagine 16:9 al
centro dello schermo.

Squeeze: Schiaccia I’'immagine 16:9 orizzontalmente e la
emette in uscita come immagine 4:3.
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Menu LCD/VF

LCD/VF

Voce Voci secondarie e Descrizione
impostazioni
LCD Setting Brightness Consente di regolare la luminosita dello schermo LCD.
Impostazioni dello  Da 99 a +99 (x0)
schermo LCD
VF Setting Brightness Regola la luminosita dell’immagine del mirino.
Impostazioni del Da 99 a +99 (+0)
mirino Color Mode Seleziona la modalita di visualizzazione del mirino in
Color / B&W modalita di registrazione o E-E.
Peaking Setting Attiva o disattiva la funzione Peaking.
Impostazioni di On / Off
peaking Type Seleziona il tipo di peaking.
Normal / Color Normal: peaking normale

Color: peaking del colore

Normal Peaking Frequency

Seleziona la frequenza di peaking standard (Normal) o alta

Normal / High (High).

Normal Peaking Level Imposta il livello di peaking normale.
Da 0 a 99 (50)

Color Seleziona il colore del segnale di peaking colore.
B&W /Red/ Yellow / Blue

Color Peaking Level
Da 0a 99 (50)

Imposta il livello del peaking colore.
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LCD/VF

Voce Voci secondarie e Descrizione
impostazioni
Marker Setting Attiva o disattiva la visualizzazione di tutti gli indicatori.
Impostazioni di On/ Off
visu‘tﬂ‘izzf’nzioné Color Seleziona il colore di visualizzazione degli indicatori.
degli indicatori White / Yellow / Cyan / Green
/ Magenta / Red / Blue
Center Marker Attiva o disattiva la visualizzazione dell’indicatore centrale.
1/2/3/4/0Off
Safety Zone Attiva o disattiva la visualizzazione dell’indicatore della zona
On / Off di sicurezza.
Safety Area Seleziona le dimensioni dell’indicatore della zona di sicurezza
80% /1 90% / 92.5% 1 95% (come percentuale delle dimensioni totali dello schermo).
Aspect Marker Seleziona I’indicatore del rapporto di aspetto.
Line / Mask / Off Line: Mostra con linee bianche.
Mask: Visualizza un livello di segnale video pil basso per le
aree esterne alla zona dell’indicatore.
Off: Non visualizzato.
Aspect Mask Seleziona la luminosita dell’immagine all’esterno

Da0al5(12)

dell’indicazione di aspetto quando Aspect Marker & impostato
su Mask.

Aspect Safety Zone
On / Off

Attiva o disattiva la visualizzazione della zona di sicurezza di
aspetto.

Aspect Safety Area
80% /90% / 92.5% 1 95%

Seleziona le dimensioni dell’indicatore della zona di sicurezza
di aspetto come percentuale delle dimensioni totali dello
schermo.

Aspect Select
4:3/13:9/14:9/15:9/
16:9/17:9/1.66:1/1.85:1/
2.35:1/2.4:1

Seleziona il rapporto dell’indicatore di aspetto.

Guide Frame

Attiva o disattiva la visualizzazione del riquadro di guida.

On / Off

100% Marker Attiva o disattiva la visualizzazione della zona di sicurezza
On / Off 100%.

User Box Attiva o disattiva la visualizzazione del cursore a riquadro.
On / Off

User Box Width Specifica la larghezza del cursore a riquadro (distanza dal
Da 40 a 999 (500) centro ai bordi destro e sinistro).

User Box Height Specifica I"altezza del cursore a riquadro (distanza dal centro
Da 70 a 999 (500) al bordo superiore e inferiore).

User Box H Position
Da —479 a +479 (x0)

Imposta la posizione orizzontale del centro del cursore a
riquadro.

User Box V Position
Da —464 a +464 (x0)

Specifica la posizione verticale del centro del cursore a
riquadro.
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LCD/VF

Voce Voci secondarie e Descrizione
impostazioni
Zebra Setting Consente di attivare e disattivare la funzione del motivo
Impostazioni del On / Off zebrato.
motivo zebra Zebra Select Seleziona il tipo di motivo zebra (Zebral, Zebra2, Both).
1/2/Both

Zebral Level
0% - 107% (70%)

Imposta il livello di visualizzazione di Zebral.

Zebral Aperture Level
1% - 20% (10%)

Imposta il livello di apertura di Zebral.

Zebra2 Level
0% - 109% (100%)

Imposta il livello di visualizzazione di Zebra2.

Gamma
Display Assist
Impostazioni
assistenza
visualizzazione
gamma

Setting
HLG—709 (800%) / Off

Seleziona le impostazioni per la funzione di assistenza per la
visualizzazione gamma.

Display On/Off

Impostazioni della

Network Status
On / Off

visualizzazione
delle indicazioni

Rec/Play Status
On / Off

Tally
On / Off

Battery Remain
On/ Off

Focus Mode
On / Off

Focus Position
Meter / Feet / Off

Focus Macro
On / Off

Face Detection Frame
On / Off

Lens Info
Meter / Feet / Off

Rec Format
On / Off

Frame Rate
On / Off

Zoom Position
Number / Bar / Off

Digital Extender
On / Off

GPS
On / Off

SteadyShot
On / Off

Consente di selezionare gli elementi da visualizzare sullo
schermo LCD/mirino.

90



LCD/VF

Voce Voci secondarie e Descrizione
impostazioni

Gamma
On / Off

SDI/HDMI Rec Control
On / Off

Gamma Display Assist
On / Off

Proxy Status
On / Off

Focus Assist Indicator
On / Off

Focus Assist Area
On / Off

Media Status
On / Off

Video Signal Monitor
Off / Waveform / Vector /
Histogram

Clip Name
On / Off
White Balance
On / Off

Scene File
On / Off

Auto Exposure Mode
On / Off
Auto Exposure Level
On / Off
Timecode
On / Off
ND Filter
On / Off
Iris
On/ Off
Gain
On / Off
Shutter
On / Off
Audio Level Meter
On / Off
Video Level Warning
On / Off
Clip Number
On / Off

Notice Message
On / Off
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Menu TC/UB

TC/UB

Voce Voci secondarie e Descrizione
impostazioni
Timecode Mode Imposta la modalita di avanzamento del codice temporale.

Impostazioni del Preset / Regen / Clock Preset: Avvia il codice temporale dal valore specificato.
codice temporale Regen (rigenerazione): Avviail codice temporale proseguendo
dal codice temporale del clip precedente.
Clock: Utilizza I’orologio interno come codice temporale.
Run Rec Run: Avanza solo durante la registrazione.

Rec Run / Free Run

Free Run: Avanzamento costante, indipendentemente
dall’accensione del camcorder.

Setting Imposta il codice temporale su un valore arbitrario.
SET: Imposta il valore.
Reset Azzera il codice temporale (00:00:00:00)
Execute / Cancel Execute: Esegue la funzione.
TC Format Imposta il formato del codice temporale.
DF / NDF DF: Drop Frame
NDF: Non-Drop Frame
Users Bit Mode Imposta la modalita del bit utente.
Impostazioni bit Fix / Time Fix: Utilizza per i bit utente un valore fisso arbitrario.
utente Time: Utilizza per i bit utente la data e I’ora correnti.
Setting Imposta i bit utente su un valore arbitrario.
HDMI TC Out  Setting Consente di selezionare se emettere il codice temporale ad
Impostazioni di On / Off altri dispositivi per altri scopi, tramite HDMIL.
uscita del codice
temporale

Menu Recording

Voce Voci secondarie e
impostazioni

Descrizione

S&Q Motion  Setting
Impostazioni della On / Off

Attiva o disattiva la modalita Slow & Quick Motion.

modalita Slow &  Frame Rate
Quick Motion Da lfps a 60fps

Imposta la frequenza dei fotogrammi durante la ripresa con la
funzione Slow & Quick Motion quando I’impostazione S&Q &
On.

I valori disponibili variano a seconda di frequenza di sistema,
codec e formato video selezionati.
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Voce Voci secondarie e Descrizione

impostazioni
Interval Rec Setting Attiva o disattiva la modalita di registrazione a intervalli.
Modalita di On / Off
Tegislrzifjone a Interval Time Imposta I’intervallo fra le registrazioni nella modalita di
mtervall

1sec/2sec/3sec/4sec/5sec/ registrazione a intervalli (Interval Rec impostata su On).
6sec / Tsec / 8sec / 9sec / 10sec

/ 15sec / 20sec / 30sec / 40sec /

50sec / 1min / 2min / 3min /

4min / Smin / 6min / 7min /

8min /9min/ 10min / 15min /

20min / 30min / 40min / 50min

/ 1hour / 2hour / 3hour / 4hour /

6hour / 12hour / 24hour

Number of Frames
Le impostazioni disponibili
variano in base
all’impostazione della
frequenza di sistema.

Imposta il numero di fotogrammi da registrare per ciascuna
ripresa nella modalita di registrazione a intervalli (Interval Rec
impostata su On).

2frames / 6frames / 12frames Quando la frequenza fotogrammi di registrazione & 50P o

59.94P.

1frame / 3frames / 6frames /
9frames

Quando la frequenza fotogrammi di registrazione non & 50P o
59.94P.

Pre-Lighting
Off / 2sec / 5sec / 10sec

Specifica con che anticipo (in secondi) si deve accendere la
luce video prima dell’avvio della ripresa in modalita Interval
Rec. Per non accendere la luce video, selezionare Off.

Picture Cache Setting
Rec On / Off

Attiva o disattiva la funzione di registrazione cache immagine.

Impostazioni della Cache Rec Time
modalita di Le impostazioni disponibili

Specifica il tempo di accumulo delle immagini nella memoria
cache immagine (il tempo di registrazione della cache

registrazionecache  variano in base alle immagine).
immagine impostazioni del formato di
registrazione.
Clip Setting Attiva o disattiva la funzione di registrazione clip continua.
Continuous On / Off
Rec Find Mode Seleziona I’operazione eseguita premendo i pulsanti NEXT o

Impostazioni della
modalita di
registrazione clip

Clip / Rec Start

PREV.

continua
Simul Rec Setting Attiva o disattiva la modalita di registrazione simultanea e
Impostazioni della On / Off specifica il supporto di destinazione della registrazione.

modalita di
registrazione
simultanea

Rec Button Set

Rec Button:| A »/| B »

Handle Rec Button:[ A |

/ Rec Button:
Handle Rec Button: /

Rec Button: Handle Rec

Button:| A

Seleziona i pulsanti utilizzati per controllare la registrazione
sui vari supporti di registrazione.
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Voce Voci secondarie e Descrizione
impostazioni
Proxy Rec Setting Attiva o disattiva la modalita di registrazione proxy.

Impostazioni della On / Off

modalita di Proxy Format

Imposta le dimensioni di immagine per il file proxy.

registrazione 1920x1080(9Mbps) / Se impostata su 1920x1080(9Mbps) ¢ la frequenza di sistema
proxy 1280x720(9Mbps) / ¢ 23.98, la registrazione utilizza la scansione progressiva. Per
1280x720(6Mbps) / le frequenze di sistema diverse da 23.98, la registrazione
640%x360(3Mbps) / utilizza la scansione interlacciata.
480x270(1Mbps) / Per impostazioni diverse da 1920x1080(9Mbps), la
480x270(0.5Mbps) registrazione utilizza sempre la scansione progressiva,
indipendentemente dalla frequenza di sistema.
Audio Channel Seleziona il canale audio da registrare sui dati proxy.
CH1/CH2 / CH3/CH4

Rec Review Setting

Impostazioni della ~ 3sec/ 10sec / Clip
revisione della

registrazione

Seleziona la durata della riproduzione dei clip appena
registrati per la loro revisione.

Menu Thumbnail

Thumbnail

Voce Voci secondarie e
impostazioni

Descrizione

Display Clip
Properties
Schermata di
visualizzazione
delle proprieta dei
clip

Visualizza la schermata delle proprieta dei clip.

Lock/Unlock  Select Clip

Seleziona e blocca o sblocca un clip.

Clip Lock All Clips

Blocca tutti i clip.

Impostazioni di 7 G T Clips
protezione dei clip

Sblocca tutti i clip.

Delete Clip Select Clip Elimina il clip selezionato.

Elimina clip All Clips Elimina tutti i clip visualizzati.

Copy Clip Select Clip Copia i clip selezionati.

Copy clips All Clips Copia tutti i clip del supporto di memoria.
Thumbnail Essence Mark Thumbnail Visualizza le miniature di tutti i fotogrammi contenenti

View All / Rec Start

contrassegni di avvio della registrazione.

Impostazioni di Clip Thumbnail
visualizzazione
della schermata
delle miniature

Visualizza miniature dei clip registrati.
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Thumbnail

Voce Voci secondarie e Descrizione
impostazioni
Customize Thumbnail Caption Seleziona le informazioni visualizzate sotto le miniature.
View Date Time / Time Code /
Impostazioni di Duration / Sequential Number
visualizzazione

della schermata
delle miniature
delle immagini
ferme.

Menu Media

Il menu Media non ¢ disponibile se non sono inseriti supporti.

Voce Voci secondarie e Descrizione
impostazioni
Update Media Media(A) Aggiorna il file di gestione della scheda di memoria nello slot
Aggiornamento Execute / Cancel A.
dei supporti Media(B) Aggiorna il file di gestione della scheda di memoria nello slot
Execute / Cancel B.
Format Media Media(A) Formatta la scheda di memoria nello slot A.
Formattazione del Execute / Cancel Execute: Esegue la funzione.
supporto Media(B) Formatta la scheda di memoria nello slot B.
Execute / Cancel Execute: Esegue la funzione.
Utility SD/MS Formatta la scheda nello slot UTILITY SD/MS.
Execute / Cancel Execute: Esegue la funzione.
USB Select Folder Seleziona una cartella sul supporto di memoria USB.
Impostazioni Crea una nuova cartella sul supporto di memoria USB.
relative alla copia  view Clip List Visualizza I’elenco dei clip presenti sul supporto di memoria
di clip dai supporti USB.
fh re?‘? trazione Rename Folder Rinomina una cartella sul supporto di memoria USB.
inseriti nello slot
per schede di Error Check Seleziona se eseguire o meno il controllo degli errori durante
memoria a On/ Off la copia su supporti di memoria USB.
supporti di Format USB Formatta (inizializza) il supporto di memoria USB.
memoria USB. Execute / Cancel Execute: Esegue la funzione.
Copy to USB Seleziona lo slot di destinazione per la copia di clip da una

Media(A) to USB / Media(B) scheda di memoria a una cartella su un supporto di memoria
to USB / Media(A)(B) to USB  USB.

Media Remain Visualizza lo spazio libero rimanente sul supporto USB (solo
visualizzazione).
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Voce Voci secondarie e Descrizione
impostazioni
Clip Naming  Title Prefix Apre la schermata Edit File Name per impostare la sezione del
Impostazioni nnn_ (nnn=ultime 3 cifre del titolo (da 4 a 46 caratteri) del nome dei clip.
relatiye ‘al nomee  umero di S§rie) ' Struttura della schermata Edit File Name
all’eliminazione di (sono v1sm'1ahzzat1 max. Area di selezione del carattere (3 righe):
clip 7 caratteri). Consente di selezionare i caratteri da inserire alla posizione
del cursore nell’area Title Prefix.
1#$%()+.-.;=@[ 1"_~0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ
Area di operativita del cursore (1 riga):
Spazio: Inserisce uno spazio alla posizione del cursore.
<«—: Sposta il cursore a sinistra.
—: Sposta il cursore a destra.
BS: Elimina il carattere alla sinistra del cursore.
Area Title Prefix (1 riga):
Area per I'immissione del titolo.
Impostazione del titolo
1 Selezionare il carattere da immettere alla posizione del
cursore nell’area Title Prefix scegliendolo nell’area di
selezione caratteri, utilizzando il pulsante 4/¥/</%_ quindi
premere la manopola SEL/SET. Il carattere selezionato
viene inserito e il cursore si sposta verso destra.
2 Ripetere il punto 1 per impostare il titolo. (utilizzare BS
secondo necessita).
3 Dopo aver impostato il titolo, selezionare Done per chiudere
la schermata Edit File Name.
Number Set

Da 0001 a 9999

Imposta il suffisso di 4 cifre aggiunto al nome del clip.

Menu File
Voce Voci secondarie e Descrizione
impostazioni
User File Load Utility SD/MS Carica un file utente da una scheda SD o “Memory Stick”.
Impostazioni di Execute / Cancel Execute: Esegue la funzione.
gestione del file  gyve Utility SD/MS Salva un file utente su una scheda SD o “Memory Stick”.
utente Execute / Cancel Execute: Esegue la funzione.
File ID Visualizza una schermata in cui & possibile modificare I'ID dei
file utente.
Load Customize Data Specifica se caricare informazioni personalizzate per il menu
On / Off User quando viene eseguito Load Utility SD/MS.
Load White Data Specifica se caricare informazioni relative al bilanciamento
On / Off

del bianco quando viene eseguito Load Utility SD/MS.
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Voce Voci secondarie e Descrizione
impostazioni
All File Load Utility SD/MS Carica un file ALL da una scheda SD o “Memory Stick”.
Impostazioni del Execute / Cancel Execute: Esegue la funzione.
file ALL Save Utility SD/MS Salva un file ALL su una scheda SD o “Memory Stick”.
Execute / Cancel Execute: Esegue la funzione.
File ID Visualizza una schermata in cui & possibile modificare I'ID dei

file ALL.

Load Network Data

Specifica se caricare informazioni sulle impostazioni del

On / Off menu Network quando viene eseguito Load Utility SD/MS.
Scene File Recall Internal Memory Carica un file di scena dalla memoria interna.
Impostazioni dei Execute / Cancel Execute: Esegue la funzione.
file di scena Store Internal Memory Salva un file di scena nella memoria interna.

Execute / Cancel

Execute: Esegue la funzione.

Load Utility SD/MS
Execute / Cancel

Carica un file di scena da una scheda SD o “Memory Stick”.

Save Utility SD/MS
Execute / Cancel

Salva un file di scena su una scheda SD o “Memory Stick”.

File ID

Visualizza una schermata in cui & possibile modificare I'ID dei
file di scena.

Scene White Data

Seleziona se applicare o meno i dati di bilanciamento del

On / Off bianco quando si caricano file di scena.
Menu Network
Network
Voce Voci secondarie e Descrizione
impostazioni
Access User Name Specifica il nome utente per I’autenticazione di accesso.

Authentication pyggword
Impostazioni di
autenticazione

Specifica la password per I’autenticazione di accesso.

Wireless LAN  Setting
Impostazioni della Access Point Mode / Station
connessione LAN Mode / Off

Seleziona la modalita di funzionamento della connessione
LAN wireless.

Wireless WPS

Execute / Cancel

Stabilisce una connessione tramite WPS (Wi-Fi Protected
Setup).
Execute: Esegue la funzione.

NFC
Execute / Cancel

Stabilisce una connessione tramite NFC (Near Field
Communication).
Execute: Esegue la funzione.

MAC Address

Visualizza ’indirizzo MAC dell’interfaccia LAN wireless del
camcorder (solo visualizzazione).
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Voce Voci secondarie e Descrizione
impostazioni
AP Mode Channel Imposta il canale della LAN wireless.
Settings Auto(5GHz) / Auto / CH1 / Auto(5GHz) & disponibile solo sul modello PXW-Z190V.
Impostazioni perla CH2/CH3/CH4/CHS / CH6
connessione in /CH7/CH8/CH9/CHI10/
modalitd punto di CH11
accesso Camera SSID & Password Visualizza SSID e password del camcorder.

Regenerate Password
Execute / Cancel

Crea una nuova password.
Execute: Esegue la funzione.

IP Address Visualizza I’indirizzo IP del camcorder in modalita punto di
accesso.
Subnet Mask Visualizza la subnet mask del camcorder in modalita punto di
accesso.
ST Mode Camera Remote Control Specifica se abilitare 0 meno il comando a distanza da un
Settings Enable / Disable dispositivo connesso al camcorder tramite LAN wireless in
Impostazioni per la modalita Station.
connessione in Connected Network Visualizza la rete LAN wireless collegata (punto di accesso).

modalita Station
! ! Scan Networks

Rileva e visualizza un elenco delle reti LAN wireless (punto di
accesso).
Seleziona nell’elenco la destinazione del collegamento.

Manual Register

Registra le impostazioni per la connessione manuale a un
punto di accesso.

SSID Immettere il SSID della destinazione di connessione.
Security Scegliere il tipo di protezione della connessione di
None / WEP / WPA destinazione. Selezionare WPA se il tipo di protezione del
punto di accesso di destinazione ¢ WPA o WPA2.
Password Se la voce Security non & impostata su None, immettere la
password per la connessione al punto di accesso.
DHCP Attiva o disattiva DHCP.
On/ Off
IP Address Immettere I’indirizzo IP del camcorder quando DHCP &
impostato su Off.
Subnet Mask Immettere la subnet mask del camcorder quando DHCP &
impostato su Off.
Gateway Immettere il Default Gateway del camcorder quando DHCP &
impostato su Off.
DNS Auto Attiva o disattiva la funzione di acquisizione automatica del
On/ Off DNS.

Primary DNS Server

Immettere il server DNS primario quando DNS Auto &
impostato su Off.

Secondary DNS Server

Immettere il server DNS secondario quando DNS Auto &
impostato su Off.

Network Reset Reset
Execute / Cancel

Ripristina le impostazioni di rete.
Execute: Esegue la funzione.
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Menu System

Voce Voci secondarie e
impostazioni

Descrizione

Base Setting  Shooting Mode
Impostazioni della SDR/HDR
modalita di ripresa

Seleziona la modalita di gamma dinamica.

Rec Format Frequency

Seleziona la frequenza di sistema.

Impostazioni del 59.94/50/29.97/25/23.98
formato di (Area NTSC: 59.94,
registrazione Area PAL: 50)
Codec Imposta la modalita di registrazione/riproduzione.

XAVC-L / DVCAM(MXF)

Video Format
Le opzioni di impostazione
disponibili variano a seconda
delle impostazioni di
Frequency e Codec.

Imposta il formato di registrazione.
SET: Imposta la funzione

File system  Frequency

Codec Opzioni selezionabili

exFAT 59.94

XAVC-L 3840x2160P
1920x1080P 50
1920x1080P 35
1920x1080i 50
1920x1080i 35
1920x1080i 25
1280x720P 50

DVCAM(MXF) 720x480i

50

XAVC-L 3840x2160P
1920x1080P 50
1920x1080P 35
1920x1080i 50
1920x1080i 35
1920x1080i 25
1280x720P 50

DVCAMMXF) 720x576i

29.97

XAVC-L 3840x2160P
1920x1080P 50
1920x1080P 35

25

XAVC-L 3840x2160P
1920x1080P 50
1920x1080P 35

23.98

XAVC-L 3840x2160P
1920x1080P 50
1920x1080P 35

Aspect Ratio (SD)
16:9/4:3

Imposta il rapporto di aspetto per la registrazione DVCAM.
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Voce Voci secondarie e Descrizione
impostazioni
Assignable Da<l1>a<8> Assegna funzioni ai pulsanti programmabili.
Button Off / Push AF/Push MF / Face Push AF/Push MF: Esegue la funzione di messa a fuoco

Impostazioni di
assegnazione dei
pulsanti
programmabili

Detection AF / Focus Macro /
Auto ND Filter / Push Auto ND
/ Push Auto Iris / Turbo Gain /
AGC / Shutter / Auto Exposure
Level / Spotlight / Backlight /
Flash Band Reduce / Digital
Extender x2 / Handle Zoom /
SteadyShot / Color Bars /
Preset White Select / ATW /
ATW Hold / Marker / Zebra /
Peaking / Video Signal Monitor
/ Focus Magnifier / Lens Info /
LCD/VF Adjust / VF Mode /
Gamma Display Assist /
Display / Rec / S&Q Motion /
Clip Continuous Rec / Picture
Cache Rec / Proxy Rec Start/
Stop / Rec Review / Last Clip
Delete / Thumbnail / NFC /
Direct Menu / User Menu /
Menu

automatica Push o la funzione di messa a fuoco manuale
Push.

Face Detection AF: Attiva o disattiva la funzione di AF con
rilevamento del viso.

Focus Macro: Attiva o disattiva la modalitd Macro.

Auto ND Filter: Attiva o disattiva la funzione Auto ND Filter.

Push Auto ND: Esegue temporaneamente la funzione Auto
ND Filter.

Push Auto Iris: Esegue la funzione di diaframma automatico
“One Push”.

Turbo Gain: Attiva o disattiva Turbo Gain.

AGC: Attiva o disattiva la funzione di regolazione automatica
del guadagno.

Shutter: Commuta fra otturatore automatico e otturatore
manuale.

Auto Exposure Level: Regola il livello di esposizione
automatica.

Spotlight: Imposta la modalita di esposizione automatica su
Spotlight.

Backlight: Imposta la modalita di esposizione automatica su
Backlight.

Flash Band Reduce: Attiva o disattiva la funzione di
correzione della flashband.

Digital Extender x2: Attiva o disattiva la funzione di
ingrandimento dello schermo (x2).

Handle Zoom: Specifica la modalita di funzionamento dello
zoom della maniglia.

SteadyShot: Attiva o disattiva la funzione di stabilizzazione
dell’immagine.

Color Bars: Attiva o disattiva la visualizzazione delle barre di
colore.

Preset White Select: Specifica il valore della modalita di
preset del bilanciamento del bianco.

ATW: Attiva o disattiva ATW.

ATW Hold: Sospende temporaneamente la funzione ATW.

Marker: Attiva o disattiva la funzione Marker.

Zebra: Attiva o disattiva la funzione Zebra.

Peaking: Attiva o disattiva la funzione Peaking.

Video Signal Monitor: Commuta le visualizzazioni relative al
segnale video (es. istogramma).

Focus Magnifier: Attiva o disattiva la Funzione di
ingrandimento della messa a fuoco.

Lens Info: Commuta I’indicatore della profondita di campo.

LCD/VF Adjust: Visualizza le barre di livello per la
regolazione della luminosita dello schermo LCD o del
mirino.

VF Mode: Commuta fra colore e bianco e nero la
visualizzazione sul mirino.

Gamma Display Assist: Commuta la funzione di assistenza
per la visualizzazione gamma.

Display: Attiva o disattiva la visualizzazione degli indicatori
sullo schermo del monitor.

Rec: Avvia o arresta la registrazione proxy.

S&Q Motion: Attiva o disattiva la modalita Slow & Quick
Motion e visualizza la schermata di impostazione della
frequenza fotogrammi.

Clip Continuous Rec: Attiva o disattiva la modalita di
registrazione continuata.

Picture Cache Rec: Attiva o disattiva la modalita di
registrazione cache immagine.

Proxy Rec Start/Stop: Avvia o arresta la registrazione proxy
indipendente.
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Voce Voci secondarie e Descrizione
impostazioni
Assignable Rec Review: Avvia la revisione della registrazione.
Button Last Clip Delete: Esegue la funzione di eliminazione ultimo
Impostazioni di clip (ripetizione ripresa).
assegnazione dei Thumbnail: Attiva o disattiva la visualizzazione della
pulsanti schermata delle miniature.
programmabili NFC: Esegue la funzione NFC.
Direct Menu: Visualizza il Direct Menu.
User Menu: Visualizza il menu User.
Menu: Visualizza il menu di impostazione.
Tally Front Accende o spegne I'indicatore di registrazione/tally
Impostazioni per On/ Off (anteriore).
I’inflicatf)re di Rear Accende o spegne I'indicatore di registrazione/tally
registrazione/tally On/ Off (posteriore).
Language Select Imposta la lingua di visualizzazione.
Impostazioni della SET: Imposta la funzione
lingua
Clock Set Time Zone Imposta la differenza rispetto all’ora UTC in passi di
Impostazioni Da UTC -12:00 a UTC +14:00 30 minuti.
Qell’orologio Date Mode Seleziona il formato di visualizzazione della data.
interno YYMMDD / MMDDYY / YYMMDD: Anno, mese, giorno
DDMMYY MMDDYY: Mese, giorno, anno
DDMMYY: Giorno, mese, anno
12H/24H Seleziona il formato di visualizzazione dell’ora.
12H / 24H 12H: Modalita 12 ore
24H: Modalita 24 ore
Date Imposta la data corrente.
SET: Imposta il valore.
Time Imposta I’ora corrente.
SET: Imposta il valore.
Hours Meter Hours(System) Visualizza le ore d’uso totali (non puo essere azzerato).
Impostazioni del  Hours(Reset) Visualizza le ore d’uso totali (pud essere azzerato).
t
contaore Reset Reimposta su 0 I'indicazione Hours(Reset).
Execute / Cancel Execute: Esegue la funzione.
GPS GPS Attiva o disattiva la funzione GPS.
Impostazioni GPS On/ Off
Battery Alarm Low Battery Imposta il livello di carica rimanente della batteria per la
Impostazioni 5% 110%/15%/ .../ 45% /  visualizzazione dell’allarme di bassa tensione batteria (in

allarme di bassa
tensione batteria

50%

incrementi del 5%).

Battery Empty
Da 3% a 7%

Imposta il livello di carica rimanente della batteria per la
visualizzazione dell’allarme batteria scarica (in incrementi
dell’1%).

DC Voltage
Alarm
Impostazioni
dell’allarme di
bassa tensione
sull’ingresso DC
IN.

DC Low Voltagel

Da 11.2V a 14.0V (11.3V)

Imposta la tensione alla quale visualizzare 1’allarme di bassa
tensione su ingresso DC IN (in incrementi di 0,1V).

DC Low Voltage2
Da 11.0V a 14.0V

Imposta la tensione alla quale visualizzare 1’allarme di
tensione insufficiente su ingresso DC IN (in incrementi di
0,1V).
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Voce Voci secondarie e
impostazioni

Descrizione

Menu Settings Direct Menu with <SET>
Impostazioni menu ~ On/ Off

Specifica se avviare o meno il Direct Menu con la pressione
del pulsante SET.

¢ Se impostato su On, il rilevamento del viso registrato
mediante la funzione di AF con rilevamento del viso diventa
non disponibile. Il viso correntemente registrato viene
eliminato.

User Menu Only Specifica se visualizzare solo il menu User (On) o I’elenco dei
On / Off menu (Off) quando il camcorder visualizza il menu.

User Menu with Lock Specifica se bloccare 0 meno la visualizzazione del menu,
On / Off mostrando solo il menu User.

* Nella visualizzazione normale del menu, questa voce non &
visualizzata. Per informazioni dettagliate sulla
visualizzazione dei menu, vedere pagina 71.

Fan Control Setting

Impostazioni della Auto / Minimum / Off in Rec
modalita di

comando della

Seleziona la modalita di comando della ventola.

ventola

All Reset Reset Riporta il camcorder alle impostazioni predefinite di fabbrica.
Reset delle Execute / Cancel Execute: Esegue la funzione.

impostazioni Reset without Network Ripristina le impostazioni predefinite di fabbrica dei menu,
predefinite di Execute / Cancel eccetto le impostazioni del menu Network.

fabbrica Execute: Esegue la funzione.

Version Version Number Visualizza la versione del software del camcorder.
Visualizzazione X.XX

della versione del  version Up

camcorder Execute / Cancel

Esegue 'upgrade del camcorder.*
Execute: Esegue la funzione.
* Questa funzione aggiorna il software del camcorder.
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Appendice

Note importanti sul funzionamento

Uso del camcorder all’estero

Alimentazione

Utilizzando il caricabatteric BC-U1A (fornito) o
il caricabatterie BC-U2A opzionale, ¢ possibile
utilizzare il camcorder in qualsiasi paese o
regione geografica che usa una tensione di rete
compresa tra tra 100 Vca e 240 Vca a una
frequenza compresa tra 50 Hz e 60 Hz.

Funzione di correzione del fuso orario
All’estero, impostare Clock Set >Time Zone
(pagina 101) nel menu System.

Uso e conservazione

Non sottoporre I’unita a forti urti
Il meccanismo interno potrebbe danneggiarsi e il
corpo potrebbe subire alterazioni.

Non coprire 'unita durante I'uso

Coprendo I’unita, ad esempio con un panno, si
potrebbe causare un eccessivo accumulo di calore
interno.

Dopo I'uso

Spostare sempre il selettore ON/STANDBY su
STANDBY prima di scollegare la sorgente di
alimentazione.

Prima di riporre I'unita per un lungo periodo
Estrarre la batteria.

Non lasciare la videocamera con I’obiettivo
rivolto verso il sole

La luce diretta del sole potrebbe penetrare dagli
obiettivi, essere concentrata all’interno della
videocamera e causare un incendio.

Evitare di esporre I’obiettivo a raggi, ad esempio
raggi laser

Questo potrebbe danneggiare il sensore immagini
e causare malfunzionamenti.

Spedizione

« Estrarre le schede di memoria prima di
trasportare 1’ unita.

* Se I'unita deve essere spedita mediante
trasporto terrestre, marittimo, aereo o di altro

genere, imballarla nel cartone utilizzato per la
spedizione dell’unita.

Informazioni sulla batteria

Per ricaricare la batteria
* Ricaricare la batteria prima di iniziare a
utilizzare la videocamera.

Per utilizzare con efficacia la batteria
* Le prestazioni della batteria si riducono quando
la temperatura ambiente & pari o inferiore a
10 °C. In queste condizioni, inoltre, il tempo di
utilizzo della batteria si abbrevia. In questo
caso, eseguire una delle seguenti operazioni per
utilizzare la batteria per un periodo piu esteso.
—Inserire la batteria in una tasca per riscaldarla
e inserirla nella videocamera appena prima di
iniziare le riprese.
—Utilizzare una batteria di capacita elevata.
Verificare di aver impostato 1’ interruttore ON/
STANDBY su STANDBY quando non si
effettua la registrazione o non viene riprodotto
alcun contenuto sulla videocamera. La batteria
si consuma anche quando la videocamera ¢
nella modalita di attesa della registrazione o
pausa della riproduzione.
Tenere a portata di mano batterie di ricambio
per un tempo di registrazione di 2 o 3 volte
superiore a quello previsto ed effettuare
registrazioni di prova prima di quelle effettive.
Non esporre la batteria all’acqua. La batteria
non ¢ resistente all’acqua.

Informazioni sulla conservazione della batteria

* Se la batteria non deve essere utilizzata per
lungo tempo, ricaricarla completamente e
utilizzarla con la videocamera almeno una volta
I’anno per mantenerne la funzionalita. Per
riporre la batteria, estrarla dalla videocamera e
conservarla in un ambiente fresco e asciutto.

* Per scaricare completamente la batteria inserita
nella videocamera, lasciare I’apparecchio
acceso nella modalita di attesa della
registrazione fino al suo spegnimento
(pagina 18).



Informazioni sulla durata della batteria

* La capacita della batteria si riduce con il tempo
e aseguito dell’uso ripetuto. Quando il tempo di
utilizzo tra due ricariche si riduce
notevolmente, ¢ probabilmente giunto il
momento di sostituire la batteria.

¢ La durata di ciascuna batteria ¢ stabilita dalle
condizioni ambientali, d’uso e di
conservazione.

Informazioni sulla ricarica della batteria

« Utilizzare il caricabatterie (in dotazione) per
caricare esclusivamente le batterie indicate.
Altre batterie potrebbero perdere, surriscaldarsi,
esplodere o causare scosse elettriche, con
conseguenti ustioni o infortuni.

« Estrarre la batteria carica dal caricabatterie.

 La spia di ricarica del caricabatterie in

dotazione lampeggia seguendo 2 schemi, come

indicato di seguito.

Lampeggiamento rapido: La spia si accende e si

spegne rapidamente a intervalli di circa

0,15 secondi.

Lampeggiamento lento: la spia si accende e si

spegne alternatamente per circa 1,5 secondi,

quindi si spegne completamente per altri

1,5 secondi circa. La sequenza viene poi

ripetuta.

Se la spia di ricarica lampeggia rapidamente,

rimuovere la batteria in carica e reinserirla

saldamente. Se la spia di ricarica continua a

lampeggiare rapidamente, € possibile che la

batteria sia danneggiata o che non sia del tipo

previsto. Controllare la batteria per verificare se

¢ del tipo previsto. Se la batteria ¢ del tipo

previsto, estrarla e poi inserire un’altra batteria

nuova (o di cui si & certi dell’integrita) per

valutare se il caricabatterie funziona

correttamente. Se il caricabatterie funziona
correttamente, ¢ probabile che la batteria sia
danneggiata.

Se la spia di ricarica lampeggia lentamente, il
caricabatterie & nella modalita di attesa e la
ricarica & sospesa. Se la temperatura ambiente &
esterna all’intervallo consigliato per la ricarica,
il caricabatterie sospende automaticamente la
ricarica ed entra nella modalita di attesa. Non
appena la temperatura ambiente rientra
nell’intervallo consigliato, il caricabatterie
riprende la ricarica e la spia di ricarica si
accende. Si consiglia di caricare la batteria a una
temperatura ambiente compresa tra 10 °C e

30 °C.
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Informazioni sulla cura della
videocamera

Uso e cura

* Non utilizzare o conservare la videocamera e gli

accessori negli ambienti indicati di seguito.

—Luoghi particolarmente caldi o freddi.

Non esporre la videocamera e gli accessori a
temperature superiori a 60 °C, ad esempio
esposti alla luce solare diretta, in prossimita
di radiatori o all’interno di auto parcheggiate
al sole. Potrebbero verificarsi problemi di
funzionamento o deformazioni.

—In prossimita di campi magnetici intensi o
vibrazioni meccaniche.

La videocamera potrebbe presentare
problemi di funzionamento.

—In prossimita di radiazioni o onde radio
intense.

La videocamera potrebbe non essere in grado
di registrare correttamente.

—In prossimita di ricevitori AM e
apparecchiature video.
Potrebbero verificarsi disturbi.

—Su una spiaggia sabbiosa o in ambienti pieni
di polvere.

La videocamera potrebbe presentare
problemi di funzionamento qualora al suo
interno penetrino sabbia o polvere. A volte
un guasto di questo genere non puo essere
riparato.

—In prossimita di finestre o all’aperto, dove lo
schermo LCD, il mirino o I’obiettivo
potrebbero essere esposti alla luce diretta del
sole.

L’esposizione potrebbe danneggiare
I’interno del mirino o dello schermo LCD.

— Ambienti molto umidi.

Per il funzionamento con tensione CC o CA,

utilizzare gli accessori consigliati nelle presenti

istruzioni per I’uso.

Evitare che la fotocamera si bagni, ad esempio

a causa della pioggia o dell’acqua di mare. La

videocamera bagnata potrebbe presentare

problemi di funzionamento. A volte un guasto

di questo genere non puo essere riparato.

In caso di ingresso di oggetti solidi o sostanze

liquide all’interno della videocamera,

scollegarla e farla controllare da un rivenditore

Sony prima di utilizzarla di nuovo.

Evitare di maneggiarla con poca cura,

smontarla, modificarla, sottoporla a urti fisici o



a impatti (ad esempio colpi di martello, cadute

o calpestamenti). Prestare particolare attenzione

all’obiettivo.

Non utilizzare una batteria deformata o

danneggiata.

Mantenere I’'impostazione dell’interruttore ON/

STANDBY su STANDBY quando non si

utilizza la videocamera.

Non utilizzare la videocamera avvolta

all’interno di teli o asciugamani. Potrebbe

verificarsi un accumulo di calore interno.

Per scollegare il cavo di alimentazione,

afferrare la spina, non il cavo stesso.

Non danneggiare il cavo di alimentazione, ad

esempio appoggiandovi sopra oggetti pesanti.

Mantenere puliti i contatti metallici.

Tenere il telecomando wireless e le pile a

pastiglia lontano dalla portata dei bambini. In

caso di ingerimento accidentale della batteria,

consultare immediatamente un medico.

In caso di perdite di elettrolita dalla batteria:

— Consultare un centro di assistenza Sony
autorizzato.

—Lavare la pelle venuta a contatto con il
liquido.

—Se il liquido & entrato a contatto con gli
occhi, risciacquare con abbondante acqua e
consultare un medico.

Se lavideocamera non deve essere utilizzata per

lungo tempo

¢ Accendere la videocamera, quindi registrare e
riprodurre immagini circa una volta al mese per
mantenere 1’apparecchio in uno stato ottimale
per lungo tempo.

« Scaricare completamente la batteria prima di
riporla.

Formazione di condensa

Se la videocamera viene trasferita direttamente da
un luogo freddo a uno caldo, al suo interno
potrebbe formarsi della condensa in grado di
causare problemi di funzionamento.

Se si & formata della condensa
Lasciare riposare la videocamera per circa un’ora
senza accenderla.

Nota sulla formazione di condensa

L’umidita pud condensarsi quando si trasferisce
la videocamera da un luogo freddo a uno caldo (o
viceversa) oppure se si utilizza la videocamera in
un ambiente umido, come nei casi indicati di
seguito.
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¢ Quando si trasferisce la videocamera da una
pista da sci a un luogo riscaldato.

¢ Quando si trasferisce la videocamera da un’auto
o un locale con aria condizionata all’ambiente
esterno caldo.

* Se si utilizza la videocamera dopo un
acquazzone o uno scroscio di pioggia.

* Se si utilizza la videocamera in un ambiente
caldo e umido.

Come evitare la formazione di condensa
Quando si trasferisce la videocamera da un luogo
freddo a uno caldo, inserire la videocamera in un
sacchetto di plastica e sigillarlo. Estrarla dal
sacchetto solo quando la temperatura dell’aria
all’interno del sacchetto stesso ha raggiunto la
temperatura ambiente (dopo circa un’ora).

Schermo LCD

» Non esercitare una pressione eccessiva sullo
schermo LCD, in quanto potrebbero verificarsi
danni.

* Se la videocamera viene utilizzata in un luogo
freddo, sullo schermo LCD potrebbe comparire
un’immagine residua. Questo non indica la
presenza di guasti.

* Durante I’uso della videocamera, la parte
posteriore dello schermo LCD potrebbe
surriscaldarsi. Questo non indica la presenza di
guasti.

Per pulire lo schermo LCD

La superficie dello schermo LCD ¢ dotata di un

rivestimento. Se si graffia la superficie, il

rivestimento potrebbe staccarsi.

Tenere presente quanto segue durante 1’uso e la

pulizia.

« Il rivestimento potrebbe staccarsi pitl
facilmente se sullo schermo sono presenti
residui di grasso o crema per mani. Rimuoverli
il prima possibile.

» Il rivestimento potrebbe graffiarsi se viene
strofinato con un panno o simili.

* Rimuovere la polvere o la sabbia con un
soffiatore prima di strofinare per eliminare lo
sporco.

« Utilizzare un panno morbido (ad esempio per
occhiali) per rimuovere la sporcizia.

Cura del telaio

* Se il telaio & sporco, pulire il corpo della
videocamera con un panno morbido
leggermente inumidito con acqua, quindi
asciugare il telaio con un panno morbido
asciutto.



« Evitare le seguenti operazioni per non causare
danni alla finitura.

— Utilizzare sostanze chimiche quali solventi,
benzina, alcool, panni chimici, repellenti,
insetticidi e prodotti solari.

—Maneggiare I’apparecchio con le suddette
sostanze sulle mani.

—Lasciare il telaio a contatto con oggetti in
gomma o vinile per un periodo prolungato.

Cura e conservazione dell’obiettivo

« Pulire la superficie dell’obiettivo con un panno

morbido nei seguenti casi:

—Se sono presenti impronte digitali sulla
superficie dell’ obiettivo.

—In ambienti caldi o umidi

—Se ’obiettivo ¢ stato esposto alla salsedine,
ad esempio al mare.

Riporlo in un luogo ben aerato in cui siano

presenti quantitd minime di sporcizia o polvere.

Per prevenire la formazione di muffe, pulire
periodicamente 1’obiettivo come descritto
sopra.

Informazioni sulla ricarica della batteria
ricaricabile preinstallata

La videocamera contiene una batteria ricaricabile
preinstallata in grado di mantenere data, ora e
altre impostazioni anche quando il selettore ON/
STANDBY si trova sulla posizione STANDBY.
La batteria ricaricabile preinstallata viene sempre
ricaricata quando la videocamera ¢ collegata alla
presa di rete tramite 1’alimentatore CA o quando
¢ inserita la batteria. La batteria ricaricabile
impieghera circa 3 mesi per scaricarsi se la
videocamera non viene mai utilizzata con
I’alimentatore CA collegato o la batteria inserita.
Utilizzare la videocamera dopo aver caricato la
batteria ricaricabile preinstallata.

In ogni caso, anche se la batteria ricaricabile
preinstallata non viene caricata, la videocamera
funzionera correttamente purché non si registri la
data.

Per prevenire interferenze
elettromagnetiche da telefoni portatili,
dispositivi wireless e simili

L’uso di telefoni portatili, dispositivi wireless e
cosi via nei pressi di questa unita pud causare
problemi di funzionamento e interferenze con i
segnali audio e video.

Si consiglia, nei pressi dell’unita, di tenere spente
le apparecchiature di questo genere.
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Informazioni sullo schermo LCD

* Non lasciare lo schermo LCD rivolto verso la
luce diretta del sole in quanto potrebbe subire
danni.

* Non premere o ruotare lo schermo LCD con
forza e non lasciare oggetti appoggiati sullo
schermo LCD, in quanto potrebbero verificarsi
problemi di funzionamento (irregolarita
dell’immagine e cosi via).

* Lo schermo LCD potrebbe surriscaldarsi
durante I’uso. Questo non indica la presenza di
guasti.

Informazioni sui pixel bloccati

Lo schermo LCD/pannello EL organico di questa
unita & prodotto con una tecnologia ad alta
precisione, che garantisce un rapporto di pixel
funzionanti pari almeno al 99,99%. E quindi
possibile che una piccolissima percentuale dei
pixel possa rimanere “bloccata”, sempre
disattivata (nera), sempre attivata (rossa, verde o
blu) oppure lampeggiante. Inoltre, a seguito di un
periodo d’uso prolungato, tali pixel “bloccati”
potrebbero comparire spontaneamente a causa
delle caratteristiche fisiche del display a cristalli
liquidi o del pannello EL organico. Questi
fenomeni non sono indice di un problema di
funzionamento e non saranno registrati sul
supporto di registrazione.

Informazioni sul display del pannello EL
organico

Le caratteristiche fisiche del pannello EL
organico possono provocare la persistenza
dell’immagine o una luminosita ridotta.

Questi fenomeni non sono indice di un problema
di funzionamento, pertanto il pannello EL
organico puo essere utilizzato senza problemi.
Spostando il proprio angolo di visuale nel mirino,
si potrebbero percepire alcuni colori primari.
Questo non indica la presenza di guasti.

Questi colori non sono registrati sulla scheda di
memoria.

Componenti di consumo

 La ventola e la batteria sono considerate
componenti di consumo che dovranno essere
sostituite periodicamente.
Se I’apparecchio viene utilizzato a temperatura
ambiente, il ciclo normale di sostituzione € di



circa 5 anni.

Tuttavia, cio ha un valore puramente indicativo
e non implica alcuna garanzia sulla durata di
vita prevista di questi componenti. Per ulteriori
informazioni sulla sostituzione dei componenti,
rivolgersi al proprio rivenditore.

La vita utile prevista dell’adattatore CA e del
condensatore elettrolitico ¢ di circa 5 anni a
temperature normali e in condizioni di utilizzo
normale (8 ore al giorno per 25 giorni al mese).
Se le condizioni di utilizzo eccedono i valori
normali sopra indicati, la vita prevista si ridurra
proporzionalmente.

11 morsetto della batteria dell’apparecchio (il
connettore per pacchi batteria e adattatori CA) &
un prodotto di consumo.

Se i piedini del morsetto sono piegati e
deformati a causa di urti o vibrazioni, o se
vengono corrosi a causa di un uso prolungato
all’aria aperta, 1’alimentazione potrebbe non
essere fornita correttamente.

Si consiglia di eseguire dei controlli periodici
per assicurare il funzionamento corretto
dell’apparecchio e prolungarne la vita utile. Per
ulteriori informazioni sui controlli, contattare il
servizio tecnico o un rappresentante Sony.

Nota sul display

¢ Le immagini sullo schermo LCD e sullo
schermo del mirino possono apparire distorte a
seguito di queste operazioni:
—Modifica del formato video
— Avvio della riproduzione dalla schermata
delle miniature

Frammentazione dei file

Se non ¢ possibile registrare o riprodurre
correttamente le immagini, ¢ possibile provare a
formattare il supporto di registrazione. Se si
effettuano operazioni ripetute di registrazione/
riproduzione di immagini su un particolare
supporto di registrazione e per un periodo
prolungato, i file nel supporto potrebbero
frammentarsi e impedire una corretta
registrazione o archiviazione. In tal caso,
effettuare un backup dei clip nel supporto, quindi
eseguire la formattazione del supporto
utilizzando Format Media (pagina 95) nel menu
Media.
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Note sulla sicurezza Internet

« Utilizzare la videocamera riparandosi dietro un
firewall progettato a fini di sicurezza. Non
connettere la videocamera a una rete che pud
essere connessa a dispositivi inaffidabili.
SONY NON SARA RESPONSABILE DI
DANNI DI QUALSIASI TIPO RISULTANTI
DALLA MANCATA IMPLEMENTAZIONE
DI MISURE DI PROTEZIONE ADEGUATE
SUI DISPOSITIVI DI TRASMISSIONE, DA
INEVITABILI DIFFUSIONI DI DATI
RISULTANTI DALLE SPECIFICHE
TECNICHE DELLA TRASMISSIONE O DA
PROBLEMATICHE RELATIVE ALLA
SICUREZZA DI QUALSIASI TIPO.

In base all’ambiente operativo, terze parti non

autorizzate alla rete potrebbero essere in grado
di accedere all’unita. Quando si collega I’unita
alla rete, accertarsi di confermare che la rete &
efficacemente protetta.

11 contenuto trasmesso pud essere intercettato
inconsapevolmente da terze parti non

autorizzate che si trovano in prossimita dei

segnali. Quando si utilizza la comunicazione

LAN wireless, implementare misure di

protezione per proteggere il contenuto della

comunicazione.

Per garantire la protezione, quando si utilizza

I’unita collegata alla rete, si consiglia di

accedere alla finestra di controllo tramite un

browser Web e di modificare le impostazioni
della limitazione di accesso rispetto ai valori

predefiniti (pagina 97).

Si consiglia anche di modificare la password

regolarmente.

* Non accedere ad altri siti con il browser Web
durante o dopo la determinazione delle
impostazioni. Poiché lo stato di accesso rimane
nel browser Web, chiudere il browser una volta
completate le impostazioni per impedire che
terze parti non autorizzate possano utilizzare
I’unita o eseguire programmi pericolosi.

Informazioni sul sistema GPS

GPS (Global Positioning System) € un sistema
che calcola la posizione geografica da satelliti
spaziali statunitensi ad elevata precisione. Questo
sistema consente di individuare con precisione la
propria posizione sulla terra.

I satelliti GPS si trovano in 6 orbite a 20.000 km
dalla terra. Il sistema GPS ¢ costituito da 24 o pilt



satelliti GPS. Un ricevitore GPS riceve i segnali
radio dai satelliti e calcola la posizione corrente
del ricevitore in base alle informazioni orbitali
(dati di almanacco), al tempo di percorrenza dei
segnali e cosi via.

La determinazione di una posizione ¢ detta
“triangolazione”. Un ricevitore GPS puo
determinare la latitudine e la longitudine di una
posizione ricevendo segnali da 3 o piu satelliti.

* Poiché le posizioni dei satelliti GPS variano
costantemente, potrebbe essere necessario pitt
tempo per determinare la posizione, oppure il
ricevitore potrebbe non essere in grado di
determinarla del tutto, a seconda della posizione
e dell’ora di utilizzo della videocamera.

 I1 GPS ¢ un sistema che consente di determinare

la posizione geografica triangolando i segnali

radio dai satelliti GPS. Evitare I’uso della
videocamera in punti in cui i segnali radio sono
bloccati o riflessi, ad esempio in luoghi
ombreggiati circondati da edifici o alberi e cosi

via. Utilizzare la videocamera in ambienti a

cielo aperto.

Potrebbe non essere possibile registrare le

informazioni sulla posizione in luoghi o

situazioni in cui i segnali radio dei satelliti GPS

non raggiungono la videocamera, come nei casi
riportati di seguito.

—In gallerie, al chiuso o all’ombra degli
edifici.

—Tra edifici alti o in vicoli circondati da
edifici.

— Sottoterra, in luoghi circondati da alberi fitti,

sotto un ponte alto o in luoghi in cui vengono

generati campi magnetici, ad esempio in
prossimita di cavi dell’alta tensione.

—In prossimita di dispositivi che generano
segnali radio nella stessa banda di frequenza
della videocamera: telefoni cellulari con
banda 1,5 GHz ecc.

Se si caricano e si condividono immagini

registrate quando 1’'impostazione GPS ¢ On, la

localita geografica di registrazione potrebbe

essere visibile su Internet anche se non si
intende farlo. Se non si desidera registrare le
informazioni sulla posizione, impostare GPS su
Off (pagina 101).

Errori di triangolazione

« Se ci si sposta in un luogo diverso subito dopo
aver impostato GPS su On nel menu, potrebbe
essere necessario pitt tempo perché il camcorder
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avvii la triangolazione (rispetto al caso in cui si
rimane fermi nello stesso posto).

Errore causato dalla posizione dei satelliti GPS
Il camcorder triangola automaticamente la
posizione attuale quando riceve segnali radio da
3 o pit satelliti GPS. L’errore di triangolazione
ammesso dai satelliti GPS ¢ di circa 10 m. A
seconda dell’ambiente, I’errore di

triangolazione pud essere superiore. In questo
caso, la posizione effettiva potrebbe non
corrispondere alla posizione sulla mappa basata
sulle informazioni GPS. Inoltre, i satelliti GPS
sono controllati dal Ministero della Difesa
statunitense e il grado di precisione puo essere
cambiato intenzionalmente.

¢ Errore durante il processo di triangolazione
Il camcorder acquisisce periodicamente
informazioni sulla posizione durante la
triangolazione.

Limitazioni all’uso di GPS

Utilizzare GPS in conformita alle normative
relative alla situazione e ai paesi o aree
geografiche di utilizzo.

Informazioni sul sistema di coordinate
geografiche

Viene utilizzato il sistema di coordinate
geografiche “WGS-84".



Formati video

Informazioni sui supporti di registrazione

Supporti di registrazione e formati compatibili

M Registrazione normale

SDXC
Video Format Class 10 Class 10 Class 10
UHS-1U3 UHS-1U1
XAVC-L exFAT 3840%x2160 @] - -
1920x1080 O O O
1280x720 O O O
DVCAM exFAT O O O
O: Compatibile
—: Non compatibile
M Modalita S&Q
SDXC
Video Format Class 10 Class 10 Class 10
UHS-1 U3 UHS-1U1
XAVC-L exFAT 3840x2160 O - -
19201080 O @]

O: Compatibile
—: Non compatibile

Modalita di registrazione speciali e formati compatibili

XAVC-L DVCAM
exFAT

Interval Rec @] -

Clip Continuous Rec O

Picture Cache Rec O

Slow & Quick Motion @]

Simul Rec su 2 slot @] -

O: Compatibile
—: Non compatibile
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Tempo di registrazione massimo per un clip

Formato di registrazione Tempo di registrazione continuata Tempo di registrazione massimo
(per ciascun supporto) in modalita Relay Rec*

XAVC-L Circa 6 ore Circa 13 ore
DVCAM

* Tempo di registrazione massimo in modalita Relay Rec utilizzando supporti con fino a 6 ore di registrazione per
supporto.
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Formati di uscita e limitazioni

Formati video e segnali di uscita

Formati di uscita per il connettore SDI OUT

Impostazione del formato di registrazione Impostazione Segnale di uscita/Metodo
dell’uscita SDI di conversione
Rec Format Rec Format >Video |Output Format >SDI |Segnale di uscita
>Frequency nel menu | Format nel menu nel menu Video
System System
59.94 3840x2160P 1920x1080P (Level A) 1920x1080 59.94P Level-A
1920x1080P (Level B) 1920x1080 59.94P Level-B
1920x1080i 1920x1080 59.94i
1920x1080P 1920x1080P (Level A) 1920x1080 59.94P Level-A
1920x1080P (Level B) 1920x1080 59.94P Level-B
1920x1080i 1920x1080 59.94i
720x486i 720x486 59.94i
1920x10801 1920x1080i 1920x1080 59.94i
720x486i 720%x486 59.94i
1280x720P 1280x720P 1280720 59.94P
720x486i 720%x486 59.94i
720x4861 720x4861 720x486 59.94i
29.97 3840x2160P 1920x1080PsF 1920x1080 29.97PsF
1920x1080P 1920x1080PsF 1920x1080 29.97PsF
720x486i 720%x486 59.94i (PsF)
1280x720P 1280x720P 1280x720 59.94P (2-2RP)
720x486i 720%x486 59.94i (PsF)
23.98 3840x2160P 1920x1080PsF 1920x1080 23.98PsF
1920x1080i (2-3PD) 1920x1080 59.94i (2-3PD)
1920x1080P 1920x1080PsF 1920x1080 23.98PsF
1920x1080i (2-3PD) 1920x1080 59.94i (2-3PD)
720x486i (2-3PD) 720%x486 59.94i (2-3PD)
1280x720P 1280x720P (2-3PD) 1280x720 59.94P (2-3PD)

720x486i (2-3PD)

720x486 59.94i (2-3PD)
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Impostazione del formato di registrazione Impostazione Segnale di uscita/Metodo
dell’uscita SDI di conversione
Rec Format Rec Format >Video |Output Format >SDI | Segnale di uscita
>Frequency nel menu | Format nel menu nel menu Video
System System
50 3840x2160P 1920x1080P (Level A) 1920x1080 50P Level-A
1920x1080P (Level B) 1920x1080 50P Level-B
1920x1080i 1920x1080 50i
1920x1080P 1920x1080P (Level A) 1920x1080 50P Level-A
1920x1080P (Level B) 1920x1080 50P Level-B
1920x10801 1920x1080 50i
7205761 720%576 50i
1920x10801 1920x10801 1920x1080 50i
720x576i 720x576 50i
1280x720P 1280x720P 1280x720 50P
720x5761 720x576 50i
720x5761 720x576i 720x576 50i
25 3840x2160P 1920x1080PsF 1920x1080 25PsF
1920x1080P 1920x1080PsF 1920x1080 25PsF
7205761 720576 50i (PsF)
1280x720P 1280x720P 1280x720 50P (2-2RP)
720x576i 720x576 50i (PsF)
Formati di uscita per il connettore HDMI OUT
Impostazione del formato di registrazione Impostazione Segnale di uscita/Metodo
dell’uscita HDMI di conversione
Rec Format Rec Format >Video |Output Format >HDMI |Segnale di uscita
>Frequency nel menu |Format nel menu nel menu Video
System System
59.94 3840x2160P 3840x2160P 3840x2160 59.94P
1920x1080P 1920%x1080 59.94P
1920x10801 1920x1080 59.94i
1920x1080P 1920x1080P 1920%x1080 59.94P
1920x1080i 1920x1080 59.94i
720x4801 720x480 59.94i
1920x10801 1920x1080i 1920x1080 59.94i
720%x4801 720%x480 59.941
1280x720P 1280x720P 1280x720 59.94P
720%x4801 720%x480 59.941
720%x4861 720%x4801 720x480 59.941
720x480P 720x480 59.94P
29.97 3840x2160P 3840x2160P 3840x2160 29.97P
1920x1080i 1920x1080 59.94i (PsF)
1920x1080P 1920x10801 1920x1080 59.94i (PsF)
720%x4801 720x480 59.94i (PsF)
1280x720P 1280x720P 1280%720 59.94P (2-2RP)
720x480i 720x480 59.94i (PsF)
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Impostazione del formato di registrazione Impostazione Segnale di uscita/Metodo
dell’uscita HDMI di conversione
Rec Format Rec Format >Video |Output Format>HDMI | Segnale di uscita
>Frequency nel menu | Format nel menu nel menu Video
System System
23.98 3840x2160P 3840x2160P 3840x2160 23.98P
1920x1080P 1920x1080 23.98P
1920x1080i (2-3PD) 1920x1080 59.94i (2-3PD)
1920x1080P 1920x1080P 1920x1080 23.98P
1920x1080i (2-3PD) 1920x1080 59.94i (2-3PD)
720x480i (2-3PD) 720%480 59.94i (2-3PD)
1280x720P 1280x720P (2-3PD) 1280x720 59.94P (2-3PD)
720x480i (2-3PD) 720%480 59.94i (2-3PD)
50 3840x2160P 3840x2160P 3840x2160 50P
1920x1080P 1920x1080 50P
1920x1080i 1920x1080 50i
1920x1080P 1920x1080P 1920x1080 50P
1920x10801 1920x1080 50i
720x576i 720x576 50i
1920x1080i 1920x10801 19201080 50i
720x576i 720x576 50i
1280x720P 1280x720P 1280x720 50P
720x576i 720x576 50i
720x576i 720x5761 720x576 50i
720x576P 720x576 50P
25 3840x2160P 3840x2160P 3840x2160 25P
1920x1080i 1920x1080 50i (PsF)
1920x1080P 1920x1080i 1920x1080 50i (PsF)
720x576i 720x576 50i (PsF)
1280x720P 1280x720P 1280x720 50P (2-2RP)
720x5761 720%x576 50i (PsF)

* Se le dimensioni di immagine del clip in riproduzione sono inferiori alle dimensioni di immagine configurate con
Output Format >SDI o HDMI nel menu Video, il segnale video non &€ emesso da quel connettore.

Limitazioni fra le funzioni di registrazione

Menu Recording S&Q Interval Picture Clip Continuous |Simul |Proxy Rec
Motion |Rec Cache Rec |Rec Rec

S&Q Motion - X x X X X

Interval Rec X - X X X x

Picture Cache Rec  |x X - x x X

Clip Continuous Rec |x X X - X @)

Simul Rec X X X X _ X

Proxy Rec X X X e} X _

O: Supportato, x: Non supportato
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Ricerca e risoluzione dei problemi

Alimentazione

Problema

Causa

Soluzione

1l camcorder non si
accende.

Non & montata una batteria e non viene
fornita alimentazione al connettore DC
IN.

Montare una batteria (pagina 17) o collegare alla
rete elettrica mediante un adattatore CA
(pagina 18).

La batteria ¢ completamente scarica.

Sostituire la batteria con una completamente
carica (pagina 17).

L’alimentazione si
interrompe durante il
funzionamento.

La batteria si ¢ scaricata
completamente.

Sostituire la batteria con una completamente
carica (pagina 17).

La batteria si scarica
velocemente.

La temperatura ambiente ¢ molto
bassa.

Tale condizione ¢ dovuta alle caratteristiche della
batteria e non ¢ un difetto.

La batteria non & caricata
correttamente.

Ricaricare la batteria (pagina 17).

Se la batteria si scarica rapidamente anche dopo
esser stata caricata completamente, potrebbe aver
raggiunto la fine della sua vita utile. Sostituirla
con una nuova.

Registrazione/riproduzione

Problema

Causa

Soluzione

Quando si preme il
pulsante di registrazione,
la registrazione non si
avvia.

La scheda di memoria ¢ protetta da
scrittura.

Disattivare la protezione da scrittura o sostituire
la scheda di memoria con una non protetta.

La scheda di memoria ¢ piena.

Sostituire la scheda con una che disponga di
spazio sufficiente.

E necessario ripristinare la scheda di
memoria.

Ripristinare la scheda di memoria (pagina 23).

Laregistrazione audio non
¢ possibile.

I1livello di registrazione audio ¢
impostato al valore minimo.

Regolare il livello di registrazione audio
(pagina 32).

11 suono registrato ¢
distorto.

11 livello audio & troppo elevato.

Regolare il livello di registrazione audio
(pagina 32).

Nell’audio registrato &
presente un alto livello di
rumore.

11 livello audio & troppo basso.

Regolare il livello di registrazione audio
(pagina 32).

Quando ¢ selezionato un microfono esterno,
regolare anche I’'impostazione INPUT MIC
Reference sotto Audio Input nel menu Audio
(pagina 85).

Non ¢ possibile riprodurre
clip.

E in corso I'editing di un clip.

In base allo stato del camcorder, potrebbero non
essere visualizzati avvisi o avvertimenti. Questo
non indica la presenza di guasti.

E in corso la registrazione del clip su
un altro dispositivo.

Non ¢ possibile riprodurre clip se sono stati
modificati i nomi di file o delle cartelle oppure se
il clip & in uso su un computer. Questo non indica
la presenza di guasti.
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Dispositivi esterni

Problema Soluzione

Il computer non riconosce  Scollegare il cavo USB dal computer, quindi collegarlo di nuovo saldamente.

il camcorder. Scollegare il cavo USB dal computer, riavviare il computer e ripetere nuovamente la
procedura nell’ordine corretto.

Non ¢ possibile caricare  Scollegare il cavo USB dal computer, riavviare il camcorder e quindi ricollegarlo.

clip sul computer. Un apposito software applicativo deve essere installato per poter caricare clip sul
computer (pagina 65).

Connessione LAN wireless

La presenza di ostruzioni o interferenze elettromagnetiche fra il camcorder e il punto di accesso LAN wireless oppure
la configurazione dell’ambiente (ad esempio il materiale delle pareti), potrebbe ridurre il campo di comunicazione
possibile o addirittura impedire completamente la connessione. Qualora si rilevino tali problemi, controllare lo stato
della connessione o della comunicazione spostando il camcorder in un altro luogo oppure avvicinando il camcorder al
punto di accesso o dispositivo terminale utilizzato.

Problema Soluzione

Un dispositivo terminale  * Controllare la connessione LAN wireless (indirizzo IP, ecc.).

non puod accedere al * Le impostazioni di comunicazione tra il punto di accesso e il client potrebbero non
camcorder. essere valide. Per informazioni dettagliate, fare riferimento alle istruzioni per I’'uso del

punto di accesso.

Non ¢ possibile eseguire il Verificare il nome utente e la password impostati.
login sul camcorder.

11 telecomando web non  Verificare I’'impostazione dell’indirizzo IP.
viene visualizzato.
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Indicazioni di errore/avvertenza

Il camcorder informa in merito alle situazioni che richiedono attenzione, precauzioni o una verifica del
funzionamento tramite messaggi sullo schermo del mirino, tramite I’indicatore di registrazione/tally e con
un segnale acustico.

I segnale acustico di avvertimento viene emesso dall’altoparlante integrato e dalle cuffie collegate al
connettore delle cuffie.

Indicazioni di errore

Il camcorder si arrestera nel caso abbia luogo una condizione che causa la visualizzazione di un messaggio
del tipo seguente.

Indicazione di Segnale Spia di regi- Causa e soluzione

errore sullo acustico strazione/

schermo LCD/ di avver- tally

mirino timento

E + codice d’errore Continuo ~ Lampeggia Indica un’anomalia del camcorder. La registrazione si arresta,
rapidamente anche se il mirino continua a visualizzare “@Rec”.

Spegnere il camcorder e verificare eventuali problemi nei
dispositivi collegati, cavi o supporti di memorizzazione. Se il
messaggio d’errore persiste dopo aver riacceso il camcorder,
rivolgersi al proprio rappresentante di assistenza tecnica Sony.
(Se non ¢ possibile spegnere 1’alimentazione impostando
I’interruttore ON/STANDBY su STANDBY, rimuovere la
batteria e/o la sorgente DC IN.)

In base allo stato del camcorder, potrebbero non essere
visualizzati avvisi o avvertimenti.

Indicazioni di avvertimento

Qualora vengano visualizzati i seguenti messaggi, eseguire le procedure indicate.

Indicazione di avvertimento Segnale  Spia di Causa e soluzione
sullo schermo LCD o sul acustico  registra-
mirino di avverti- zione/tally
mento
Battery Near End Intermittente Lampeggiante La carica rimanente del pacco batteria si sta
esaurendo.

Ricaricare non appena possibile.

Battery End Continuo Lampeggia Il pacco batteria & scarico. Impossibile eseguire la
rapidamente  registrazione.
Arrestare le operazioni e sostituire il pacco batteria.

Temperature High Intermittente Lampeggiante La temperatura interna ¢ elevata.
Spegnere il camcorder e lasciarlo raffreddare prima
di utilizzarlo nuovamente.

Voltage Low Intermittente Lampeggiante La tensione sul connettore DC IN & bassa (livello
1). Controllare 1’alimentazione.
Insufficient Voltage Continuo Lampeggia La tensione sul connettore DC IN ¢ insufficiente

rapidamente  (livello 2). Impossibile eseguire la registrazione.
Collegare un’altra sorgente di alimentazione.
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Indicazione di avvertimento Segnale  Spia di Causa e soluzione

sullo schermo LCD o sul acustico  registra-
mirino di avverti- zione/tally
mento
Media Near Full Intermittente Lampeggiante Lo spazio disponibile sulla scheda di memoria ¢
divenuto insufficiente.
Sostituire non appena possibile.
Media Full Continuo Lampeggia Lo spazio disponibile sulla scheda di memoria &

rapidamente  esaurito. Impossibile eseguire la registrazione, la
copia e la divisione dei clip.
Sostituire immediatamente.

Clips Near Full Intermittente Lampeggiante Ci si sta avvicinando al numero massimo di clip che
possono essere registrati sulla scheda di memoria.
Sostituire non appena possibile.

Clips Full Continuo Lampeggia E stato raggiunto il numero massimo di clip che
rapidamente  possono essere registrati sulla scheda di memoria.
Non ¢ possibile registrare o copiare altri clip.
Sostituire immediatamente.

Last Clip Recording Intermittente Lampeggiante Il clip in corso di registrazione ¢ I’ultimo clip che
puo essere registrato in quanto ¢ stato raggiunto il
numero massimo di clip consentito.

Preparare una nuova scheda di memoria.

Media(A) Near Full® Intermittente Lampeggiante Quando si utilizza la funzione Simul Rec

Media(A) FullV Continuo Lampeggia Quando si utilizza la funzione Simul Rec
rapidamente

Media(A) Clips Near Full") Intermittente Lampeggiante Quando si utilizza la funzione Simul Rec

Media(A) Clips Full® Continuo Lampeggia Quando si utilizza la funzione Simul Rec
rapidamente

Media(A) Last Clip Rec! Intermittente Lampeggiante Quando si utilizza la funzione Simul Rec

1)“Media(B)” per la scheda nello slot B.

Messaggi di avviso e messaggi operativi

Al centro dello schermo potranno essere visualizzati i seguenti messaggi di avviso e operativi. Seguire le
istruzioni fornite per risolvere il problema.

Messaggio sul mirino Causa e soluzione

Battery Error E stata rilevata un’anomalia nel pacco batteria.

Please Change Battery Sostituire con un pacco batteria normale.

Unknown Media(A)" E stata inserita una scheda di memoria che & stata partizionata oppure
Please Change una scheda di memoria contenente un numero di clip superiore al

massimo gestibile da questo camcorder.
La scheda non puo essere utilizzata nel camcorder e deve essere

sostituita.
Cannot Use Media(A)" E stata inserita una scheda con un file system diverso oppure non
Unsupported File System formattata.

La scheda non puo essere utilizzata nel camcorder e deve essere
sostituita oppure formattata con il camcorder.

Media Error Si & verificato un errore sulla scheda di memoria e la scheda deve essere

Media(A) Needs to be Restored ! ripristinata.
Ripristinare la scheda di memoria.
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Messaggio sul mirino

Causa e soluzione

Media Error
Cannot Record to Media(A)])

La scheda di memoria potrebbe essere danneggiata e non puo essere
utilizzata per la registrazione.

La riproduzione potrebbe essere possibile, & consigliabile quindi
eseguire una copia e sostituire la scheda di memoria.

Media Error
Cannot Use Media(A)”

La scheda di memoria potrebbe essere danneggiata e non puo essere
utilizzata per la registrazione o la riproduzione.

La scheda non puo essere utilizzata nel camcorder e deve essere
sostituita.

Media(A) Error!
Recording Halted
Playback Halted

La registrazione e la riproduzione sono state arrestate a causa di un
errore durante I’utilizzo della scheda di memoria.
Se il problema persiste, sostituire la scheda di memoria.

Media Reached Rewriting Limit
Change Media(A)”

La scheda di memoria ha raggiunto la fine della sua vita utile.

Eseguire un backup e sostituire la scheda immediatamente. Se si
continua a utilizzare la scheda & possibile che la scheda non consenta pit
I’esecuzione di registrazioni o riproduzioni.

Per ulteriori informazioni, consultare le istruzioni per 'uso della scheda
di memoria.

Invalid setting value was reset:
Media/Clip Naming/Camera Position
Please save All File again

Le impostazioni di formato di Clip Naming sono state ripristinate perché
¢ stato caricato un file ALL non valido.

Configurare le impostazioni di formato desiderate e provare a salvare il
file ALL di nuovo.

The specified address is invalid.

L’indirizzo specificato non & valido.
Controllare che I’impostazione sia corretta.

Failed Questo errore potrebbe apparire se non & possibile ottenere un indirizzo
con DHCP impostato su On.
Controllare le impostazioni del server DHCP.

<SSID>Not found. Non ¢ stato possibile trovare una rete (punto di accesso) con il <SSID>

specificato.
Controllare che I’'impostazione sia corretta.

<SSID>Authentication Failed

L’autenticazione della connessione sulla rete (punto di accesso) con il
<SSID> specificato non & riuscita.
Controllare che la password e le altre impostazioni siano corrette.

1)“Media(B)” per la scheda nello slot B.
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lagrammi a

»

Fare riferimento alle voci relative in “Impostazione dell’audio da registrare” (pagina 32) e “Elenco delle

(pagina 74).

”»

voci del menu di impostazione

Audio Input (CH1&2)

INPUT1

Internal
MIC

Il‘r—

- —
[CH2 EXT Input Select]
INPUT1
INPUT2

14
|
I
| |
| |
\ - TN I N |
| 1 I I | | 1 [ !
L (%)L I [ !
AT o TR DAY [
I o [ I M I P !
I I | I | I I I | [ !
I I I I I I | | | (I !
I o o I I I I 1ol “
1 1 1 1 [ 1 1 1 1 [
- - - -— - | Lo |
<CH1 INPUT SELECT> [CH1 Wind Filter] <CH1 LEVEL CONTROL> <CH1 INPUT LEVEL> | | |
INT on AUTO 0-10 | |
EXT off MAN | [
MI SHOE | o |
; M| 1
I . “
l (.
J— J— - J— | [ !
\ 14 \ 14 14 \ | Lo |
o o I ro Lo I
O O L (%)L _ — 1
(I I I I | % Lo I
| o o [ P Lo |
| I | | | | | I | Lo |
| | 1 | 1 | | | | Pl |
| | | | | | | | | Pl |
| | | | | | | | |
-__ -__ - __ -__ \__/ ‘___
<CH2 INPUT SELECT> [CH2 Wind Filter] <CH2 LEVEL CONTROL> <CH2 INPUT LEVEL> [Limiter Mode] [CH182 AGC Mode]
INT On AUTO 0-10 Off, —6dB Mono
EXT off MAN —9dB, —12dB Stereo
MI SHOE —15dB, —17dB

°1

-
[Color Bar]
[1kHz Tone on Color Bar]
Una o entrambe attive
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Audio Input (CH3&4)

4
|
|
| |
| |
¢ \ TN ¢ N | __
OFF Lo Lo | Lo Lo [ S
t t L ()L ] L1 |
AT 4 TR AT AT A
INPUTA | o o _ N Lol ! _ |
I (N I I I I I I 1o ! ! |
INPUT2 I I I I I I I | | (. ! ! |
I o o I I I I ol ! I |
I o o I I I I . ! !
-— - -——- -— | o | | |
[CH3 Input Select]  [CH3 Wind Filter]  [CH3 Level Control] [CH3 Input Level] | | | | I
Internal L off on Auto 0-99 ! | |
MIC @ INPUT1 off Manual 1 (- !
R Internal MIC | | [ | !
Shoe CH1 | N | | | |
t +
| ol | I !
| Pl ! ! :
__ __ __ _ | | | | | |
14 \ 14 N TN | ol | | |
| | [ | 1 [ | P | | |
t + 1 \J | _ — 1
S % [ % I I 9 A | % L I
[ [ [ I - _
| | | [ | [ | [ | ! |
| [ | [ | [ | [ | ! |
1 [ 1 | 1 | | | | ;! 1
| | | | | | | | |
- - - - N
[CH4 Input Select]  [CH4 Wind Filter] ~ [CH4 Level Control] [CH4 Input Level] [Limiter Mode] [CH3&4 AGC Mode] [Color Bar]
off On Auto 0-99 Off, —6dB Mono [1kHz Tone on Color Bar]
INPUT1 off Manual —9dB, —12dB Stereo Una o entrambe attive
INPUT2 —15dB, —17dB
Internal MIC
Shoe CH2
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CH1
CH2

!

:
A 4

CH3

CH4

Audio Output

v

A 4

-
7/
A

&

9

L)
[HDMI Output CH]
CH1/CH2,CH3/CH4 M - =N
\ I\ﬁ -/

[Analog Output CH]
CH1/CH2,CH3/CH4

[E——-
[Monitor CH]
CH1,CH2,CH3,CH4,
CH1/CH2,CH3/CH4,

MIX ALL

SDI OUT

| —
.

HDMI OUT

| —

N

Analog OUT

| —

- — =

[Headphone Out]

Mono/Stereo

Headphone

A 4

Internal Speaker

| S ——

121



Specifiche tecniche

Generale

Peso
Circa 2,3 kg (solo corpo)
Circa 2,8 kg (con paraluce (1), oculare (1),
batteria BP-U30 (1), scheda di memoria (1))

Dimensioni (larghezza / altezza / profondita)
190,0 mm x 202,0 mm x 419,7 mm
Dimensioni massime. La profondita
corrisponde alla distanza dall’estremita
anteriore del paraluce all’oculare grande.

R isiti di ali tazione

12Vec(dall Val65V)

Consumo energetico

Circa 24 W
durante la registrazione con schermo LCD
spento, mirino acceso, nessun dispositivo
esterno collegato

Circa 36 W
durante la registrazione con schermo LCD
acceso, mirino acceso, con HD SDI, HDMI e
dispositivo esterno

Circa 36 W
durante la copia su supporti di memoria USB

Formato di registrazione video

XAVC Long

Modalita XAVC-L QFHD: VBR, 150 Mbps
(max), MPEG-4 H.264/AVC

Modalita XAVC-L HD 50: VBR, 50 Mbps
(max), MPEG-4 H.264/AVC

Modalita XAVC-L HD 35: VBR, 35 Mbps
(max), MPEG-4 H.264/AVC

Modalita XAVC-L HD 25: VBR, 25 Mbps
(max), MPEG-4 H.264/AVC

DVCAM
CBR, 25 Mbps

Proxy

Profilo principale AVC/H.264 4:2:0 Long GOP,
VBR

1920x1080/9 Mbps, 1280x720/9 Mbps,
1280x720/6 Mbps, 640x360/3 Mbps,
480x270/1 Mbps, 480x270/500 kbps

Formato di registrazione audio
XAVC Long
Modalita XAVC-L: LPCM 24 bit, 48 kHz,
4 canali

DVCAM
LPCM 16 bit, 48 kHz, 4 canali

Proxy
AAC-LC, 128 kbps, 2 canali

Temperatura di funzionamento
Da0°Ca40°C

Temperatura di conservazione
Da-20 °C a +60 °C

Tempo di funzionamento continuato

Con pacco batteria BP-U90:
Circa 3 ore e 15 minuti

Con pacco batteria BP-U60:
Circa 2 ore e 10 minuti

Con pacco batteria BP-U30:
Circa 1 ora e 5 minuti

(Durante la registrazione con schermo LCD
spento, mirino acceso, nessun dispositivo
esterno collegato)

Frequenza fotogrammi di registrazione

XAVC Long

Modalita XAVC-L QFHD 150: 3840x2160/
59.94P, 50P, 29.97P, 23.98P, 25P

Modalita XAVC-L HD 50: 1920x1080/59.94P,
50P, 59.94i, 50i, 29.97P, 23.98P, 25P
1280x720/59.94P, 50P

Modalita XAVC-L HD 35: 1920x1080/59.94P,
50P, 59.94i, 50i, 29.97P, 23.98P, 25P

Modalita XAVC-L HD 25: 1920x1080/59.94i,
50i

DVCAM
720x480/59.94i, 29.97PsF
720x576/50i, 25PsF




Tempo di registrazione o riproduzione

XAVC Long
Modalita XAVC-L QFHD 150

Utilizzo di una scheda di memoria da 128 GB:

Circa 88 minuti
Modalita XAVC-L HD 50

Utilizzo di una scheda di memoria da 128 GB:

Circa 240 minuti
Modalita XAVC-L HD 35

Utilizzo di una scheda di memoria da 128 GB:

Circa 320 minuti
Modalita XAVC-L 25

Utilizzo di una scheda di memoria da 128 GB:

Circa 445 minuti

DVCAM

Utilizzo di una scheda di memoria da 128 GB:

Circa 425 minuti

« I tempi di registrazione e riproduzione
potrebbero variare a seconda delle condizioni
di utilizzo e delle caratteristiche della
memoria.

Obiettivo

Attacco obiettivo

Tipo fisso

Rapporto di zoom
25%

Lunghezza focale

Da 3,7 mm a 92,5 mm
(Equivalente 35 mm: da 28,8 mm a 720 mm)

Videocamera

Dispositivo di imaging
Sensore di immagine da 1/3 pollice tipo ExmorR
3 CMOS

Elementi effettivi dell’immagine
3840 (H) x 2160 (V)

Sistema ottico

Sistema a prisma F1.6

Filtri integrati
Filtri ND
CLEAR: disattivato
1: 1/4ND
2: 1/16ND
3: 1/64ND
ND variabile lineare (circa 1/4 ND - 1/128 ND)

Sensibilita (2000 Ix, riflettanza 89,9 %)

F11 (tipica, modalita 1920x1080/59.94P, alta
sensibilita)

F12 (tipica, modalita 1920x1080/50P, alta
sensibilita)

Illuminazione minima
0,01 Ix (tipica, 1920x1080/59.94i) (F1.6,
modalita alta sensibilita +30 dB, accumulo
64 fotogrammi)

Rapporto S/N
57 dB (Y) (tipico)

Risoluzione orizzontale
2000 linee TV o superiore (modalita
3840x2160P)
1000 linee TV o superiore (modalita
1920x1080P)

Area di messa a fuoco
AF/MF/Full MF (selezionabile)
Da 800 mm a e (macro OFF)
Da 10 mm a e (macro ON, grandangolo)
Da 800 mm a e (macro ON, telefoto)

Diaframma

Auto/Manuale (selezionabile)
DaFl1.6 aFl1 e C (chiuso)

Stabilizzazione dell’immagine
Selezionabile ON/OFF, tipo “shift”

Diametro filtro

M82 mm, passo 0,75 mm

Macro
Selezionabile ON/OFF
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Velocita otturatore
Da 1/24 a 1/8000 sec.

Slow & Quick Motion
XAVC Long
2160P: Da 1 a 60 fps
1080P: Da 1 a 60 fps
720P: Da 1 a 60 fps

Bilanciamento del bianco

Modalita preset (3200K)
modalita Memory A, modalita Memory B,
modalita ATW

Guadagno
-3,0,3,6,9, 12,15, 18 dB, 30 dB (Turbo Gain
on), AGC

Curva di gamma

Selezionabile




LAN wireless

Standard supportati
IEEE 802.11a/b/g/n/ac

Bande di frequenza

2,4 GHz
5,2/5,3/5,6 GHz (solo PXW-Z190V)

Sicurezza

WEP/WPA-PSK/WPA2-PSK
Conforme a NFC Forum Type 3 Tag

Ingressi/Uscite

Ingresso audio
Tipo XLR a 3 pin (2), femmina, LINE/MIC/
MIC+48V commutabile
LINE: +4dBu/0dBu/-3dBu (/EBUL) / 10 kQ
MIC: Da—80dBu a —30dBu / 3 kQ
(livello di ingresso di riferimento
0 dBu=0,775 Vrms)

Uscita audio
Multi/micro USB

Uscita SDI
Tipo BNC (1), 3G/HD/SD (selezionabile)

Ingresso del timecode
Tipo BNC (1), commutabile con connettore TC
ouT
Da 0,5 Val8 Vp-p,33kQ

Uscita del timecode
Tipo BNC (1), commutabile con connettore TC
IN
1,0 Vp-p, 75 Q

Connettore USB

Multi/micro USB (1)
Host: USB 3.0/2.0 tipo A (1), USB 2.0 tipo A
(1) (Supportato in un aggiornamento futuro.)

Uscita cuffie
Mini jack stereo (1)
—16 dBu, 16 Q

Uscita altoparlanti

Mono
Uscita: 500 mW

Ingresso corrente continua

Connettore DC

Uscita HDMI
Connettore HDMI (tipo A)

Connettore REMOTE

Jack sub-mini stereo (¢2,5 mm)
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Connettore LAN cablata

RJ-45 (1), 1000BASE-T, 100BASE-T,
10BASE-T (supporto in un aggiornamento
futuro)

Display

Mirino
Dimensioni dello schermo: 1,0 cm (tipo da
0,39 pollici)
Pixel effettivi: circa 2,36M di punti

Schermo LCD
Dimensioni dello schermo: 8,8 cm (tipo da
3,5 pollici)
Pixel effettivi: circa 1,56M di punti

Microfono interno

Microfono interno

Microfono a condensatore electret stereofonico
omnidirezionale

Slot per schede di memoria

Tipo
SD (2), SD/MS (1)

Accessori forniti

Pacco batteria (1)

Adattatore CA / Caricabatterie (1)
Cavo USB (1)

Paraluce (1)

Oculare grande (1)

CD-ROM “Istruzioni per 'uso” (1)
Prima di usare 1’apparecchio (1)
Documento di garanzia (1)

Download di software

Quando I’unita viene utilizzata in collegamento
con un PC, scaricare driver, plug-in e software
applicativo necessari del dispositivo dai seguenti
siti web.

Sito web per i prodotti business di Sony:
Stati Uniti http://pro.sony.com
Canada http://www.sonybiz.ca
America Latina  http://sonypro-latin.com



Europa, Medio Oriente e Africa
http://www.pro.sony.eu

Giappone http://www.sonybsc.com
Asia Pacifico http://pro.sony-asia.com
Corea http://bp.sony.co.kr

Cina http://pro.sony.com.cn

Anche se i dati relativi al materiale registrato sono
memorizzati su piu file e cartelle, ¢ possibile
gestire facilmente i clip senza considerare la
struttura di directory e dati, utilizzando lo
specifico software applicativo.

 Se si eseguono operazioni sui clip, ad esempio,
copiando i clip sulla scheda di memoria mediante
Explorer (Windows) o Finder (Macintosh), i dati
ausiliari dei clip potrebbero andare perduti.

Design e le specifiche tecniche passibili di
cambiamenti senza preavviso.

Note

* Eseguire sempre una registrazione di prova, e
verificare che il contenuto sia stato registrato
correttamente.

LA SONY NON SARA RESPONSABILE DI
DANNI DI QUALSIASI TIPO, COMPRES]I,
MA SENZA LIMITAZIONE A,
RISARCIMENTI O RIMBORSI A CAUSA
DIGUASTI DI QUESTO APPARECCHIO O
DEI SUOI SUPPORTI DI
REGISTRAZIONE, SISTEMI DI
MEMORIZZAZIONE ESTERNA O
QUALSIASI ALTRO SUPPORTO O
SISTEMA DI MEMORIZZAZIONE PER
REGISTRARE CONTENUTI DI
QUALSIASI TIPO.

Verificare sempre che 1’apparecchio stia
funzionando correttamente prima di usarlo.
LA SONY NON SARA RESPONSABILE DI
DANNI DI QUALSIASI TIPO, COMPRES]I,
MA SENZA LIMITAZIONE A,
RISARCIMENTI O RIMBORSI A CAUSA
DELLA PERDITA DI PROFITTI ATTUALI
O PREVISTI DOVUTA A GUASTI DI
QUESTO APPARECCHIO, SIA DURANTE
IL PERIODO DI VALIDITA DELLA
GARANZIA SIA DOPO LA SCADENZA
DELLA GARANZIA, O PER QUALUNQUE
ALTRA RAGIONE.
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+ SONY NON SARA RESPONSABILE PER
RICHIESTE O RICORSI DI NESSUN TIPO
PRESENTATI DA UTENTI DI QUESTO
APPARATO O DA TERZI.

SONY NON SARA RESPONSABILE PER
RICHIESTE O RICORSI DI NESSUN TIPO
PRESENTATI DA UTENTI DI QUESTO
APPARATO O DA TERZI.SONY NON
SARA RESPONSABILE PER LA PERDITA,
RIPARAZIONE O RIPRODUZIONE DEI
DATI REGISTRATI SUL SISTEMA DI
MEMORIZZAZIONE INTERNO, SU
SUPPORTI DI REGISTRAZIONE, SU
SISTEMI DI MEMORIZZAZIONE
ESTERNI, O SU QUALSIASI ALTRO TIPO
DI SUPPORTO O SISTEMA DI
MEMORIZZAZIONE.

SONY NON SARA RESPONSABILE PER
LA CANCELLAZIONE O LA MANCATA
CONTINUAZIONE PER QUALSIASI
CAUSA O CIRCOSTANZA DI SERVIZI

CORRELATI A QUESTO APPARATO.

Marchi di fabbrica

* XDCAM ¢ un marchio di Sony Corporation.
* XAVCe sono marchi registrati di Sony
Corporation.
¢ Microsoft, Windows, Windows Vista e
Windows Media sono marchi o marchi
registrati di U.S. Microsoft Corporation negli
Stati Uniti e altri paesi.
Mac e Mac OS sono marchi registrati di Apple
Inc. negli Stati Uniti e in altri paesi.
I termini HDMI e HDMI High-Definition
Multimedia Interface e il logo HDMI sono
marchi o marchi registrati di HDMI Licensing
Administrator, Inc. negli Stati Uniti e in altri
paesi.
Adobe, il logo Adobe e Adobe Acrobat sono
marchi o marchi registrati di Adobe Systems
Incorporated negli Stati Uniti e/o in altri paesi.
“Memory Stick”, “Memory Stick Duo”,
“Memory Stick PRO Duo”, “Catalyst Browse”,
“Content Browser Mobile” e il logo “Content
Browser Mobile” sono marchi o marchi
registrati di Sony Corporation.
Il logo SDXC & un marchio di SD-3C, LLC.
iOS ¢ un marchio o un marchio registrato Cisco
Systems, Inc. e/o di sue societa affiliate negli
Stati Uniti e in certi altri paesi.



¢ Android, Google Play sono marchi di Google
Inc.

* Wi-Fi, il logo Wi-Fi e Wi-Fi PROTECTED
SETUP sono marchi o marchi registrati di
Wi-Fi Alliance.

« Il simbolo N Mark ¢ un marchio o un marchio
registrato di NFC Forum, Inc. negli Stati Uniti e
in altri paesi.

Altri nomi di societa o prodotto sono marchi o

marchi registrati dei rispettivi detentori. In questo

documento i marchi non sono contrassegnati dai
simboli ™ o ®.

Licenze

QUESTO PRODOTTO E CONCESSO IN
LICENZA SECONDO LA LICENZA DEL
PORTAFOGLIO DEI BREVETTI AVC PER
USO PERSONALE E NON COMMERCIALE
DI UN CONSUMATORE FINALIZZATO A
(i) CODIFICARE VIDEO IN CONFORMITA
CON LO STANDARD AVC (“VIDEO AVC”)
E/O

(i) DECODIFICARE VIDEO AVC
CODIFICATI DA UN CONSUMATORE
IMPEGNATO IN ATTIVITA PERSONALI E/O
OTTENUTI DA UN FORNITORE CON
LICENZA DI FORNIRE VIDEO AVC.
NESSUNA LICENZA E CONCESSA O E DA
RITENERSI IMPLICITA PER ALTRO USO.
PER ULTERIORI INFORMAZIONI,
VISITARE IL SITO WEB DI MPEG LA, L.L.C.
VISITARE IL SITO HTTP://
WWW.MPEGLA.COM

Sulla base degli accordi di licenza fra Sony e i
detentori dei diritti di copyright del software,
questo prodotto utilizza software aperto. Per
soddisfare i requisiti stabiliti dai detentori dei
diritti di copyright sul software, Sony ¢ tenuta a

informare gli utenti del contenuto di dette licenze.

Ottenere software sotto licenza GPL/LGPL
Questo prodotto utilizza software a cui si
applicano le licenze GPL/LGPL. Questa nota ha
lo scopo di informare 1’utente del suo diritto di
accesso, modifica e ridistribuzione del codice
sorgente per tali programmi software secondo le
condizioni stabilite dalle licenze GPL/LGPL.

1l codice sorgente ¢ fornito su Internet. Per il
download, utilizzare il seguente URL e seguire le
istruzioni.

http://www.sony.net/Products/Linux/common/
search.html

Preferiremmo non essere contattati relativamente
al contenuto del codice sorgente.

Le licenze (in inglese) sono registrate nella
memoria interna del prodotto.

Stabilire una connessione di tipo Dispositivo di
memorizzazione fra il prodotto e un computer per
leggere le licenze contenute nella cartella
“PMHOME” - “LICENSE”.



Indice

A

Adattatore CA 18

AGC 29, 34,77

All File 97

All Reset 102

Aperture 84

Assignable Button 38, 100

Assistenza di visualizzazione gamma
12,43

ATW 30

Audio 27

Audio Input 85, 86

Audio Output 86

Auto Black Balance 78

Auto Exposure 77

Auto Shutter 77

Batteria ricaricabile preinstallata 106
Battery Alarm 101

Bilanciamento del bianco 30
Bilanciamento del bianco automatico 31

Bilanciamento del bianco con Auto Tracing

30
Bit utente 34
Black 81

C

Caricabatterie 17

Cavo USB 65

Clip 25, 58, 59, 65, 96

Clip Continuous Rec 93

Clock Set 101

Codec 28

Codice temporale 34, 60

Color Bars 77

Condensa 105

Connettore AUDIO INPUT1 32
Connettore AUDIO INPUT2 32
Connettore HDMI OUT 64, 112
Connettore multi/micro USB 8, 64, 65
Connettore SDI OUT 64, 111
Content Browser Mobile 49

Controllo del guadagno automatico 29, 77

Correzione gamma 82
Customize View 95

D

Datae ora 19

Dati temporali 34

Delete Clip 94

Detail(HD) 83
Detail(QFHD) 83
Detail(SD) 84

Diaframma automatico 28
Diaframma manuale 28
Display Clip Properties 60, 94
Display On/Off 90
Dispositivo audio esterno 32
Down Converter 87

E

Editing non lineare 65

F

Face Detection AF 11, 36

File ALL 43,97

File di scena 12, 43, 97

File utente 43, 96

Filtro ND 29

Flicker Reduce 78

Format Media 95

Formato 28, 41

Formato video 111

Formattazione (inizializzazione)
slot UTILITY SD/MS 44, 47
supporti di registrazione 22

Frequenza di sistema 12, 28

Fuso orario 19

G

Gain 75

Gamma 82

Ghiera dello zoom 26
Ghiera di messa a fuoco 26
Ghiera diaframma 28

GPS 46, 101, 107
Grandangolo 25
Guadagno 29



H

Handle Zoom 78

HDD 66

HDMI TC Out 92
HDR 43

HLG 43

Hours Meter 101

Indicatori di identificazione 62
Indicazioni di avvertimento 116
Indicazioni di errore 116

J
Jack cuffie 27

K
Knee 82

L

LAN 49

Language 101

LCD Setting 88

Levetta dello zoom 25

Levetta dello zoom della maniglia 25

Livello di registrazione audio 34
Lock/Unlock Clip 94

Maintenance 85
Manopola SEL/SET 70
Marker 89

Matrix 85

Media Full 23

Media Near Full 22
Menu Audio 85

Menu Camera 75
Menu di impostazione 68, 70, 74
Menu File 96

Menu LCD/VF 88
Menu Media 95

Menu Network 97
Menu Paint 79

Menu Recording 92
Menu System 99
Menu TC/UB 92
Menu Thumbnail 94

128

Menu User 68, 72, 74
Menu Video 87
Messaggi di avviso e messaggi operativi

117
Microfono interno 7, 32, 85
Mirino 11

regolazione diottrica 20

Modalita AF 27
Modalita di registrazione proxy 94
Modalita Full Auto 24
Modalita Full MF 26
Modalita Macro 27
Modalita Memory A 30
Modalita Memory B 30
Modalita MF 26
Modalita preset 29, 30
Modalita punto di accesso 13, 49, 98
Modalita Station 13, 51
Modalita variabile 29
Modulo LAN wireless USB 49
Moltiplicatore di focale digitale 12
Monitor esterno 64
Monitoraggio audio 27

N

ND Filter 75
NEC 6, 50
Nome clip 25

(0

Obiettivo 106

Orologio 19

Otturatore automatico 29
Output Display 87
Output Format 87
Output On/Off 87

P

Pacco batteria 17, 103

Paraluce con copriobiettivo 19
Peaking 88

Presa elettrica a parete 18

Pulsante di registrazione 24

Pulsante MENU 70

Pulsante PUSH (sblocco paraluce) 19
Pulsante SLOT SELECT 22

Pulsante WB SET 30

Pulsanti programmabili 38



Pulsanti VOLUME 27

R

Rec Format 99
Registrazione proxy 48
Registrazione relay 24

S

S&Q Motion 92

Schede di memoria SD 43, 47
Schede di memoria SDHC 43, 47
Schede di memoria SDXC 21, 43, 47
Schede SD 43, 47

Schermata delle miniature 57
Schermo LCD 11

Segnale di uscita 111

Selettore FOCUS 26

Selettore GAIN 29

Selettore INPUT1 32

Selettore INPUT2 32

Selettore IRIS 28

Selettore WHT BAL 31

Shutter 76

Simul Rec 93

Skin Detail 84

Slot per schede di memoria 9, 21
Slot UTILITY SD/MS 8, 43, 47
Software 65, 124

Spia di registrazione/tally 7,9, 116
Stabilizzazione dell’immagine 34
SteadyShot 34

Supporto di memoria USB 66, 95

T

Telecomando Web 55

Teleobiettivo 25

Tempo di registrazione rimanente
14,22, 110

Thumbnail View 94

Timecode 92

Tracolla 9

U

Update Media 95

Users Bit 92

Uso del camcorder all’estero 103
UTC 19

129

\')

Version 102

VF Setting 88

Video Light Set 78

Visualizzazione ingrandita per la messa a
fuoco 27

w

White 80
White Clip 82
White Switch 80
WPS 50, 51

zZ

Zebra 90
Zoom 25
Zoom della maniglia 25



	Sommario
	Panoramica
	Posizione e funzione delle parti
	Informazioni visualizzate sullo schermo

	Operazioni preliminari
	Alimentazione
	Impostazione dell’orologio
	Montaggio degli accessori
	Regolazione degli schermi
	Utilizzo delle schede di memoria

	Ripresa
	Procedura base
	Modifica delle impostazioni di base
	Funzioni utili
	Registrazione proxy
	Connessione ad altri dispositivi tramite LAN
	Utilizzo del telecomando Web

	Schermata delle miniature
	Configurazione della schermata delle miniature
	Riproduzione di clip
	Operazioni con i clip

	Connessione di un dispositivo esterno
	Connessione di monitor e dispositivi di registrazione esterni
	Gestione ed editing di clip con un computer

	Menu visualizzati e impostazioni
	Struttura e configurazione del menu di impostazione
	Operazioni del menu di impostazione
	Elenco delle voci del menu di impostazione

	Appendice
	Note importanti sul funzionamento
	Formati video
	Formati di uscita e limitazioni
	Ricerca e risoluzione dei problemi
	Indicazioni di errore/avvertenza
	Diagrammi a blocchi
	Specifiche tecniche
	Indice


